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About this Book

You are very welcome to this book. It provides an introduction to Blended Learning 
and how you might add blended activities into your teaching practice for adult 
learners. We do not assume you have a great deal of technical knowledge. This 
book provides an introduction into the technical aspects of blended activities and 
the creation of respective materials. 

The book begins with an introduction (Chapter 1) which outlines some of the basic 
ideas around Blended Learning. It  moves on to A Pilot Approach (Chapter 2) which 
outlines briefly how to include a simple blended activity into your teaching. 

Chapter 3 mentions some of the Key Considerations that are important to think 
about as a teacher or adult educator dealing with Blended Learning actcivities, 
such as copyright and accessibility. 

In Chapter 4 –Advanced Activities – you find detailed tutorials for using tools 
to create e-learning materials such as presentations, podcasts, videos,  games, 
webquestes, and so on. 

Chapter 5 – The Blended Learner – suggests some skills you might consider teach-
ing to your learners to help them navigate the blended activities. 

Chapter 6 – The Blended Manager – suggests ways that you can talk to your man-
agement about these blended activities. 

The Blended Technologies chapter (7) presents very briefly alternative tools you can 
use for what is described in Chapter 4.

Finally, the last chapter (8) looks at a range of approaches to evaluating the blend-
ed teaching and learning process. 

In the appendix you get to know Blended Learning in praact

The book focusses on six types of blended activities:

●● Presentations

●● Podcasts

●● Videos

●● Documents

●● Games

●● Searching

We realise there are many more, but we think these will provide you with enough 
variety to begin your blended journey.

This book contains a number of forms, which we would like you to copy and fill 
out. Most of the forms are full-page, which you can print out and distribute to your 
learners. There are also some other activities designed to be printed out and given 
to your learners.

Accompanying this handbook is an online resource that provides all of the forms 
and activities in downloadable format. 
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Glossary

Accessibility — Making digital content easily available 
to a range of users, including those who use assistive 
technologies

ADDIE – An educational design methodology, which 
stands for analysis, design, develop, implement, and 
evaluate

Badges, see Digital Badges

Balanced Scorecard – An organisational, or depart-
mental, evaluation approach

Blended Learning – Combining classroom and online 
learning

Cloud Storage – Online file storage system

Copyright – Legal protection for the creator of content

Cornell Notetaking – An approach to notetaking that 
includes space for summaries and revision

Cost-Benefit Analysis – Determining the ration of ben-
efits to costs

Creative Commons – A series of licences that can be 
used by the creator of content to describe how they 
want their content to be used

Digital Badges – Online badges that recognise the 
completion of a course, or acquisition of a new skill

Digital Identity – The overall information available on-
line about a person, organisation or other entity 

Digital Footprint – The information that is available 
about us online that we created

Digital Reputation – The perceptions you generate 
based on your behaviour in an online environment

Digital Shadow – What other people say about us on-
line or when they take a picture with us in it and put it 
online

Digital Tattoo – The data that is permanently stored on-
line about us

Discernment – The ability to know what you are look-
ing for online, and recognise it when you find it

E-Learning – Any form of electronic learning

E-Moderation – The role of the educator to promote 
communication and sharing of ideas

Flexible Learning, see Blended Learning

Hybrid Learning, see Blended Learning

Infographic – Poster-like visual representation of infor-
mation and data 

Integrated Learning, see Blended Learning

Just-in-Time Learning – The quick, continuous learn-
ing and unlearning of new skillsets

Learning Outcomes – Statements that describe the 
knowledge or skills of the learner

Lesson Plans – Description of the teaching approach 
and content of a course

LORI – A review instrument of learning objects

MERLOT – A review instrument of learning objects

Mixed-mode Learning, see Blended Learning

MOOC – Massive Open Online Course, an online course 
aimed at unlimited participation

Module – A set of learning content about a specific top-
ic

Monitoring – The Web is changing constantly, the na-
ture of the information you require changes constantly, 
so searching for what you need to know is an ongoing 
activity

Multimedia – Using more than one medium of expres-
sion or communication, e.g. audio, and text

Multi-method Learning, see Blended Learning

Plagiarism – Passing off someone else’s work as your 
own

Podcasting – Audio recording in the style of a radio 
programme

Programme – A collection of modules

References – A list of research sources quoted
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Return-on-Investment – A performance measure used 
to evaluate the benefits of an investment 

Accessibility — Making digital content easily available 
to a range of users, including those who use assistive 
technologies

ADDIE – An educational design methodology, which 
stands for analysis, design, develop, implement, and 
evaluate

Badges, see Digital Badges

Balanced Scorecard – An organisational, or depart-
mental, evaluation approach

Blended Learning – Combining classroom and online 
learning

Cloud Storage – Online file storage system

Copyright – Legal protection for the creator of content

Cornell Notetaking – An approach to notetaking that 
includes space for summaries and revision

Cost-Benefit Analysis – Determining the ration of ben-
efits to costs

Creative Commons – A series of licences that can be 
used by the creator of content to describe how they 
want their content to be used

Digital Badges – Online badges that recognise the 
completion of a course, or acquisition of a new skill

Digital Identity – The overall information available on-
line about a person, organisation or other entity 

Digital Footprint – The information that is available 
about us online that we created

Digital Reputation – The perceptions you generate 
based on your behaviour in an online environment

Digital Shadow – What other people say about us on-
line or when they take a picture with us in it and put it 
online

Digital Tattoo – The data that is permanently stored 
online about us

Discernment – The ability to know what you are look-
ing for online, and recognise it when you find it

E-Learning – Any form of electronic learning

E-Moderation – The role of the educator to promote 
communication and sharing of ideas

Flexible Learning, see Blended Learning

Hybrid Learning, see Blended Learning

Infographic – Poster-like visual representation of infor-
mation and data 

Integrated Learning, see Blended Learning

Just-in-Time Learning – The quick, continuous learn-
ing and unlearning of new skillsets

Learning Outcomes – Statements that describe the 
knowledge or skills of the learner

Lesson Plans – Description of the teaching approach 
and content of a course

LORI – A review instrument of learning objects

MERLOT – A review instrument of learning objects

Mixed-mode Learning, see Blended Learning

MOOC – Massive Open Online Course, an online course 
aimed at unlimited participation

Module – A set of learning content about a specific top-
ic

Monitoring – The Web is changing constantly, the na-
ture of the information you require changes constantly, 
so searching for what you need to know is an ongoing 
activity

Multimedia – Using more than one medium of expres-
sion or communication, e.g. audio, and text

Multi-method Learning, see Blended Learning

Plagiarism – Passing off someone else’s work as your 
own

Podcasting – Audio recording in the style of a radio 
programme

Programme – A collection of modules

References – A list of research sources quoted

Return-on-Investment – A performance measure used 
to evaluate the benefits of an investment 

Searching – The ability to find what you are looking for 
using a range of search techniques

SMS Language – An abbreviated language and slang 
commonly used with mobile phone texts
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Soundscape – A combination of sounds that forms or 
arises from an immersive environment

SQR3 – An active reading technique that consists of 
Survey, Question, Read, Recite, Review

Storyboards – A graphic organization of images for vis-
ualizing media content

Syllabus – The subjects in a course of study or teaching

Technology-mediated Learning, see Blended Learning

Textspeak, see SMS language 

Usability – The ease of use and learnability of a system

Virtual Learning Environment – A web-based plat-
form for storing teaching content

VLE, see Virtual Learning Environment

Web-enhanced Learning, see Blended Learning

WebQuest – A set of online search activities to help 
learner learn

Worldwide Web – Part of the internet providing access 
documents and multimedia content

WWW, see World-wide Web
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Blended Learning:  
A Roadmap

Welcome to the first chapter of this workbook. We want 
to start by explaining what we think Blended Learning 
is. Different people have different understandings of 
the term Blended Learning. Therefore, we want to set 
out our understanding of Blended Learning, so that the 
rest of this workbook makes sense. 

In this chapter, we will discuss some of the reasons why 
Blended Learning makes sense for adult learning. We 
will also mention some other terms that people use 
when talking about Blended Learning. We will present 
five quality tips to think about when preparing a blend-
ed learning environment, and we will consider when 
you should choose to blend.

Next, we will mention the key people (and key roles) 
involved in a Blended Learning process, including the 
learners, the educators, the managers, other Blended 

Learning contributors, the technical staff, external soft-
ware organisations, and other external organisations.

From there we will look at the advantages and disad-
vantages of Blended Learning. First, we will look at the 
advantages of Blended Learning both from your point 
of view as the educator and from the learners’ point of 
view as well. Looking at the disadvantages of Blended 
Learning, we should consider organisational as well as 
technical challenges.

Finally, we will discuss the scope of the handbook, what 
it is going to cover, and what it will not cover. At this 
stage it is important to be aware of the scope of the 
handbook so that you do not have any false expecta-
tions as to what will be covered. Whilst we do cover a lot 
in this handbook it does not cover everything!

Fig 1.1 – Main Sections in Chapter 1.

1. 	 Blended Learning:  A Roadmap
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1.1	 What is Blended Learning?

1.1.1	 Blended Learning: Simple Introduction

1	 For details on this study see https://ec.europa.eu/epale/en/blog/blended-learning-adult-education-practice-lessons-learned-questionnaire-based-survey

We believe Blended Learning refers to any educational 
activity that combines traditional classroom (offline) 
activities with online activities. In order for the learning 
to be blended the traditional classroom content and the 
online content must overlap to some extent, and they 
must compliment and scaffold each other. A Blended 
Learning activity that is well designed can combine all 
the benefits of the traditional classroom (conversation 
and interaction) with the benefits of the online class-
room (spatial and time flexibility). 

In order to gauge interest in and guide the content of 
this handbook, an international study of views and atti-
tudes towards Blended Learning was conducted among 
adult educators around Europe. 117 surveys were com-
pleted, across five countries, and a total of 60 of the 
respondents were contacted to complete a follow up 
interview. From the results of this survey and the subse-
quent interviews, it is apparent that there is a good deal 
of interest among educators and related managers in 
the topic of quality Blended Learning. Most interview-
ees could see the appeal and benefits for learners and 
educators alike and were very positive in their attitudes 
towards adapting to new technologies and learning 
new skills. However, it also became apparent that there 
are elements of confusion in relation to the terminolo-
gy, which can be daunting for someone starting out in 
the area.1 

Everyone interviewed re-iterated the importance of 
the role of the educator, and how a blended delivery 
might mean that while the role or skills of the educator 
might change, their presence and overall impact does 
not decrease with the inclusion of technologies. Rath-
er, technologies should be used to enhance teaching, 
not replace the educator. Most interviewees agreed that 
there is an initial dramatic increase in workload, as qual-
ity Blended Learning means adapting a curriculum to 
suit the new delivery, as well as learning new teaching 
and technology skills. This all takes time, and most ed-
ucators are time-poor, which was reported as the big-
gest barrier to the adoption of Blended Learning on a 
wider scale. Others mention the lack of dissemination 
of Blended Learning practices and methods, as well as a 
lack of investment and support at a higher level. 

These findings led us to conclude that a handbook on 
best practices, including a beginner’s introduction as 
well as overviews of the benefits from the educator and 
learner perspectives, and validated, practical ways to 
enhance Blended Learning delivery would provide di-
rection to those interested in starting out in the area. It 
could provide further insight to those already working 
in the space.

Blend-it-well Handbook 

Figure 1.2 – The Characteristics of Blended Learning.
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1.1.2	 Five Quality Tips for Blending

Blended Learning requires that you as the educator give 
up some control of the teaching process, and it places 
more responsibility on the learners to be responsible 
for their own learning. When you put content online 
the learners must engage with it enthusiastically if they 
want to get the most out of it. To help you in this process 
there are many suggestions throughout this workbook. 
Here are a few things to start with:

1) Start with learning outcomes
As with the development of any educational content, 
start with the learning outcomes. So ask yourself, what 
are the key 5-7 big ideas that you want the learners to 
take away from this course? At the end of each class, 
whether they are online or in the classroom, you can 
present a bar chart or a status bar indicating how much 
the learners have achieved from each outcome to date.

2) Teaching leads technology
There is such a wide range of interesting online tools 
available, it can be tempting to incorporate some of 
them into your lessons, even if they are not directly rel-
evant. Try to avoid doing this. The goal here is to edu-
cate the learners, therefore all the technology should be 
driven by the learning outcomes.

3) Group work can be effective
One of the most useful things about having the learners 
online is to put them into groups and get them to dis-
cuss topics relevant to the learning outcomes. Getting 
learners to share their knowledge and skills with oth-
ers can be extremely beneficial to all involved. This sort 
of learning – peer learning – is considered extremely 
impactful for learners. It can be organised in the class-
room, but it can also be organised online. Online dis-
cussion tools can help structure conversations. Learners 
can easily share content and hyperlinks with each other. 

4) Find online resources
There are a wide range of resources and references 
available online about almost every topic in existence, 
so this could include newspaper stories, or research 
papers, or simulations, or videos. There is a lot of con-
tent available, and with a little search you will be able to 
locate high quality content. Additionally, as one of the 
learners’ activities, you could ask them to locate relevant 
reference material.

5) Assessment should be blended
If the teaching is blended, it makes sense that the assess-
ment is also blended, so a mixture of online and class-
room assessment. One of the goals of assessment is to 

1. 	 Blended Learning:  A Roadmap

Table 1.1 – Categorisation of teaching-learning arrangements 
after Allen, Seaman & Garrett (2007)

Content 
Delivered 

Online

Content 
Delivered in 
Classroom

Type of Course Description

0 % 100 % Traditional Classroom This is classroom teaching.

1-29 % 71-99 % Web Facilitated
Using an online teaching tool or webpages to do 
some activities.

30-79 % 21-70 % Blended Blended Learning.

80-100 % 0-20 % Online
Mostly online,  
with few face-to-face meetings.

1
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Why is Blended Learning Needed?
Each partner involved in the writing of this book  
was asked why they believe that Blended Learning 
is needed in adult education, and here are some re-
sponses:

“Whereas in other sectors of education, Blended 
Learning has made substantial progress in recent 
years, traditional adult education has remained 
relatively unaffected. This is partly because of 
the expectations of the participants in adult 
education courses. However, with the ubiquity 
of internet services in everyday life, the next 
generation of adult education participants simply 
will expect that these services be integrated into 
their classroom activities - without reducing the 
social aspect of meeting in classes.”

“We think the pros of Blended Learning 
outweigh the cons (for example, infrastructure 
cost, overload of educators), with increased 
collaboration between educators and learners 
inside and outside the classroom; and an 
environment comfortable for all the learners 
(those who cope with tasks at a different pace or 
are in need for additional resources). Even for our 
seniors, Blended Learning is fun.”

“It supports motivated, mature learners who 
want to influence the pace of learning to ensure 
they are learning effectively and efficiently.”

“It enables learners to organize their time 
according to their (home and work) needs, it 
also allows them to proceed at a pace suitable 
to them. Finally, it allows them to do learning 
activities at home whilst still being connected to 
a learning group.”

“We think the pros of Blended Learning 
outweigh the cons (for example, infrastructure 
cost, overload of educators), with increased 
collaboration between educators and learners 
inside and outside the classroom; and an 
environment comfortable for all the learners 
(those who cope with tasks at a different pace or 
are in need for additional resources). Even for our 
seniors, Blended Learning is fun.”

“Blended learning gives adults the freedom to 
choose why, how, and when to learn. Moreover, 
it provides them with learning options: learning 
online or group learning. It supports their 
learning and motivates them.”

“Adult learners can learn in a personalised way, 
and they can choose what to learn, and best of 
all the learning process can be adjusted to their 
own pace, rhythm and experience.”

1
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allow the learners to check what they have learned. On-
line tools allow you to do this easily, from multi-choice 
quizzes to asking the learners to collaborate on an ar-
ticle to summarize the content that has been learned.

***

When Blended Learning is implemented properly it can 
significantly improve the learners’ desire to learn, but to 
achieve this, the online aspects of the delivery must be 
integral to the overall programme. They cannot be sim-
ply bolted on, they have to serve a vital purpose in the 
teaching.1  

Other terms that can be used for Blended Learn-
ing include: flexible learning, hybrid learning, integrat-
ed learning, mixed-mode learning, multi-method learn-

1	 Jansen, D., P. Henderikx (2018): The Changing Pedagogical Landscape: In search of patterns in policies and practices of new modes 
of teaching and learning, Retrieved from https://tinyurl.com/CPLreport2018

2	 Allen, I. E., J. Seaman, R. Garrett (2007): Blending. In: The Extent and Promise of Blended Education in the United States, Sloan 
Consortium. Newburyport (MA).

3	  What is “accessibility“? See introduction to Chapter 4.2.2. “Create accessible PDFs“.	

ing, technology-mediated learning, and web-enhanced 
learning.

Many researchers, including Allen, Seaman, & Garrett 
(2007)2 suggest that when mixing classroom and online 
content to produce a blended lesson, there is a mini-
mum component of each aspect that must be present 
to qualify it as being Blended Learning. The table be-
low suggests that for something to qualify as blended 
it must be somewhere in the range of 30 % online and 
70 % classroom, to 79 % online and 21 % classroom, to 
qualify as Blended Learning. Therefore, if the teaching is 
fully online, e.g. getting the learners to use a MOOC or 
other exclusively online content, then it is not typically 
considered Blended Learning.

(See Table 1.1.)

1.1.3	 When Should Educators use Blended Learning?

Educators should consider using Blended Learning:

●● If you have a group of learners who are geographi-
cally dispersed, and it would be more convenient for 
them to meet intermittently rather than regularly.

●● If you want to develop content that might serve to 
introduce a module, or provide revision content for 
the module.

●● If there is a specific topic you wish to teach that 
might benefit from multimedia content.

●● If less face-to-face content would be helpful to ei-
ther you or the learners.

●● If more accessibility would benefit the learners.3 

●● If your learners have other commitments and it 
would be helpful if they could do the learning at 
their own pace. 

●● If you have a guest lecturer who cannot physically 
attend the classroom.

1. 	 Blended Learning:  A Roadmap

1



8

1.2	 Common Blended Learning Roles
In this section, we will mention some of the key indi-
viduals involved in the Blended Learning process. It is 
important to remember that this is not a solo effort. For 
a blended initiative to be successful, you need the co-
operation of your learners, your managers, and many 
others. 

Another purpose of this section is to introduce the 
terms we will use throughout this workbook for the var-
ious participants in the blended process, each of whom 
we will be discussing in more detail in the subsequent 
chapters.

Learners
The blended learner is required to take more initiative 
and be willing to explore the use of a range of tools on-
line.Educators

Educators 
The blended educator has to begin to develop a range 
of new skills, including learning how to use online tools, 
and how to moderate activities online. 

Managers 
The blended manager has to be patient in the early 
stages of the Blended Learning process, and has to be 
generous in terms of support, time, training, tools, and 
recognition. (This category includes heads of depart-
ment.)

Blended Learning Contributors
Other people who might be involved in this process 
could include instructional designers, who could support 
the development of the learning development process, 
multimedia support staff, who can help with the devel-
opment of multimedia content, and an audio-visual (AV) 
person, who might create videos of lectures or audio 
content.

Technical Staff 
Other people who might be involved in this process 
could include instructional designers, who could sup-
port the development of the learning development 
process, multimedia support staff, who can help with 
the development of multimedia content, and an au-
dio-visual (AV) person, who might create videos of lec-
tures or audio content.

External Software Organisations
Organisations such as internet service providers and soft-
ware suppliers might become involved in this process, 
depending on challenges.

Other External Organisations
Organisations such as certification authorities (academ-
ic and professional), municipal or regional councils, and 
even the media might be an element in this process.

Blend-it-well Handbook 
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1.3	 The Two Sides of Blended Learning

1	 Garrison, D.R., H. Kanuka (2004): Blended Learning: Uncovering its Transformative Potential in Higher Education. The Internet and 
Higher Education, 7 (2), p. 95-105.

2	 Means, B., Y.  Toyama, R. Murphy, M. Baki (2013): The Effectiveness of Online and Blended Learning: A Meta-Analysis of the Empirical 
Literature. Teachers College Record, 115 (3), p. 1-47.

3	 Bernard, R.M., E. Borokhovski, R. F. Schmid., R. M. Tamim, P. C. Abrami (2014): A Meta-Analysis of Blended Learning and Technology 
Use in Higher Education: From the General to the Applied. Journal of Computing in Higher Education, 26 (1), p. 87-122.

4	 Liu, Q., W. Peng, F. Zhang et al.  (2016): The Effectiveness of Blended Learning in Health Professions: Systematic Review and Meta-
Analysis. Journal of Medical Internet Research, 18 (1).

In this section, we will look at both the potential ben-
efits and potential challenges associated with Blended 
Learning. It is important that this Introduction Chapter 
provide a balanced perspective on Blended Learning. 
We do not believe that Blended Learning is suitable for 

all teaching situations at all times, but we do feel that 
there are times when Blended Learning is an effective 
solution to providing an advantageous and engaging 
environment for learners in certain situations.

1.3.1	 The Benefits of Blended Learning

This section will look at the potential benefits of Blend-
ed Learning, focusing first on the reasons why Blended 
Learning can be of use to you, and also be of benefit to 
your learners.

Internet-based technologies are fundamentally chang-
ing many aspects of society, including business, jour-
nalism, social networking, and leisure time, and these 
types of innovations are also occurring in education. 
This means that education is now available to a wider 
and more diverse audience than was previously pos-
sible. It also means that learners can become part of 
a community of learning where dialogue, debate and 
agreement are possible. This range of dialogue can lead 
to higher order learning and improved critical thinking.1  

Blended Learning also represents a novel experience 
for learners, not just because of the online content, but 
from the combination of the classroom and the online 
experience. The interface between these two distinct 
forms of learning can result in new attitudes to learn-
ing in general, for example more self-directed learning 
competence.

Blended Learning opens up a world of opportunities for 
you, the educator. It provides you with more opportuni-

ties for collaboration with other educators and learners, 
it gives you an opportunity to develop new skills, and it 
allows you to monitor your learners more effectively. It 
can also allow you to focus on deeper learning through 
peer learning.

Once you have developed and delivered the blended 
content a few times, you will have a significant bank 
of content created, including potentially useful ques-
tion-and-answers about module specific content, tech-
nical support issues, a bank of (quiz) questions, and 
a blended schedule. This makes the re-delivery of a 
blended module significantly easier.

Blended Learning also provides some potential ben-
efits for your learners, including the fact that they can 
become significantly more motivated, enjoy the new 
approaches to engagement, as well as potentially new 
means of communications and evaluation. 

Many researchers,234  that have looked at a number of 
studies to allow for comparison (so-called meta-analy-
sis studies) show that there is a significant improvement 
(between 80-87%) in learner achievement of learners 
in a blended environment when compared with class-
room-based teaching.

1. 	 Blended Learning:  A Roadmap
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1.3.2	 The Challenges of Blended Learning

1	 Oliver, M., K. Trigwell (2005): Can ‘Blended Learning’ be Redeemed? E-learning and Digital Media, 2 (1), p.17-26.

2	 Moskal, P., C. Dziuban, J. Hartman (2013): Blended Learning: A Dangerous Idea? The Internet and Higher Education, 18, p.15-23.

To provide a balanced view on this topic, this section in 
contrast will look at the potential pitfalls and risks asso-
ciated with Blended Learning.

Blended Learning is not only a matter of bringing ex-
isting content online, but rather it requires a rethink of 
the content already being delivered. Initially this will be 
a time-intensive process, both at a strategic level and 
an operational one. It also may require new resources in 
terms of staff, money, and technology. As the blended 
activities become more and more sophisticated, they 
will require more technical support.

Some critics strongly reject the term Blended Learning 
and argue that it is ill conceived and inconsistently used, 
and the activities associated with Blended Learning 
have been occurring in classrooms frequently without 
being associated with that term. They also argue that 
since different learners experience the same teaching 
experience in different ways, measuring the efficacy of 
Blended Learning for a whole class is very challenging.1 

Other critics feel that unless there is complete organisa-
tional support for Blended Learning, and a robust and 
reliable infrastructure is put in place, it becomes very 

difficult to successfully monitor and support blended 
initiatives.2 

It is worth noting that some participants especially in 
non-formal adult education attend evening and week-
end classes not merely in order to learn useful content, 
but also – or predominantly – for personal development 
or for the social benefits and other reasons beyond the 
actual learning. These participants may not wish to en-
gage with technology in their learning, particularly if 
they are doing so all day in their work activities. They 
may want to engage with other people in a pleasant, 
meaningful and inspiring way face to face; so asking 
these learners to engage with technology may not be 
desirable, even if it is appropriate from a teaching per-
spective.

Some learners will find using computers challenging, 
for example because they are not used to using them at 
work or in their leisure time at all. You therefore should 
always first assess if your group of learners is able to deal 
with the technology involved. A certain degree of skills 
provided, it can help to offer an introductory session 
where the IT tools to be used within the course are pre-
sented, and everybody has a change to try using them. 

Blend-it-well Handbook 
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1.4	 Scope of This Book
This work is designed for someone who is new to Blend-
ed Learning. The goal is to explain how your role, the 
role of the learners, and the role of others around you 
will change once you engage in blended activities in 
the classroom. 

We will focus on six types of activities:

●● Presentation development

●● Podcast development

●● Video development

●● Document development

●● Game-based learning

●● Search activities

There are many other forms of online activity that the 
blended educator can develop.  Not discussed in de-
tail are for example wikis, blogging, social media, and 
virtual reality. We have scoped this document to focus 
just on these six techniques, which we hope are easy to 
understand but sufficiently powerful to having a mean-
ingful impact on learner understanding.

The workbook does not set out to provide a definitive 
guide to useful software for each of those activities, but 
rather provides a general guide on how to undertake 
some actions in an example of the relevant software 
(Chapter 4), and identifies some of the currently avail-
able software that might be helpful for these activities 
(Chapter 7). It is worth noting that new blended soft-
ware is being made available on a daily basis, so when 
you are engaged in a particular blended activity, always 
do a quick search to check if something new has be-
come available.

In Chapter 3, we have some key themes we think it is 
important for you to be aware of, including copyright, 
and accessibility. We realise that you will encounter a 
wide range of new themes when undertaking blended 
activities, but we feel the content covered is sufficient to 
start your journey. In a similar vein, Chapter 8 provides 
a range of evaluation techniques. This is by no means 
meant to be definitive, but rather an overview of some 
of the many ways that Blended Learning can be evalu-
ated. 

1. 	 Blended Learning:  A Roadmap
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2. 	The Blended Educator:  
A Pilot Approach

A journey of a thousand miles  
begins with a single step. 

Tao Te Ching – Chapter 64
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The Blended Educator –  
A Pilot Approach

If you are reading this chapter, it is likely you are an ed-
ucator who is thinking about creating some blended 
content for your classes. Our advice is that you begin 
with something small, that we will call a pilot, to explore 
whether or not Blended Learning is suitable for you 
and your learners, and to explore what type of Blended 
Learning might be best suited.

Starting with something small means that you will not 
have to spend a lot of time on this, and you will not have 
to develop a range of new skills. The goal here is for you 
to get the first impression and see how it feels. 

We recognise that as an educator you are very busy 
most of the time, so it is important that these first steps 
towards Blended Learning are made as effortless as pos-
sible for you. What we are going to recommend is that 
you use a five-step process in implementing the pilot. 
Those five steps are as follows:

●● Step 1: Selecting a topic to blend

●● Step 2: Exploring the possible ways to blend

●● Step 3: Creating the blended content

●● Step 4: Testing the blended content with learners

●● Step 5: Evaluating the outcome of the pilot

Fig. 2.1.  Journey of a pilot, i.e. of creating Blended Learning content as suggested in this book.

2
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2.1	 Selecting a Topic to Blend
Deciding on a topic to blend is the first step in this 
process. The topic you choose to blend is best if it is 
one that you will not be teaching for at least a month 
from now. Also, it shouldn’t be a whole lesson, instead 
it should be a topic that you would typically cover in 
about 5 minutes in the classroom. It should be a rela-
tively independent topic that won’t impact the learners’ 
overall understanding of the lesson you are teaching if 
it wasn’t included in any given delivery of that lesson. 
Therefore, for example, if you are giving the learners a 

few different examples to help them understand the 
lesson more fully, perhaps you could consider choosing 
one of those examples to blend. Alternatively if there is 
terminology or formulae that you are explaining to the 
learners, that you are using to reinforce concepts in your 
lesson, it might be worth considering blending those.

Below we are presenting a checklist of the key consider-
ations we feel that you should reflect on when selecting 
a topic to blend:

For Example 
Let’s imagine you were teaching 
a French language course, and 
you were going to suggest some 
French movies that the learners 
could look at. This is a nice topic 
to blend, because it is not central 
to your teaching, but it is a perfect 
topic to develop as a blended asset. 
In a classroom setting you might 
say something like:

 “If you want to look at some movies 
that could help you with your basic 
French, the 1990 Gérard Depardieu 
movie Cyrano de Bergerac is 
very helpful, as is another Gérard 
Depardieu movie, The Return of 
Martin Guerre from 1982 that is also 
worth seeing. Jean Cocteau’s Beauty 
and the Beast movie from 1946 is 
also a wonderfully helpful movie to 
learn vocabulary.”

This is clearly an independent unit 
of learning, so it is a nice one to 
choose to blend. A storyboard for 
this activity is presented in Section 
2.3.

If the answer is yes to all of the above questions, then you have found a topic that is suitable for blending.

Blend-it-well Handbook 

Table 2.1 – What Topic Should I Choose to Blend?

Description Yes/No

1 Is this a topic that you will not be teaching for at least a month?

2
Is this a simple topic that would take no more than 5 minutes to teach 
in a classroom setting?

3
Is this a relatively independent topic that is not vital to the learners’ 
understanding of the topic you are teaching but does help contribute 
to their learning?

4
Is this a topic you have flexibility in terms of when you deliver it to the 
learners?

5
Is this a topic you could cover in the classroom once you have done the 
pilot if it turns out that the learners did not engage with the blended 
content?

2
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2.2 	 Exploring the Possible Ways to Blend 
As we have mentioned previously, Blended Learning 
means a mixture of classroom content and online con-
tent. What we are exploring in this step is, first, how to 
develop the online content as part of the blend, and 
second, how to integrate that online content into a 
classroom-based lesson. 

To help you get the pilot completed, we have suggest-
ed six different potential content types, so you can just 
pick any one of these. There are many more potential 

content types, but we are simplifying the selection to 
these six for the moment as we feel these are the ones 
that will give you the most impact for the least effort. 
In the table below, we have also listed an example of 
each content type you could use for the pilot, and how 
you may build upon the work you do in the pilot. The 
next section will explain how to implement each of the 
examples presented for the pilot (but remember you 
should only do one of these six for the pilot).

The three key considerations you should think about at 
this stage (to help you pick which one of the above six 
activities for the pilot) are:

1) The topic being taught
Some topics more readily lend themselves to a particu-
lar type of content, for example, podcasts might suit a 
language-learning topic, and a presentation might be 
more suitable for teaching the visual arts.

2) Your Resources and Skills
Some of the content types will be easier to produce with 
a laptop; others may suit a mobile phone; for some you 

need internet access. The technology you use should be 
determined by what you feel comfortable doing with 
your skillset using technologies.

3) Learner resources and skills
As well as your own resources, it is worth considering 
what technology the learners have access to, and what 
their technical skills are. So do they have internet access 
at home (and is it quick enough)? Do they have a com-
puter or tablet, or is the only thing they have a mobile 
phone with relatively small screen? 

The flowchart next page will help you choose which 
content type to pick.

2. 	 The Blended Educator:  A Pilot Approach

Table 2.2 – Content Types Presented in This Book

Content Type
For the Pilot  
(Chapter 2)

After the Pilot  
(Chapter 4)

Presentations Presentation with audio
●● Creating Infographics
●● Using Prezi

Podcasts Audio recording
●● Edited audio recordings
●● Audio with soundscapes

Videos Video recording
●● Creating Animated videos
●● Adding quizzes to videos

Documents PDF document
●● Interactive PDF content
●● Accessible PDF content

Games
Word games  
(e.g.  a crossword or a quiz)

●● Interactive games
●● Digital badges

Searching Search for information
●● Searching for multimedia
●● WebQuest

2
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Do all your students 
have internet access?

Don’t bother.

Would you like to 
create multimedia?

Would you like to
 create a video?

Well, then let’s 
create a podcast!

Well, then let’s 
create a video!

Well, then let’s create
 a presentation!

Well, then let’s create
a PDF file!

How about a 
search activtiy?

Would you like 
to create a game?

Well, then let’s create
a  search activity!

Well, then let’s 
create a game!

it’s a document so.
Perhaps a PDF?

Do you want to create a 
blended asset?

No

No

No

No

No

No

No

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Blend-it-well Handbook 
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2.3 	 Creating the Blended Content
Well done! If you have got as far as here you have select-
ed what type of content you are going to create. In this 
section we are going to present our suggestions as to 
how you can simply and effectively create the content 
for your Blended Learning topic.

Before we get into the specifics of creating the various 
content types, to help you on your journey to Blended 
Learning, first, we are going to introduce two things: the 
concept of storyboards, and a template script.

2.3.1	 Creating Simple Storyboards

A storyboard is an illustration or a series of illustrations 
that are a visual representation of content such as a web-
site, a video, or other interactive media. Storyboards are 
usually created on paper. They are a plan or prototype 
design of the content you wish to create. Storyboards 
are cheap, easy to make, and are easily understood by 
everyone. So when designing a website, a video, or oth-
er interactive media, you can use a storyboard like the 
one below. Here is what each field means:

●● Content Number: Each storyboard gets a succes-
sive sequential number

●● Module: This is the module that is being taught

●● Content: This can be a visual sketch or text proto-
type of the content

●● Notes: This could be a script, or navigation infor-
mation, or other details

You can use the template on the next page. Make a photocopy, or use the DOCX-file from the supplementary materi-
als to this book, download from www.blenditwell.eu/handbook/templates/BL_Sup01_StoryBoardTemplate.docx

2. 	 The Blended Educator:  A Pilot Approach

NO: 57 Module: Introduction to French Notes:

Content:

This webpage will have links to 
trailers to three French movies, as 
well as links to cast lists of each of 
those movies.
The page will be navigated to from 
Storyboard CN-56, and will link to 
Storyboard CN-58.
The webpage is accessible, and it is 
possible to change the background 
colours.

Fig. 2.2 – Example of a story board, here for presenting material for a French class on movies as part of a website.

2
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2.3.2	 Creating Simple Scripts

A script is a written form of something that eventually 
will be said (in an audio record) or shown (in a video re-
cord). Scripts can be long and detailed. But for starting, 

let’s keep it simple. Below you find a generic template 
that is good for many purposes, and a number of ex-
amples where this script template is applied in practice.

2. 	 The Blended Educator:  A Pilot Approach

Template Script

Hello everyone, you are very welcome to this talk on [Topic name]. In the talk, we will be looking at [Key points 
to cover].

First, we will look at [Point 1].

Next, we will look at [Point 2].

Finally, we will look at [Point 3].

[Main body of talk]

To recap, we looked at [Key points to cover].

Thanks very much.

Sample Script 1: French Language Course

Hello everyone, you are very welcome to this talk on movies that can help with your French speaking skills. In 
the talk, we will be looking at three movies to help your language skills.

First, we will look at Cyrano de Bergerac.

Next, we will look at The Return of Martin Guerre.

Finally, we will look at Beauty and the Beast.

Cyrano de Bergerac is a film from 1990 which stars Gérard Depardieu as a shy suitor who helps a rival to woo 
the woman that he loves. The Return of Martin Guerre is from 1982 and stars Gérard Depardieu as a man who 
returns from war, and has changed in very fundamental ways. Finally, Jean Cocteau’s Beauty and the Beast is 
from 1946 and is also a wonderfully helpful movie to learn vocabulary.

So to recap, we looked at the three movies to help you learn French: Cyrano de Bergerac, The Return of Martin 
Guerre, and Beauty and the Beast.

Thanks very much.

2
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Sample Script 2

Hello everyone, you are very welcome to this talk on essential skills for journalists. In the talk, we will look at 
three of the key non-technical skills that all good journalists should possess.

First, we will look at maths skills.

Next, we will look at design skills.

Finally, we will look at interpersonal skills.

First, maths, which is a very important skill for journalists, particularly as many modern news stories require 
a clear understanding of concepts such as statistics and ratios. The second skill, design, is also very important, 
particularly for digital journalism, where the journalist may be involved in the layout of on-line content. The 
final skill is interpersonal, and it is the most obvious one, as all journalists need to talk to strangers, and get 
people to open up to them quickly.

So to recap, we looked at the three essential skills for journalists are maths, design, and interpersonal.

Thanks very much.

Sample Script 3

Hello everyone, you are very welcome to this talk on Learning Theories. In the talk, we will be looking at three 
of the key theories of how people take in information and learn.

First, we will look at Behaviourism.

Next, we will look at Cognitivism. Finally, we will look at Constructivism.

The first theory of learning, called Behaviourism, suggests that if you repeat the same materials many times to 
learners, and get them to repeat it with you, it will be retained by them. The second theory of learning, called 
Cognitivism, suggests that a very good way of teaching new material to learners is to find links to material that 
the learners are already familiar with. The third theory of learning, called Constructivism, suggests that it is 
important that a learner constructs their own understanding of the material.

To recap, we looked at the three main theories of how people learn: Behaviourism, Cognitivism, and 
Constructivism.

Thanks very much.

2
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2.3.3	 Creating a Presentation with Added Audio

Presentation software allows you to create, edit, and 
display text and images in the form of slides. Some pres-
entation software also allows you to attach audio con-

tent that can be synchronised with the slides, which are 
automatically advanced. Therefore, it is a bit like making 
a movie, but a lot easier to do.

What do you need?
●● Pen and paper, or a word processor ●● Presentation software that allows you to attach au-

dio content (e.g. PowerPoint, Prezi, and Keynote). 

What do you do?
Develop the presentation first.

●● Next, develop a script, so write down the key words 
you need to mention about this topic, and based 
on these words create some sentences. Using those 
sentences and the content from the Template Script 
above, create a script that you can read for the au-
dio. If you want to create a 5-min audio, that is usu-
ally somewhere between 500 and 750 words in the 
script. Rehearse reading the script a few times be-
fore recording. Some of us prefer sitting down at a 
table went recording; others like to do it standing.

●● Start the presentation software running, with the re-
cording process activated, read the script, and step 
through the slides as appropriate. – 

●● For example, in Powerpoint, simply choose Insert > 
Audio > Record Audio. This creates an audio clip that 
will be inserted onto your slide. Once you click on 
the audio icon on yours slides, there will also be 
some basic settings available in the menu bar, for 
example settings for Start on click  or Start automat-
ically. (Audio quality of such recordings made direct-
ly in Powerpoint are rather low, chiefly in order to 
keep the files small.)  

●● If you make a mistake, just stop the recording, and 
take a breath and start again. If you keep making 
mistakes after five recordings, take a break, make 
yourself a cup of tea and come back to it later. When 
you are happy with the presentation, save that pres-
entation.

Online or Offline?
●● If you want to distribute this presentation offline, 

you can copy the presentation file onto a USB mem-
ory stick and hand it out in class.

●● If you and your learners have access to the inter-
net, you have many options to distribute it to your 

learners. You can share it with them using cloud 
storage (e.g. Dropbox, Google Drive, and AWS), you 
can email it to them, if you have a website, you can 
upload it there, or to a virtual learning environment 
(e.g. Moodle, Blackboard, and Edmodo).

2. 	 The Blended Educator:  A Pilot Approach
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2.3.4	 Creating a Podcast 

A podcast is an audio file that a learner can either lis-
ten to online or download and listen to offline. Podcasts 
are often presented by an individual or two people, but 

it is also possible to produce collaborative podcasts 
from multiple contributors. Podcasts are like radio pro-
grammes that you can listen to whenever you want.

What do you need?
●● A pen and paper, or a word processor ●● Something to record audio with (a mobile phone, 

laptop or tablet)

What do you do?
●● The first thing to do is develop a script, so write 

down the key words you need to mention about 
this topic, and based on these words create some 
sentences. Using those sentences and the content 
from the Template Script above, create a script that 
you can read for the podcast. If you want to create a 
5-min podcast, that is usually somewhere between 
500 and 750 words in the script.

●● Rehearse reading the script a few times before re-
cording.

●● Some of us prefer sitting down at a table went re-
cording; others like to do it standing.

●● Start the recording device and read the script. Al-
most all mobile phones, laptops and tablets have 
recording software on them.

●● If you make a mistake, just stop the recording, and 
take a breath and start again. If you keep making 
mistakes after five recordings, take a break, make 
yourself a cup of tea and come back to it later. When 
you are happy with the recording, save that record-
ing

Online or offline?
●● If you want to distribute this recording offline, you 

can copy the audio file onto a USB memory stick and 
hand it out in class.

●● If you and your learners have access to the inter-
net, you have many options to distribute it to your 
learners. You can share it with them using cloud 

storage (e.g. Dropbox, Google Drive, and AWS), you 
can email it to them, if you have a website, you can 
upload it there, or to a virtual learning environment 
(e.g. Moodle, Blackboard, and Edmodo). You can also 
add it to a podcasting site (e.g. Podomatic, Sound-
cloud or Audioboom)

Blend-it-well Handbook 
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2.3.5	 Creating a Simple Video

A video recording is a recording of visual and audio 
information received by a camera. A wide range of ex-
pert video recording software is available, but almost 

all mobile phones, laptops and tablets have basic video 
recording software already on them.

What do you need?
●● A pen and paper, or a word processor ●● Something to record video with (a mobile phone, 

laptop or tablet)

What do you do?
●● The first thing to do is develop a script, so write 

down the key words you need to mention about 
this topic, and based on these words create some 
sentences. Using those sentences and the content 
from the Template Script above, create a script that 
you can read for the podcast. If you want to create a 
5-min video, that is usually somewhere between 500 
and 750 words in the script.

●● Rehearse reading the script a few times before re-
cording.

●● Record yourself against a blank wall with a copy of 
the script taped to the wall near the camera.

●● Do not look at the camera, look through it, and im-
agine there is a learner right behind the camera.

●● If you make a mistake, just stop the recording, and 
take a breath and start again. If you keep making 
mistakes after five recordings, take a break, make 
yourself a cup of tea and come back to it later. When 
you are happy with the recording, save that record-
ing.

Online or offline?
●● If you want to distribute this recording offline, you 

can copy the video file onto a USB memory stick and 
hand it out in class.

●● If you and your learners have access to the inter-
net, you have many options to distribute it to your 
learners. You can share it with them using cloud 

storage (e.g. Dropbox, Google Drive, and AWS), you 
can email it to them, if you have a website, you can 
upload it there, or to a virtual learning environment 
(e.g. Moodle, Blackboard, and Edmodo). You can also 
add it to a video sharing site (e.g. Youtube, Vimeo, 
and Dailymotion).

2. 	 The Blended Educator:  A Pilot Approach
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2.3.6	 Creating a PDF Document

Creating an easy-to-read document for the learners can 
be very helpful in terms of producing content that they 
can refer to during class and afterwards. In the context 

of the pilot, we are going to focus on developing a doc-
ument in PDF format.

What do you need?
●● A word processor (that’s a fancy term foan office 

computer) 

What do you do?
●● There are many ways to create a PDF document, one 

of the easiest ways is to use Microsoft Word, LibreOf-
fice or OpenOffice Writer. Any of these will allow you 
to save a document as PDF.

●● We believe that a good educational document 
should always start with a glossary of terms. There-
fore, you should consider putting a glossary at the 
start of your document that provides very simple ex-
planations for all of the keywords you will be using.

●● Leave plenty of space for the learners to write notes 
in your document. If you leave a wide margin to the 
left of each page of the document, and some blank 
lines at the bottom of each page, you could sug-
gest that the learners use the Cornell Note Taking 

technique (https://www.timeatlas.com/cornell-note-template/). 
It suggests that the learners should add their own 
diagrams and memory aids in the left margin, and a 
summary of each page at the bottom of that page.

●● Use images where possible, because remember a 
picture really is worth 1000 words.

●● To see if your completed document is visually ap-
pealing, print out a copy of it, and hold it at arm’s 
length: Does anything jump out at you as looking 
cluttered?

●● Consider reading some of Edward Tufte’s work on 
the visual display of information to help you create 
better handouts.

Online or offline?
●● If you want to distribute this document offline, you 

can copy it onto a USB memory stick and hand it out 
in class.

●● If you and your learners have access to the inter-
net, you have many options to distribute it to your 
learners. You can share it with them using cloud 
storage (e.g. Dropbox, Google Drive, and AWS), you 
can email it to them, if you have a website, you can 
upload it there, or to a virtual learning environment 
(e.g. Moodle, Blackboard, and Edmodo). 

Blend-it-well Handbook 

2



27

2.3.7	 Creating a Game

The internet allows you to both play and create a wide 
range of games that can be very helpful to learners. 
This activity is focussed on the creation of simple word 

games (like a crosswords) and developing simple quiz-
zes.

What do you need?
●● Internet access via a mobile phone, laptop or tablet

What do you do?
●● For the word games activity the first thing to do 

is to create a list of words relevant to your topic of 
study and to develop a clue for each of the words. 
The clues can be used in the crossword, as well as 
questions in the quiz activity.

○○ For the crossword activity, go online and lo-
cate a free crossword generator, for example, 
the following

https://crosswordhobbyist.com

http://www.crauswords.com

http://www.eclipsecrossword.com

○○ For the quiz activity, go online and locate a 
free quiz generator, for example, the follow-
ing

https://hotpot.uvic.ca/wintutor6/tutorial.htm

https://www.quiz-maker.com

https://www.vocabtest.com

https://quizlet.com/en-gb

●● Once you have created the game, you will be given 
a web address (a URL) that you can share with your 
learners so that they can play.

Online or offline?
●● This has to be an online activity	

2. 	 The Blended Educator:  A Pilot Approach
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2.3.8 	 Creating a Search Activity

A search activity in this context means using an online 
search engine for learners to explore something and, in 

the process, develop some better understanding. This 
activity focusses on information-based search tasks.

What do you need?
●● Internet access via a mobile phone, laptop or tablet ●● A search engine website (e.g. Google, Bing, and 

Baidu)

What do you do?
Develop a series of questions for the learners to teach 
them how to use a search engine, for example:

●● What was the first search engine online? (The Archie 
search engine.)

●● Find the meaning of word “requisition”. (A thorough 
search)

●● Find a web page that contains the exact phrase: 
learning outcome. (enter  “learning outcome”  in 
your favorite search enginge.)

●● Find a web page that contains the word “learning” 
but NOT the word “teaching”. (Search for “learning   – 
[minus] teaching”)

●● What is Dihydrogen Monoxide? (It is water.)

●● Find out how many miles we are away for Bohola, 
Mayo, Ireland.( Depends on where you are.)

●● What is a European storm petrel? (It is a seabird.)

●● What is the deepest part of the ocean? (It is the Chal-
lenger Deep in the Mariana Trench.)

●● How high is the highest mountain on Earth? (Mount 
Everest, 8848m.)

●● Look for the phrase “Evaluation Criteria” in three dif-
ferent search engines, are the first 10 pages returned 
the same in all three engines? (Very unlikely.)

Online or offline?
●● This has to be an online activity.

Blend-it-well Handbook 
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2.4. 	 Testing the Blended Content with your 
Learners

Now that you know how to create the online content, 
what happens next? You have to blend it into a class-
room experience with your learners. How will you intro-
duce the online content to the learners and what are 
you going to ask them to do with it? One approach to 
introducing the content is to tell them: 

“I have created a resource for you, to make your lives 
easier, and it will help clarify some of the material we 
have been discussing in class. I really did create this 
myself, and it is the first time I have done anything 
like this, so any feedback you have on it would be very 
much appreciated“. 

Alternatively, you might just wait until you are teaching 
a concept in class that closely relates to the resource, 
and then say: 

“So for further information on this, I have a resource 
that I will make available to you to help you better 
understand the material”.

The instructions you give to the learners should be clear 
and simple:

“Before our next class together I would like everyone 
to use this resource for at least 10 minutes, and have a 
pen and paper with you when you are using it to write 
down some notes. When you are finished, write down 
the key three points you took from the material and we 
will share with each other what we learned from it in 
the next class”.

In the next class put the learners in pairs or groups of 
three and get them to discuss with each other what they 
learned from the resource. Next, ask each group to tell 
the whole class if each of the members took different 
ideas from the resource, or did everyone in that group 
have the same three key points. This is a vital step in the 
concept of Blended Learning, that we blend the eLearn-
ing activity back into the classroom so that the learner 
feels the resource is a part of the classroom experience.

A simple way to evaluate the resource at this stage (we 
will do more about this in the next chapter) is to ask the 
learners for a thumbs-up/thumbs-down (thumbs-up for 
“I liked it”, and thumbs-down for “I did not like it”).  If the 
majority of learners are thumbs-down, please don’t get 
discouraged, it would be very unusual for everything to 
go smoothly the first time that you try something new in 
a classroom. Take a few weeks away and try again with a 
different content type. If, on the other hand, this process 
works well, and you get a majority of thumbs-up, that is 
great and you should strike while the iron is hot, and do 
another content type outlined in this chapter. 

2. 	 The Blended Educator:  A Pilot Approach
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E-Moderation

1	 Salmon, G. (2011): E-Moderating: The Key to Teaching and Learning Online (3rd edition), Routledge.

Transitioning from classroom-based learning to an on-
line setting will prove challenging for some learners, so 
leading British researcher Gilly Salmon has developed 
a five-stage model to help educators understand the 
challenges of successfully achieving this transition.1 The 
process outlined below begins by introducing the learn-

ers to the online environment; next, getting them to do 
basic communication tasks; following this they engage 
with the learning materials; next they discuss what they 
are learning with each other and you, the educator; and 
finally they reflect on what they have learned, and ex-
plore and comment on external materials:

Table 2.3 – Salmon five stage model for Blended transitions.

Stage 1 Stage 2 Stage 3 Stage 4 Stage 5

Access and 
Motivation

Online  
Socialisation

Information 
Exchange

Knowledge 
Construction

Development

Introduction to 
online learning

Basic 
communication and 
system usage

Interacting with the 
learning materials

Conferencing with 
other learners and 
the educator 

Connecting to the 
outside world

Salmon points out that the role of the educator chang-
es at each stage and that preparation is key in terms of 
ensuring that the learners successfully transition from 
stage to stage. The educator begins by giving the learn-
ers specific and detailed instructions (and is very wel-

coming and encouraging), and over time the learners 
will develop independence and their own ways to inter-
act with the system and each other; and the educator’s 
role becomes more about facilitation.

Table 2.4 – Salmon’s changing role of educator.

Stage 1 Stage 2 Stage 3 Stage 4 Stage 5

Welcoming and 
encouraging

Linking cultural, 
social and learning 
environments

Tutoring and 
supporting of 
learning materials

Facilitating 
conferencing

Supporting and 
responding

Technical support must go hand-in-hand with this pro-
cess, and as the learners transition between stages, the 
level of interactivity increases (learner-to-learner, and 
learner-to-system), therefore the educator must have 
resources available to aid them in handling technical 

issues. The resources can include; access to technicians, 
online help, textbooks, and online software support. Be-
low are the types of technical activities that will occur at 
each stage.

Table 2.5 – Technical activities at each of Salmon’s five stages.

Stage 1 Stage 2 Stage 3 Stage 4 Stage 5

Set up system and 
provide access

Sending and 
receiving messages

Searching, 
personalising 
software

Conferencing 
support

Providing links to 
external sources

Blend-it-well Handbook 
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2.5	 Evaluating on the Outcome of the Pilot
Well done, you have gotten to the end of the pilot. The 
final step is to evaluate the whole process, reflect on 
what went well and what went badly, and make sure 
that if you are doing this again any problems that came 
up are fixed. 

It is always important to ask yourself two key questions 
during any teaching process: “What am I doing?”, and 
“Why am I doing it?”  These questions help you to reflect 
on the process, and reflection is a very important part 
of any teaching process. Without it we tend to jump to 
conclusions about why things happened, whereas if we 

have structured and focussed questions, we can obtain 
accurate and useful feedback. 

To evaluate the effectiveness of the pilot, we have cre-
ated two questionnaires, one for you and one for your 
learners. The one for you is below, and you can fill your 
answers into this workbook. The learner questionnaire 
is on the next page, and you can copy it for them.

We would like you to fill out the following reflective 
questionnaire:

2. 	 The Blended Educator:  A Pilot Approach

Table 2.6 – Your Evaluation of this Chapter with Pilot Exercises

What went well?

What went badly?

What surprised you?

How long did the pilot take to 
develop?

What were the key technical 
issues?

Was the resource meaningful to 
your learners?

What will you do differently next 
time?

2
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Learner Feedback

1 2 3 4 5
Hated it Disliked it Neutral Liked it Loved it

1 2 3 4 5
Definitely  

not
Would  
not like 

Neutral I would  
like more

I would  
love more

1.	 What did you think of the blended content? – Mark a number

3.	  How much time did you spend engaging with the resource?

4.	  If you would like more blended content, what topic would you like to see?

5.	 Draw a picture of how you would like to see it presented:

2.	 Would you like if there was more blended content?

Blend-it-well Handbook 
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3. 	The Blended Educator: 
Key Considerations

The function of education is to teach one to 
think intensively and to think critically. 

 Martin Luther King Jr. – The Maroon Tiger
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The Blended Educator:  
Key Considerations 

Now that you have completed your pilot, before we 
move onto more advanced blended activities, we 
thought we’d take this chapter to discuss some of the 
important considerations that need to be taken into 
account when moving on to a more large-scale blend-
ed activity. So we will start by discussing why we teach 
and what we can do to help in the teaching process, and 
how to keep learners engaged offline and online. 

Then we will look at a process to help you develop 
Blended Learning content, the key steps you must un-
dertake, and looking at how to develop learning out-
comes and how to create comprehensive storyboards, 
which if you are familiar with already, please feel free to 
skip those sections.

Next, we will have a look at copyright, which becomes 
very important when content goes online, particularly 
if that content is made publically available. Copyright 
is something educators can forget about when creat-
ing content, so this section will outline how copyright 
works, and how to find shareable content using Crea-
tive Commons licences.

The next section will first look at usability and then at 
accessibility. Usability is a way to look at how easy it is 
to use some content, and accessibility looks at whether 
the content is useable by as wide a range of people as 
possible. 

We will finish the chapter with an outline of some of the 
key challenges associated with Blended Learning, and 
how to approach them.

Why teach?
Challenges, pitfalls 

and choices

Usability and 
accessability 

Copyright

The process  
of blending

Key considerations

3
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3.1	 Why Do We Teach, and How Do We Make 
it Effective?

1	 Reeve, J., H. Jang (2006): What Teachers Say and Do to Support Students’ Autonomy during a Learning Activity. Journal of 
Educational Psychology, 98(1), p. 209.

2	 Marzano, R. J. (2010): Art & Science of Teaching. Educational Leadership, 68 (4), p. 82-85.

3	 Boud, D., R. Cohen, J. Sampson (1999): Peer Learning and Assessment. Assessment & Evaluation in Higher Education, 24 (4), p. 
413-426.

4	 Vlachopoulos, P., J. Cowan (2010): Choices of Approaches in e-Moderation: Conclusions from a Grounded Theory Study. Active 
Learning in Higher Education, 11 (3), p. 213-224.

Why do we teach? It is an obvious question, but it is 
worth thinking about, and considering how those 
reasons change and need to be reframed in a Blend-
ed Learning context. Another way of asking the same 
question could be: why do we not just give the learners 
a textbook and tell them to read it?

There are many reasons why we teach the way we do. 
Here are three reasons. We describe them first in the 
classroom context, and then we mention some of the 
additional challenges that occur in the online context:

1) To enthuse learners
It is easier for the learners to learn from someone (you) 
telling them about the content, as opposed to reading 
about it, because you can emphasise key points, you 
can answer questions immediately, you can present re-
al-world examples, and you can motivate and enthuse 
the learners.1 This requires a lot of preparation on your 
behalf, and an empathy to put yourselves in their shoes 
and to remember that even if you have been teaching 
this content for years, it may well be the first time the 
learners have heard it. 

In the blended context there are similar challenges, but 
if this is the first time the learners are doing blended 
tasks, there can be a significant novelty value, which 
can generate enthusiasm for undertaking tasks in this 
context. It is important to make the activities fun to 
help learners succeed at these tasks. Very often it is also 
a good idea to create a few fake learners to help you get 
the ball rolling, so if you start an online discussion as 
the educator and ask some questions, if the learners are 
reluctant to begin answering questions, use one of your 
fake learners to give an initial answer to the questions 
and get the conversation started.

2) To cover the syllabus
A crucial element of teaching is to ensure that the learn-
ers know everything they need to know about a par-
ticular topic and to also help them pass an examination 
or assessment associated with this topic.  To achieve 
this it is important to break a topic into a series of man-
ageable steps and to associate each of the steps with a 
timescale.2 By doing this it is possible to monitor your 
progress in covering the syllabus against the timescale.

In the blended context all of the above still applies, and 
we will remember the old adage that “content is king”, 
therefore to ensure that the learner fully engages with 
the online elements it is important to put content on-
line that isn’t available anywhere else.

3) To create group identity
A good point to remember about teaching is that 
peer-learning is extremely effective, and we should take 
any opportunity we have to get learners working to-
gether, and learning from each other.3 Group work and 
group-based assignments are an easy way of getting 
learners to work in teams, and can help learners devel-
op a sense of identity for their class/group which can 
often serve as a strong form of motivation, in the same 
way that participation in a team-based sporting activi-
ties can help them become motivated to work harder, 
make sacrifices and excel for the glory of their team.

In the blended context getting people to work in groups 
can be more challenging, so it is good if the learners 
upload a picture of themselves and they write a few 
paragraphs about themselves, listing interests, hobbies 
etc. It is also important that groups are encouraged to 
contact each other regularly to allow them to succeed. 
Moderating group work online (called eModeration4) is 
a new skill that needs practice in order for you to be-
come good at it.

Blend-it-well Handbook 
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3.2	 The Blended Learning Process
The process for Blended Learning we are going to use in 
the workbook is based on the ADDIE model of instruc-
tional design. ADDIE stands for Analysis, Design, Devel-
opment, Implementation, and Evaluation, and it repre-
sents a generic approach to any design challenge. If you 
were building a house, it would make sense to proceed 
in the the following stages:

1.	 Determine the number of bedrooms, bathrooms, 
etc. needed based on a number of factors, includ-
ing the budget, the number of family members, 
and available plot sizes (ANALYSIS).

2.	 Hire an architect to create blueprints based on 
these needs (DESIGN).

3.	 Get builders to build the house based on the blue-
prints (DEVELOPMENT).

4.	 Move into the house and see if all the doors work 
and there are any leaks (IMPLEMENTATION).

5.	 any issues and ask the builder to fix them (EVALU-
ATION).

In the context of the development of Blended Learning, 
the stages are as follows:

(See Table 3.1.)  

The benefits of following the approach are that it en-
sures we do not overlook something obvious, as well as 
ensuring that there is a consistent approach to all the 
stages, as well as giving a clear focus on getting the de-
sign completed and helping ensure the success of the 
outcomes. You have already used the ADDIE model, 
the five steps of the pilot process outlined in Chapter 2 
follow ADDIE. In the following sections we will discuss 
some of the steps mentioned in the first two stages 
(Analysis and Design). The development and implemen-
tation stages are discussed in detail in Chapters 4 and 7, 
and the evaluation stage is covered in Chapter 8.

3. 	 The Blended Educator: Key Considerations

Table 3.1 – Stages of Developing Content using ADDIE methodology

Stage Description Outputs

Analysis

The analysis stage clarifies the 
instructional problems and 
objectives, and identifies the learning 
environment and learner's existing 
knowledge and skills.

●● Describe what your learners should know 
coming into this process.

●● Identify constraints in terms of cost, time, and 
scope.

●● Develop learning outcomes.

Design

The design stage deals with 
assessment instruments, exercises, 
content, subject matter analysis, lesson 
planning, and media selection.

●● Describe what will be taught (using a lesson 
plan).

●● Create initial storyboards and scripts.
●● Explore what software tools might be 

needed.

Development
In the development stage, you create 
and assemble content assets described 
in the design stage.

●● Finalise and develop content. 
●● Edit, brand, and publish.
●● Develop quizzes.

Implementation
The implementation stage delivers the 
content to the learners.

●● Present classroom content.
●● Present online content.

Evaluation
The evaluation stage is where you 
assess what worked well and what did 
not, and what you should redesign.

●● Get learner feedback.
●● Do self-reflection.
●● Revise content.

3
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3.2.1	 Learning Outcomes

1	 Bloom, B. S., M. D. Engelhart, E. J. Furst, W. H. Hill, D. R. Krathwohl (1956): Taxonomy of Educational Objectives: The Classification of 
Educational Goals, Handbook I: Cognitive Domain. New York: David McKay Company.

Learning outcomes are created by the educator. They 
are short, simple sentences that outline what a learner is 
expected to know after a particular learning experience. 
They help inform the learners what they are expected 
to achieve with the help of the educator. So if the con-
tent being taught is related to education, a statement of 
learning outcomes might be:

On Completion of this module, the learner will be able 
to:

●● Identify and review a wide variety of learning 
and teaching methods 

●● Discuss the theories of learning that underpin 
their teaching approach

●● Develop effective and efficient self-directed 
study skills

The important thing to note here is that we use ac-
tion verbs to describe what we expect the learners to 
be able to do. When possible we try to avoid using the 
words know, understand or appreciate as these tend to 
be vague and hard to quantify. Instead we try to think 

of what the learners should be able to do in order to 
demonstrate that they have gained the required knowl-
edge. These learning outcomes will give you clues as to 
how to teach the content, as well as what type of blend-
ed activities might be suitable, and what form of assess-
ment you might use.

In 1956 Benjamin Bloom led a group of educators to de-
velop a classification of levels of learning, moving from 
non-critical learning (surface learning) to critical and 
reflective learning (deep learning).1 The lowest level of 
learning, when the learner is taking in the information, 
and trying to remember as much of it as possible with-
out any critical reflection is Level 1 (called the “Knowl-
edge” level). The highest level where the learners have 
deeply engaged with the material is Level 6 (called the 
“Evaluation” level). Below is a description of each of the 
levels, and some verb examples that can be used for 
writing learning outcomes. It is worth noting that in the 
example above the first two learning outcomes have 
verbs from Level 2, and the final learning outcome is 
from Level 4. This is perfectly fine as you might want the 
learners to understand some things more deeply than 
other things.

(See Table 3.2, next page.)

Blend-it-well Handbook 
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3.2.2	  Lesson Plans

Once you have completed your learning outcomes, you 
have a clear idea of what needs to be taught, so now 
you can move onto a lesson plan. The lesson plan is a de-
tailed plan to guide what will happen during the lesson, 
highlighting the goals, the methods and the reviewing 
of the lesson. The lesson plan allows you to undertake a 
structured reflection on how you will combine the on-
line and classroom based activities of a blended activity. 
Some of the key questions that the lesson plan will help 
you reflect on include the following:

●● How much time will it take to teach this content?

●● What are the learner’s strengths and weaknesses?

●● What types of activities should I use?

●● How will I chunk the learning?

●● How will I assess what they have learned?

There are a very wide range of lesson plan templates 
available, and it is a good idea to look online and find 
one that suits your particular needs. We have an exam-
ple lesson plan filled out below, and a blank template 
on the next page:

3. 	 The Blended Educator: Key Considerations

Table 3.2 – Bloom’s Taxonomy Action Verb Examples

Level Description Action Verbs

1. Knowledge
Remember previously 
learned information.

arrange, define, duplicate, label, list, memorize, name, 
order, recognize, relate, recall, repeat, reproduce, state

2. Comprehension
Demonstrate an 
understanding of the facts.

classify, describe, discuss, explain, express, identify, 
indicate, locate, recognize, report, restate, review

3. Application
Apply knowledge to actual 
situations.

apply, choose, demonstrate, dramatize, employ, 
illustrate, interpret, operate, practice, schedule, 
sketch, solve, use

4. Analysis
Break down ideas into 
simpler parts and look for 
generalizations.

analyse, appraise, calculate, categorize, compare, 
contrast, criticize, differentiate, discriminate, 
distinguish, examine

5.  Synthesis
Compile component ideas 
into a new whole solution.

arrange, assemble, collect, compose, construct, 
create, design, develop, formulate, manage, organize, 
plan, prepare

6. Evaluation
Make and defend judgments 
based on internal evidence or 
external criteria.

appraise, argue, assess, attach, choose, compare, 
defend estimate, judge, predict, rate, score, select, 
support, value

3
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Template availabe on www.blenditwell.eu/handbook/templates/Sup04_LessonPlanTemplate.docx

Blend-it-well Handbook 

L e s s o n P l a n

Subject: Educational Models Course: Education

Topic: Learning Theories Designer/Date: Jane Smith 

21-03-2018

Learning Outcomes:

On Completion of this module, the learner will be able to:
-- Identify and review a wide variety of learning and teaching 
methods 
-- Discuss the theories of learning that underpin their teaching 
approach
-- Develop effective and efficient self-directed study skills

Required Prior Knowledge:

No prior knowledge needed.

Procedure:

5 minutes Warm-up activity

10 minutes Introduction to learning theories, a good overview

5 minutes Introduction to the blended materials

15 minutes Using the blended content

10 minutes More detail on learning theories

10 minutes Review the learning

5 minutes Final Questions and instructions for next class

Discussion:

-- What is the purpose of these theories?
-- Do some people learn differently than others?
-- Which theory do you prefer?

Review:

-- What have we learned?
-- What additional questions do we have?

Example of a Lesson Plan 
3
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3.2.3	 Storyboards

In the pilot chapter we saw a simple storyboard, and in 
this chapter we will look at a more detailed storyboard 
template, which can be based on the learning out-
comes and lesson plans you have developed. The key 
field again is the CONTENT field, which should include 
sketches of a website, a video, or other interactive me-
dia. These sketches could initially be hand-drawn to al-
low for flexibility, and crucially it is important to make 
sure you do not put too much content on each story-
board, it is better to chunk the content into a few differ-
ent storyboards to prevent cognitive overload. Remem-
ber to look at the content through the learners’ eyes. In 
addition, if your chosen form of content includes the 
option for audio content as well as visual content then 
you can experiment with finding the balance between 
how much textual information you wish to display vis-
ually, and how much you will do as a voice-over.

Here is what each field means in the detailed story-
board:

●● Content Number: Each storyboard gets a succes-
sive sequential number

●● Module: This is the module that is being taught

●● Lesson: This is the specific lesson that is being 
blended

●● Learning Objective: This states the purpose of the 
lesson

●● Content: This can be a visual sketch or text proto-
type of the content

●● Notes: This could be a script, or navigation informa-
tion, or other details

●● Designer/Date: The name of the designer/The date 
of the design

Three examples for storyboards
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Content No.: 57

Module: Introduction to French

Notes:
Lesson: French Movies

Learning objective: To outline some 
useful movies that may help learners 
improve their vocabulary.

Content: This webpage will have 
links to trailers to three 
French movies, as well as 
links to cast lists of each 
of those movies.

The page will be 
navigated to from 
Storyboard CN-56, and 
will link to Storyboard 
CN-58.

The webpage is 
accessible, and it is 
possible to change the 
background colours.

Designer: Jane Smith Date: 04/05/66
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Content No.: 7

Module: Computer Networks

Notes:
Lesson: Network Topologies

Learning objective: To explain how a 
tree topology network configuration passes 
messages between computers. 

Content: This PowerPoint slide 
will have little animations 
of packages travelling 
(represented as brown 
boxes).

The slide will be navigated 
to from Storyboard CN-6, 
and will link to Storyboard 
CN-8.

This set of slides will also 
cover other topologies, 
including ring, star, and 
hybrid topologies.Designer: Jane Smith Date: 12/06/65

Content No.: 
24

Module: Good Design Practice

Notes:
Lesson: Designing a Bus Stop

Learning objective: To explain how to design 
bus stops and where to place it on the footpath 
relative to a bin.

Content: This is a video showing 
a persona (Mary Normal) 
at a bus stop.

The narration will be:

Mary Normal goes for 
a walk, and along the 
street, she encounters 
curb-cuts, ATMs, Bus-
stops and littler bins.

The video will be 
accessible and will have 
subtitles and closed 
captioning.

Designer: Jane Smith Date: 14/11/65
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Template available as .docx at www.blenditwell.eu/handbook/templatesw/BL_Sup01_StoryBoardTemplage.docx

Story Board Template
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3.3 	 Adult Education Versus Other Forms of 
Organised Learning

It is important to be aware of the concrete teaching sit-
uations we are in. 

Everybody who reads this book is probably an educator, 
teacher, trainer, facilitator, manager etc. in adult edu-
cation. This means, you are working with certain types 
of learners, and you are doing this in a situation that is 
probably quite different from other school types. 

Contemporary adult education is distinct from prima-
ry and secondary school, but also from other forms of 
formal education such as higher education (at univer-
sities and the like) or vocational training (at vocational 
schools, in enterprises).

Good adult education treats learners differently. Its 
task is to provide favourable learning environments for 
adults of any educational level by approaching them 
as what they are: individuals who have their own set of 
experiences and competences, and who have opinions 
they want to see valued. This is not only true for the ed-
ucated but also for the so-called low-skilled, who in fact 
do have skills, just not those usually valued in the sys-
tems of formal education. Good adult education uses 
these pre-existing skills to build upon. 

In many contexts, adult education in that sense is also 
not that much about learning certain skills or compe-
tencies (although this might also be the case in certain 
settings). It often is rather about developing one’s per-
sonality, discovering new facets of the world, leading a 
healthy life, and so on. Sometimes people attend adult 
education events not so much for learning, rather in or-
der to share the company of people with similar inter-
ests. 

Other strands of adult education are more oriented to-
wards practical things in life, be it in the household, be 
it at work. For example learning to use a computer is 
a typical reason someone might want to visit an adult 
education centre. This can be on an entry level, or on a 
quite advanced expert level. Language courses are at-
tended by people who want to use it at work, or simply 
for their holidays. Recently in some European countries, 
providing classes in local language has become a  much 
larger part of the work adult education organisations 
are doing because recently arrived refugees want to 

learn the language quickly and efficiently in order to be 
able to find a job. 

Some of those who use the services of adult education 
organisations take entire sets of courses to get a certifi-
cate as accountants or in other professions. 

Adult education organisations typically are quick and 
flexible in finding out what people want and need, and 
organise learning opportunities around this. 

Adult education offers learning opportunities for the 
average citizens, as well as for special groups of the pop-
ulation. This may include functionally illiterate people – 
research says that about 7-8 per cent of the population 
even in the large industrialized countries are not able 
to read or write at a level necessary for adequate life in 
modern society. 

Adult education may include elderly people who have 
their own interests and requirements.

Sometimes, adult education covers topics that are seen 
as important for society, and therefore society (in form 
of the municipality, or government on a higher level) 
decides to invest money to let adult education organ-
isations offer certain events, or example public debates 
with politicians and citizens about ardent questions.  

This special environment of adult education must be 
taken into account. 

Ask yourself: Who am I? Who am I working with? What 
is the subject matter of the learning activities I prepare? 
Why do people come to attend my course? 

Moreover, when it comes to Blended Learning: what 
part of that can I take to create a little pilot for my first 
blended content? Is Blended Learning at all a suitable 
instrument for the people I am working with? 

In the paragraphs above, we tried to outline briefly what 
makes adult education different from other branches 
of organised learning. However, the picture is not the 
same in all European countries. Each country, each ed-
ucation system and national culture has different tradi-
tions. In addition, the six institutions that cooperated 
in the Blended Learning project started from specific 
backgrounds of their own. In order to become aware of 
this, and to illustrate the difference between countries 
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as well as between types of institutions, in what follows we discuss a number of typical situations how and why 
and for whom learning is organised in our organisations.

VHS Hannover ∙ Germany
VHS Hannover is a typical municipal adult education 
centre as they can be found in practically every German 
town of some importance. Typical learning situations 
include (note that this is a list of random examples, not 
a full list): 

●● Foreign language classes for people who want to 
use the language on their holidays.

●● Health related courses such as Yoga, Pilates and oth-
er techniques. 

●● German language classes for refugees who have re-
cently come into the country.

●● Indian cooking course attended by middle-aged 
men and women, usually with daytime jobs.

●● A class of young adults who after having failed at 
school are now left without any school leaving cer-
tificate. They visit a daytime course for a year to get 
a secondary school leaving certificate; many of them 
have behavioural issues. 

●● A class of trainees for the vocation of Retail Sales-
person. In a three year course which includes intern-
ships in various companies they achieve a full voca-
tional degree. This is vocational re-training paid for 
by the Employment Agency. 

●● Adult educators organise a one-day event for 16-18 
year old learners from various schools in town on 
the topic of “What is the European Union, and do we 
need it?” The event is planned to be as interactive 
and communicative as possible (using a format such 
as World Café).

●● Some  private company commissions VHS Hannover 
to train their staff in accounting and in using accout-
ning related software.  

●● On behalf of the municipality, VHS Hannover organ-
ises courses for parents of school children to liaise 
with immigrant families to improve their childrens’ 
school attendance. 

DOMSpain ∙ Slovenia
DomSpain is an adult education and training organisa-
tion from the province of Tarragona, Catalonia. It pro-
vides courses in foreign languages, ICT, cooking, and 
personal growth for adult learners; training for educa-
tors focusing on improving foreign language compe-
tences, learning to use digital tools in teaching, and new 
teaching methods; extra curriculum activities for school 
children and parents.  

Typical learning situations can include the following:

●● Conversational English/French/German classes, usu-
ally mixed-level and mixed age groups 

●● Foreign language classes for older learners who like 
travelling

●● Classes of English for young adults who need to do 
Cambridge English exams to study abroad or im-
prove employment opportunities

●● Classes on foreign languages for employees in the 
tourism and commercial sectors

●● Computer/Mobile application courses for older 
learners

●● Cookery classes for mixed-level and mixed age 
groups: cooking for singles, Greek/Japanese/Tibet-
an/Nikkei/Korean cuisine

●● Memory workshops for older learners

●● Mindfulness and Meditation workshops for adults

●● Workshops for parents on how to educate their chil-
dren to behave in a responsible way and stay safe 
online

●● Courses on Robotics and Coding, and English Re-
fresher courses for school teachers 

3. 	 The Blended Educator: Key Considerations
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●● Interactive workshops for young adults and youth 
workers on international mobility and the Erasmus+ 
programme

UPI ljudska univerza Žalec ∙ Slovenia
UPI Žalec is a public non-profit institution for education 
and training of adults in the Lower Savinja Valley, Slove-
nia. It offers a wide range of formal and non-formal ed-
ucation programmes, quality guidance and counselling 
services. UPI Žalec runs vocational school programmes, 
primary school classes for adults and numerous non-for-
mal programmes as listed below:

●● Language courses for unemployed who want to im-
prove their employment prospects

●● Language courses for employed people, both job-re-
lated and for leisure time reasons 

●● Language courses for seniors

●● Language courses to prepare for national or foreign 
exams

●● Slovene courses for companies who employ mi-
grants

●● Computer courses for the unemployed and em-
ployed

●● Computer literacy courses for the unemployed

●● Digital workshops for seniors: e-mail use, taking and 
editing photos on the phone, first computer steps, 
Facebook and other social media, etc.

●● Creative workshops and lectures about various top-
ics within Centre of Intergenerational Learning (per-
sonal growth, arts and crafts, sewing workshops etc.)

●● Integration programmes for migrants

●● Study circles (sustainability, health, geography etc.)

●● Music and dance classes for adults etc.

TU D ∙ Ireland
The Technological University of Dublin is a higher ed-
ucation institution offering academic training to (typi-
cally) young adults as highest level of formal education. 
Learning at a university type organisation is character-
ized through a high degree of structuring; measuring of 
outcomes; and  curricula or learning units typically rath-
er long: up to four years for example for a full degree. 
Some forms of learning, though, are short-term: TU 
Dublin also teaches adult learners who typically are em-
ployed and are returning to education through evening 
classes or part-time classes.

Here is a list of how learning is organised, and with what 
attendants: 

●● Students who have completed secondary educa-
tion, and are attending college on a full-time basis to 
obtain a qualification (typically a Bachelor of Science 
degree) to gain entry into full-time employment.

●● Students who are over 23 years old (“mature stu-
dents”) who have been orking, but have decided to 

return to college on a full-time basis to expand their 
employment opportunities.

●● Evening class for students who have full-time work 
during the day, and are obtaining a degree (typical-
ly a BSc) in the evenings and weekends, to expand 
their employment opportunities.

●● Post-graduate students who have graduated within 
the last three years and are returning to college to 
get an MSc qualification on a full-time basis.

●● Post-graduate students who are graduated for more 
than three years and are returning to college to get 
an MSc qualification on a part-time basis.

●● Post-graduate students who are graduated within 
the last three years and are returning to college to 
get a PhD qualification on a full-time basis
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3.4	 Copyright and Creative Commons

3.4.1	 Copyright

Copyright, as you know, is a legal concept that allows 
the creator of an original piece of work to have exclu-
sive rights for its use and distribution. It is usually only 
granted for a limited period of time. For example in the 
Republic of Ireland copyright for literary, dramatic, mu-
sical and artistic works is for the life of the creator and 70 
years thereafter. For sound recordings, film, and broad-
casts the term of protection is 50 years from the year of 
creation. Not all copyrights expire. For example, in the 
United Kingdom the copyright for J.M. Barrie’s play Pe-
ter Pan was granted in perpetuity to the Great Ormond 
Street Hospital, a children’s hospital in London, based on 
Barrie’s wishes.

The exclusive rights are not absolute. There are excep-
tions such as “Fair Dealing” (also known as “Fair Use”) 
which is an umbrella term for a collection of exceptions 
that are not considered to prejudice the rights of the 
copyright holder. Examples of these include: 

●● Using the content for research or private study

●● Using it for criticism or review or for reporting cur-
rent events

●● Copying a small amount of the content that doesn’t 
represent a “substantial” part of the work

●● For educational purposes

●● Parodies and pastiches

A major limitation on copyright is that copyright pro-
tects only the original expression of ideas, and not the 
underlying ideas themselves. 

It is worth discussing copyright because even if you 
never have had to consider it in a classroom setting, if 
you are developing online content, and particularly if 
you are making that content publically available, it is 
important to be sure the content you generate doesn’t 
include any copyrighted materials, or you have the 
explicit (written) permission by the authors (or rights 
holders) to do so. 

For Example: Copyright Claims Gone Wild
An interesting example concerning 
copyright (that might be worth 
mentioning to learners) is the 
Monkey Selfie Copyright Dispute. 
In 2011 wildlife photographer 
David Slater went to Indonesia 
to take photographs of an 
endangered monkey species 
(the Celebes crested macaques). 
Slater spent a couple of days with 
the monkeys, teaching them 
how to click the shutter-release 
button on his camera to take a 
picture. One of the monkeys took 
a picture of itself (on the right), 
which was published in several 
British newspapers including the 
Daily Mail, The Telegraph, and The 
Guardian, on 4th July 2011. Five 
days later the image was uploaded 
onto Wikimedia Commons, a site 
that only accepts media available 
under a free content license, in 

the public domain, or otherwise 
ineligible for copyright, asserting 
that the photographs were in 
the public domain as “the work 
of a non-human animal, it has no 
human author in whom copyright 
is vested”. Slater asked Wikimedia 
Commons to take down the 
pictures, which they did for a time, 
but after a lot of internal discussion 
agreed that the monkey took the 
picture, and the monkey can’t hold 
copyright. Slater argued that he 
set up the shot, practiced with the 
monkeys, and even held the tripod 
for this shot, so he was the owner 
of the picture. But on 21st August 
2014 the United States Copyright 
Office ruled that the picture 
cannot be copyrighted as it wasn’t 
taken by a human. (It is important, 
though, to notice that this is only 
the opinion of one court in one 

country. Other courts in other 
countries might decide differently.) 
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3.4.2 	 Creative Commons

To help avoid copyright pitfalls an American non-profit 
organization called Creative Commons (CC) was set up 
in 2001 by Harvard scholar Lawrence Lessig to expand 
“the range of creative works available for others to build 
upon legally and to share”. To achieve this the organi-
sation has created a number of standard, free legal 
permissions – called Creative Commons licenses – that 
describe which rights the creator wants to reserve and 
which they are willing to waive for the benefit of other 
creators. 

Creative Commons licenses are not designed to replace 
copyright, but they can replace individual negotiations 
for specific rights between copyright owner and licen-
sees, which are necessary under an “all rights reserved” 
copyright management. 

By 2015 over one billion works were licensed under the 
various Creative Commons licenses.

Organisations like Google Images, Flickr, YouTube, 
Vimeo, SoundCloud, and Wikipedia use Creative Com-
mons licenses. So when you upload content to them, 
you are asked which licence you wish to attach to that 
content. A useful website to search for content that has 
Creative Commons licenses is:

●● https://search.creativecommons.org

Creative Commons Licence Elements 
There are six standard Creative Commons licences avail-
able. Each licence is formed from one or more of the fol-
lowing four licence elements:

1.	 Attribution: This means that others must credit 
you as the original creator of the work. All Creative 
Commons licences require users to provide attribu-
tion.

2.	 Non-Commercial: This means that others may not 
share, adapt or reuse use your work if their use is 
primarily intended for commercial advantage or 
monetary compensation.

3.	 NoDerivatives: This means that others can share 
your work, but they must not change it. Note that 
users still have the range of fair dealing rights.

4.	 ShareAlike: This means that those who adapt or 
remix your work must use the same Creative Com-
mons licence on any derivative works.

There are standard icons associated with each of those 
elements:

(a) Attribution (b) Non-Commercial

(c) NoDerivatives (d) ShareAlike

Fig. 3.2 – Creative Commons Licence Elements Logos.

When publishing something under a Creative Com-
mons licence, you are supposed to add the respective 
icons (one, or several, according to your choice of li-
cencing) to your work, e.g. in the imprint of your book. 

You can do that by adding the symbols as graphics (pic-
tures).  An other way, that is very convenient when you 
publish things more frequently, is the following: Crea-
tive Commons icons are also available as typesetting 
fonts (both for Windows and Apple operating systems). 
You can download them for free and install them on 
your computer like you would do with other fonts such 
as your ubiquitous Times New Roman or Arial fonts. The 
font available in 2018/2019 was called CC-icons (cc-
cons.ttf ).   
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Learner Activity: Copyright Challenge  

Instruction 

Make a copy of these images, cut them out, and hand them out to your learners (in groups or individually) and ask 
them to find out what they mean. If you want to be nice you could give them a clue and say, “this is related to Creative 
Commons”. Maybe ask them to email you the answer, or tweet it, or contribute it to a wiki.

b n
d a

Lo

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Attribution

This licence lets others distribute, remix, tweak, and build upon your 
work, even commercially, as long as they credit you for the original 
creation.

Attribution-NonCommercial

This licence lets others remix, tweak, and build upon your work 
non-commercially with credit to you (their new works must also be 
non-commercial).

Attribution-ShareAlike

This licence lets others remix, tweak, and build upon your work even 
for commercial purposes, as long as they credit you and license their 
new creations under the identical terms.

Attribution-NonCommercial-ShareAlike

This licence lets others remix, tweak, and build upon your work 
non-commercially, as long as they credit you and license their new 
creations under the identical terms.

Attribution-NoDerivatives

This licence allows for redistribution, commercial and non-commer-
cial, as long as it is passed along unchanged and in whole, with credit 
to you.

Attribution-NonCommercial-NoDerivatives

This licence is the most restrictive of our six main licences, only allow-
ing others to download your works and share them with others as 
long as they credit you, but they cannot change them in any way or 
use them commercially.

All logos used for CC liensing are avaible for download in various formats (pixel and vector) at:  
https://creativecommons.org/about/downloads

Creative Commons Licence Elements
From the four basic licence elements in the Creative Commens universe, the following six standard licences are avail-
able (there are more, but these are the most common ones): 
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3.5 	 Usability and Accessibility

3.5.1	  Usability

1	 Gould, J. D., C. Lewis (1985): Designing for Usability: Key Principles and What Designers Think. Communications of the ACM, 28 (3).

When developing content it is important to remember 
to design it in such a way that it is easy to understand 
how to use the content. So for example if you create an 
interactive quiz and the learners can’t figure out how to 
answer the quiz because the interface is either not easy-
to-use or not easy to learn-to-use, then it will not only 
fail its objective but it will also frustrate learners.

Three key pillars of good usability are:1

1.	 User-centred Design: The sooner you involve 
learners in the design of content, the more likely 
they are to be happy with the outcome. Their in-
volvement could be as simple as consulting them 
on choice of colour, or it could be presenting them 
with early storyboards or prototypes for feedback.

2.	 Measure Progress: At the start of the develop-
ment of content, decide on what metrics you are 
going to measure to ensure the completed content 
meets the needs you set out to achieve. This could 
be something as simple as counting the number of 
clicks it takes a learner to complete a task, to meas-
uring how long it takes for a learner to learn how to 
use the complete system.

3.	 Iterative Design: Developing educational content 
does not have to be a one-time thing. Once the 
content is completed it can be tested, and based 
on the feedback of that testing, the content can be 
redesigned and redeveloped leading to retesting. 
The process can reoccur over and over again until 
no problems are found in the testing any more. This 
process of testing-improving-re-testing etc. is com-
monly called “iterative design”.

An effective way to test the usability of content is to in-
vite a small pool of learners to participate in a usabili-
ty testing session. During this session the learners are 
given a series of tasks to complete using the content, 
without any assistance from you. If you get them to do it 
one at a time you can note how they approach the tasks, 
what level of frustration occurs, and how long it takes to 
accomplish each task.  Analysis of several learners’ per-
formance can help improve the system.

Observation is only one of a number of methods of usa-
bility evaluation. Others include GOMS (Goals, Operator, 
Methods, and Selection rules), the think-aloud protocol, 
and personas. These are detailed in Chapter 8: Blended 
Evaluation). 

There are a number of design guidelines that have been 
developed to aid designers in creating usable content, 
including Christopher Wickens’ Thirteen Principles of 
Display Design and Ben Shneiderman’s Eight Golden 
Rules of Interface Design. The most widespread guide-
lines for usability are Jakob Nielsen’s Ten Heuristics from 
his 1994 book Usability Engineering. Those heuristics 
are outlined on the next page, and there is a check 
sheet for them on the following page.

Nielsen defined the five quality components of usability 
as:

1.	 Learnability

2.	 Efficiency

3.	 Memorability

4.	 Errors (as in low error rate)

5.	 Satisfaction. 

which can be used as effective measures in a usability 
testing session.
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Blend-it-well Handbook 

Nielsen’s Heuristics

Heuristic Description

1. 	 Visibility of system 
status

The user needs to know what’s going on inside the system within a 
reasonable time. For example when uploading files using Google Drive, 
a pop-up window appears that indicates the file is being uploaded, and 
confirms when the upload is completed.

2.	 Match between system 
and the real world

The user needs to understand what is happening so the system uses 
terminology that the user is familiar with. For example if the user of the 
system uses British spelling and terminology (as opposed to  US American), 
then the system should use British spelling and terminology.

3. 	 User control and 
freedom

The user should have some freedom of choice when using the system, and 
if the user selects an option in error, it should be possible to undo that error. 
For example when you delete an email in your favourite e-mail application or 
website, a message appears saying: “The conversation has been moved to the 
Trash –  Learn more –  Undo”, leaving the user the chance to undo.

4. 	 Consistency and 
standards

Different parts of the system should not have a different look-and-feel, either 
in terms of appearance, actions or terminology. For example a button that 
does one thing on one screen shouldn’t do something different on another 
screen. The opposite is also true: the same function shouldn’t be represented 
by two different buttons on two different screens.

5. 	 Error prevention

The user should be prevented from making errors. This can be achieved by 
testing prototype systems with users to identify common errors, and either 
eliminate their source by redesign, or add a function to ask the users: “Are you 
sure?”, before you allow them to do it. For example many email systems check 
if you have the word “attached” in your message, and will suggest you should 
include an attachment if you haven’t already.  

6. 	 Recognition rather 
than recall

The user shouldn’t have to recall a large amount of information from page to 
page. Rather, the system should minimise the user's memory load by making 
objects, actions, and options visible. For example, many website provide 
breadcrumbs to show the user their current location within a website, such 
as:  Home > Publications > Books > The Blended Learning Guide.

7. 	 Flexibility and 
efficiency of use

The system should have different ways of doing the same thing depending 
on the user’s level of experience. This includes having hidden options 
(“accelerators”) for expert users that novice users don’t need to know about. 
For example when copying-and-pasting in Microsoft Word, the novice user 
can do Right-Click Copy, and Right-Click Paste, and the expert user can do 
Ctrl-C and Ctrl-V.

8. 	 Aesthetic and 
minimalist design

The user should only be presented with information that is directly relevant to 
the current interaction. Keep the information on each page to the necessary 
minimum. (The Google Search home page is a good example of this.)

9. 	 Error recovery

Error messages should indicate in plain language what the problem actually 
is, and constructively suggest a solution. A message like “System Error 4245” 
is usually useless. Better is something like: “You typed in some letters, but you 
should have typed in numbers.”

10. 	Help and 
documentation

All help should be easy to search, focussed on the user's task, list concrete 
steps to be carried out, and not be too large. For example, a Frequently Asked 
Questions (FAQ) list can often be more attractive to users than a manual.
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Nielsen’s Heuristics Check Sheet

Content: Reviewer: Date:

1. 	 Visibility of system status

2. 	 Match between system and the real 
world

3. 	 User control and freedom

4. 	 Consistency and standards

5. 	 Error prevention

6. 	 Recognition rather than recall

7. 	 Flexibility and efficiency of use

8. 	 Aesthetic and minimalist design

9. 	 Error recovery

10. 	Help and documentation
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3.5.2	  Accessibility

The previous section explained the concept of Usability, 
which considers how easy content is to use for a typical 
user. Accessibility takes this one step further and consid-
ers how easy content is to use for a user with an impair-
ment or disability. 

Typical impairments can be visual impairments (includ-
ing blindness), auditory impairments (including deaf-
ness), mobility impairments, cognitive impairments 
(including dyslexia, ADHD, Autism), and neurological 
impairments (including the use of memory, cognition, 
sensory skills, organizational skills, social skills).

There are specific software and hardware tools called 
Assistive Technologies that can help a user access on-
line information and use computers. Computers have 
a screen, and they display textual information; which 
can be challenging for users with a visual impairment 
(or those who are blind). Nonetheless with the use of 
a software tool called a screen reader those users can 
access online information, as the screen reader will read 
out the text from the screen. 

Below are some accessibility tips for the six types of 
blended activities featured in this book:

Accessible Presentations
●● Presentations are usually a combination of text 

and images. If you have learners with visual impair-
ments, the text will be readable with a screen read-
er, but images may need a little more work to help 
those learners. In many text and graphics editing 
programmes (starting for example with MS Word or 
Powerpoint) if you you right-click on an image (or 
shape, or SmartArt, or video), and select Format > 
Properties you will get an Alt Text (alternative text) 
dialogue where you may add a textual description of 
the visual element. Screen readers will read out this 
textual description. 

●● If the presentation software has built-in slide de-
signs (for example Title, Two Content, Blank, Com-
parison), try to use those as they will be well under-
stood by the screen reader, whereas if you do your 
own formatting of slides it may cause confusion.

●● If you are adding hyperlinks to a presentation, 
make sure the linking text gives a clear indication of 
the destination. Something like “Click Here” is insuf-

ficient compared to text that says “Link to the Irish 
National Disability Authority Website”.

●● Make sure the text and images are coloured in such 
a way that there is enough contrast with the back-
ground colour. Use an online contrast checker if you 
are not sure that what you did is sufficient, e.g.

https://webaim.org/resources/contrastchecker/

Accessible Podcasts
●● Create a transcript of the podcast. If you are too lazy 

to type yourself, you can try a number of software 
tools online to convert audio files into text. (Quality 
of such robotic transcripts is often insufficient with-
out human post-editing, but this technology is mak-
ing quick progress, so checking again after a couple 
of years may be a good idea.)  If you include the tran-
script on the same webpage as your podcast, it will 
make it easier for search engines to find it.

●● Use the transcript to create Show Notes for the pod-
cast, which can include:

○○ Title of Podcast

○○ Episode Number

○○ File Size

○○ 3-5 Key Takeaways from the Podcast

○○ The Transcript

○○ Best moments from the Podcast

○○ External links to useful information related to 
the topic of the podcast

Accessible Videos
●● Create a transcript of the video. – For details, see 

above in the section on Accessible Podcasts.

●● Use the transcript to create Closed Captions for the 
video. Closed Captions is a term used for subtitles 
that do not only show the words spoken, but also in-
clude text descriptions of non-speech elements, e.g. 
the identity of speakers, their manner of speaking, 
background music and other relevant audible infor-
mation. They are called “Closed Captions” because 
usually they are set to be not visible by default but 
only on special request by the viewer (or audience).
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●● You can also consider adding an additional 
soundtrack of video descriptions. This are audio 
descriptions of the video’s key visual elements. They 
are usually inserted into natural pauses in the dia-
logue.

●● If one of the settings you have control over is au-
to-play, it is better to switch that off. Let the learners 
themselves decide when they want to start playing 
the video.

●● Under no circumstances include flashing or strob-
ing content in your video. It can trigger epilepsy 
attacks in some learners. If you are not sure if your 
video can cause problems, download the Photosen-
sitive Epilepsy Analysis Tool from the Trace Center to 
test it.  Source: 

http://trace.umd.edu/peat

Accessible Documents
●● If the document is a combination of text and im-

ages, learners with visual impairments can access 
the text with a screen reader. But the images may 
need a little more work to help those learners. Use 
the “alternative text” (Alt Text) feature of such graph-
ics to add some explanatory text. E.g. if the picture 
shows a sailing ship and blue sky, add a descriptive 
text “Sailing ship and blue sky” which screen readers 
will read out. In most editing software you can get to 
the Alt Text dialogue through clicking something like 
Format >  Properties > Alt Text. 

●● If you are adding hyperlinks to a document, make 
sure the linking text gives a clear indication of the 
destination.  Something like “Click Here” is insuffi-
cient compared to text that says: “Link to the Irish 
National Disability Authority Website”.

●● Make sure the text and images are coloured in such 
a way that there is enough contrast with the back-
ground colour. Use an online contrast checker if you 
are not sure that what you did is sufficient. Source 
for example: 

https://webaim.org/resources/contrastchecker/

●● To make reading easier, consider using sans serif 
fonts (for example, Arial, Comic Sans, Verdana, Sas-
soon or Open Sans), and try to use as large a font size 
as possible, at least 18 point.

Accessible Games
●● There are a range of audio games designed for vis-

ually impaired learners. These games can be played 
without any visual feedback. To learn more and see 
some examples, visit

 www.audiogames.net.

●● There are a range of games designed to be played 
using a single switch for learners with severe mo-
tor impairments or cognitive impairments. To learn 
more and see some examples, visit 

http://www.oneswitch.org.uk.

●● There are a range of games designed for learners 
with a learning disability. To learn more and see 
some examples, visit

http://game-accessibility.com.

●● There are a range of games universally designed for 
learners with different impairments. To learn more 
and see some examples, visit

 www.ics.forth.gr/hci/ua-games/index.html.

Accessible Searching
●● Search engines such as Ecosia and DuckDuckGo —

or Google, if you are alternatives-unaware — usual-
ly have a video searching tool to search for videos 
over the entire web. Some sites have advanced vid-
eo search for narrowing down the content, e.g.  www.
google.com/advanced_video_search. Here you can choose 
the option to search only for closed captioning in 
the section: Subtitles > Closed Captioned Only. 

●● To search for videos with proper closed caption-
ing on Youtube (not just the auto generated closed 
captioning, which can be poor), type in your search 
term and add in “, cc” (yes, that’s comma cc). 

3. 	 The Blended Educator: Key Considerations
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3.6	 Challenges, Pitfalls, and Choices 

3.6.1	 Providing Flexibility

1	 Boelens, R., B. De Wever, M. Voet (2017): Four Key Challenges to the Design of Blended Learning: A Systematic Literature Review. 
Educational Research Review, 22, 1-18.

2	 Hattie, J. (2003): Teachers Make a Difference: What is the Research Evidence? Paper presented at the Australian Council for 
Educational Research Annual Conference on Building Teacher Quality, Melbourne.

Many researchers highlight the advantages of provid-
ing more flexibility to the learners in terms of: where 
they learn, when they learn, and even how they learn.1 

This can be facilitated in a wide range of ways, including 
some very complex ways and some more straightfor-
ward ways. 

For example, if you do not typically use e-mail with 
your learners, then that would be a simple way to in-
corporate flexible communications into the blended 
process. Alternatively it is possible to create a discussion 
board using a site like www.proboards.com to build it.

Flexibility can also be delivered in terms of the type of 
content you create in the online setting. You could cre-
ate additional advanced content that would be op-
tional for the very successful learners who wouldn’t find 
the regular content sufficiently challenging. 

Also you could create different types of content based 
on different learning styles, for example VARK (visual, 
auditory, read-write, and kinaesthetic) or the Keirsey 
Temperament Sorter (artisans, guardians, idealists, and 
rationals).

3.6.2 	 Giving Quality Feedback

Feedback is a very important aspect of the teaching 
process. Research indicated that it has a very powerful 
effect on learners’ understanding and achievement.2  It 
is therefore extremely important to do it often and do it 
well. Feedback can be part of the later evaluation pro-
cess, and therefore some of the issues associated with 
feedback will be covered in Chapter 8. But for now we 
will make the following two key points:

1.	 If you have to give negative feedback to learner 
groups, it is best to avoid saying “You guys have a 
problem…” and instead say “We have a problem…”

2.	 In terms of giving individual feedback it is best to 
soften the blow of negative feedback with some 
positive feedback first. We suggest starting feed-
back with some positive points under the heading 
“I like that you …” and following that with your neg-
ative points under the heading “I would have liked 
if you had …”.

On the other hand, especially with adult learners, you 
should be aware that this can also backfire by being 
perceived  as just an introduction to negative feedback. 
Adult learners who are in employment may have expe-

rienced their superiors doing this (especially when they 
just came back from a leadership training) and become 
rightfully suspicious when a superior starts saying posi-
tive things about them, as they know that this happens 
only when negative things are to follow.  

The takeaway is: be aware of the situation and try to see 
it from the perspective of your learners. 

Feedback Form (Example)

I like that you:

1. ___________________________

2. ___________________________

3. ___________________________

I would have liked if you had:

1. ___________________________

2. ___________________________

3. ___________________________
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3.6.3 	 Ensuring Confidentiality

We will reiterate this point in Chapter 5 (The Blended 
Learner), but digital identity is becoming more complex 
in recent years. Digital identity is divided into four dis-
tinct concepts: 

●● the digital footprint, which is all of the information 
that is available about us online that we created; 

●● the digital reputation, which is perceptions this infor-
mation generates in third parties; 

●● the digital shadow, which is what other people say 
about us online or when they take a picture with us 
in it and put it online; 

●● and finally the digital tattoo, which is the data that is 
permanently stored about us online. 

It is important that learners are aware of these different 
aspects of digital identity and that they behave carefully 
in an online setting. 

3. 	 The Blended Educator: Key Considerations
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All growth depends upon activity. Life is manifest only by action.  
There is no development physically or intellectually without effort. 

 Calvin Coolidge – Adequate Brevity.
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The Blended Educator:  
Advanced Activities

Now that we have looked at some 
of the key considerations associat-
ed with developing blended con-
tent, let us take the six activities 
we looked at in the pilot one step 
further, and explore advanced ver-
sions of each of those activities. 

The six activities are, Presentations 
Podcasts, Videos, Documents, 
Games, and Searching. 

For each of the six activities we 
have selected two tasks to give 
you some options to choose from.  

For each of these tasks we have 
detailed instructions as to how to 
start doing them. 

Each task is presented based on the following structure:  (See Table 4.1.) 

Table 4.1 – How the following sections are structured

What do I need?
This section covers what hardware and software is required for you to achieve this 
task.

Where to look for help?
This section mentions online and offline resources that will help you learn more 
about this task. 

How do I prepare?
We have mentioned it before: preparation is key before you start developing 
content. This section gives some advice on what to do to begin doing this task.

What do I do? This section details a step-by-step guide to doing this task.

Teaching benefits
This section lists some of the teaching benefits that can occur when you do this 
task. 

Common mistakes to 
avoid

This section looks at some of the common mistakes people make when 
developing and teaching this task.

Online or offline?
This section explains whether or not you need internet access for you and your 
learners to do this task.

Fig. 4.1 – Topics in this Chapter. 
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4.1	 Presentations
Creating presentations is a really important skill to de-
velop for the blended educator. You may already use 
them in a classroom setting. In a blended context, how-
ever, it is important to remember to add a little more 
information into the presentations, to make them inde-
pendent units of learning.

In this section we’ll look at two tasks associated with 
presentations: creating infographics, and using Prezi, 
which is an online tool for creating presentations.

4.1.1	 Creating Infographics with Canva

Infographics are poster-style representations of infor-
mation in a quick and clear way. The combination of 
text and graphics allows for the information to be more 
easily understood by readers.

As always, it is best you do this with totally within your 
own means. You could draw it on paper, or if you have 
good graphic design software available (e.g. Adobe Il-
lustrator, Adobe InDesign or Corel Draw) you could use 
this. 

In this book, and in this chapter, we do not assume that 
you have such expert tools available. Therefore, let us 
do this tasks by using  free online tools. 

Caveat: The advantage is that it is quick, and that it is 
free. The disadvantage is that the results often are boil-
erplate and standard using just a ready-made template. 
The templates available are usually overly perfect in 
visual appearance; carrying a particular aesthetic (start-
ing with the way they use type-faces). You can however 
reduce this by heavy editing, and creating your own de-
signs from scratch. But these disadvantages aside, you 
may find online tools for making infographics worth 
trying. 

For example, we managed to create the book cover 
(Fig. 4.1., this page) in about 4 minutes from a template 
available at www.canva.com:

What do I need?
●● Computer

●● Internet access

●● The Canva site: www.canva.com

●● Before using the Canva site you need to create an 
account. Click on the  link above and register for free.

Where to look for help?
●● https://support.canva.com offers tutorials and step-by-

step user guides. As a complete novice, click Getting 
Started first.	

●● You can also watch a wide range of Canva tutorials at  
https://designschool.canva.com/tutorials

Blend-it-well Handbook 

Fig. 4.1 –  Book cover quickly created using Canva, from a pre-
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How do I prepare?
●● The first thing to do is develop a script for the top-

ic you want to cover. Write down the key words you 
need to mention about this topic, and based on 
these words create some sentences. (Some people 
do not do this by physically writing as they have 
some clear enough idea in their head. It simply 
depends on what type of a person you are. Taking 
notes can help in the beginning.)

●● If you want to include photos, make sure you pay 
attention to copyright and that the photos are of ap-
propriate quality.

What do I do?
●● Once you have registered you enter the application 

and land on your account page. 

●● The application asks you what you want to design. 
Search around until you find “Infographic”. You can 
also type “Infographic” into the search field. (Add-
ing more information here about how to find that 
section on the Canva websites does not make much 
sense as website layouts can change quickly)  When 
we checked last in Apil 2019, the website looked like 
this: 

●● In this case the icon for “Infographic” is bottom left. 
Click it. You will then get a number of ready-made 
designs for infographics to choose from.

(See Fig. 4.2.)

●● By clicking on one of the templates the window with 
the selected template opens.

●● By clicking on the template, the toolbar appears 
above the selected infographic. You can add text, 
photos, change the font, use colours etc.

Fig. 4.3 – Toolbar for editing content in Canva.
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Fig. 4.2 –  Ready-made designs offered by Canva. (Screenshot 
taken in late 2018.)
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(See Fig. 4.3)

●● There is another menu on the left side of your page. 
The first icon is about templates. Once you have 
chosen the template, you can start playing with it: 
you can add different elements such as photos and 
graphics, add text, change background, upload your 
own photos, create folders and use one of many 
apps to further design your infographics.

●● If you for example click on the Background’ icon, you 
are offered a number of free templates you can use 
to change the original one you selected.

1	 Making sure that colour-blind people can read graphics is a science in itself, all the more as there are several types of colour-
blindness. A good point to start is watching your graphic with your eyes narrowed to slits. This helps you see contrast of 
brightness rather than colour.

●● After choosing the background of your infographic, 
you can start playing with content by adding text. 
Click on “Text” and then drag and drop heading 
types. You can change font faces and colours.

●● Under “Elements” you can add free photos, grids, 
frames, shapes, lines, illustrations, icons and charts 
to your infographic. To select a graphic element, se-
lect your chosen category, and then double-click the 
element, or drag and drop it to the editing screen. 

Teaching Benefits 
●● BenefitsInfographics take textual information and 

convert it into a highly visual piece of content that 
people are more likely to read, understand, and re-
member.

●● A good infographic can tell a story.

●● Infographics encourage learners to think visually 
about topics.

●● They can help learners to better remember statisti-
cal information.

Common Mistakes to Avoid
●● You must define a clear entry point into your graph-

ics. That’s the thing to watch (or read) first. The oppo-
site is “weak flow”: that’s when the reader does not 
know where to look first. 

●● You should organise your information clearly and 
effectively.

●● Keep your colour palette small.

●● Ensure you choose colours with good contrast. 
Some people have problems differentiating certain 
colours.1 

●● Don’t forget your hierarchy.

Online or Offline?
●● You can download your infographic in files: .jpg, 

.png or pdf

Blend-it-well Handbook 
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●● You can share your infographics with your col-
leagues. Simply click the “Share” button on the top 
right of the editor.

4. 	 The Blended Educator: Advanced Activities
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4.1.2	 Creating a Presentation with Prezi

Prezi is an online tool which allows the user to create 
presentations. It is an alternative to slide-based tools 
like PowerPoint (Windows) and Keynote (Mac). The pe-
culiarity is: you draw your presentation on a single can-
vas, and you zoom in and out of parts of the canvas.

What do you need?
●● Computer

●● Internet access

●● The Prezi site: 

https://prezi.com

Where to look for help?
●● Prezi Knowledge base: 

https://support.prezi.com/hc/en-us

●● The book Prezi For Dummies (2010) by Stephanie Di-
amond 

How do I prepare?
●● A good way to begin is by preparing a few points of 

what you would like to cover in your presentation. 
You can also decide what supporting details you 
would like to put in your subtopics.

●● It can be useful to sketch on paper the overall shape 
you want to create on the canvas and create a few 
sketches of specific elements within the canvas.

What do I do?

1) Create your account
Go to the Prezi website. Once there, click on the blue get 
started button. There are several options to pick from:

●● Basic: This is the basic membership, and comes with 
a small amount of online storage. All presentations 
made with this membership are public and can be 
viewed by everyone. 

●● Plus and Premium: for higher monthly fees, you get 
a numer of additional services, for example offline 
access to your presentations. When we last checked 

Fig 4.4 – Changing the background.

Fig. 4.5 – Show animations.
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in June 2019, prices were between 19 und 59 euros 
per month. – There is also an option for a free trial 
for two weeks.

●● To make a new Prezi account, the website will ask 
for your name, e-mail address and a password. Once 
you have entered all your information, simply click 
on the Create your free Basic account button.

2) Making a presentation

a) Create 

●● Once you are in the dashboard, click on the New 
presentation button to get started with making your 
new presentation. This button will take you to a new 
tab called the “Canvas” which is where you will edit 
your Prezi presentation. 

●● It will prompt you to select a pre-made template by 
clicking on one of them and then clicking on the Use 
template button on the bottom.

●● You can also start from an empty sheet of paper (in 
category “General”). Sometimes this is the better 

solution because you are more free to develop your 
ideas.

●● Write a title of presentation and choose who can see 
this presentation. If you are using the free version 
you must choose: “anyone on the web”. 

b) Customize the theme 

●● Change theme options to customize. You can choose 
a predesigned theme, change the background col-
our, or add a background image.

●● From the editor, click the Background & Theme but-
ton in the context toolbar, or go to View > Show 
Background & Theme to get the pop-out sidebar.

(See Fig. 4.4)

c) Lay out your topics 

●● To begin creating your presentation, click on the 
field that reads “Click to add text”. 

d) Add content

●● Topics can also include subtopics that are revealed 
when you enter a topic so your content remains hid-
den until you’re ready to show it. You can fill subtop-
ics with text, images, video and more. 

4. 	 The Blended Educator: Advanced Activities
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e) Adding and editing shapes

●● To add a shape to your presentation go to the area 
where you’d like to add it. Go to Insert > Shape… 
from the top menu. Find the shape you would like 
to add in the sidebar and drag it on to your canvas.

●● In the context toolbar you can adjust the colour, bor-
der colour, and border thickness. You can also select 
a present colour according to the theme of the tem-
plate.

f) Structure type

●● You can freely place subtopics anywhere on your 
canvas. Select Subtopic and then click the Structure 
type” button in the context toolbar and select Per-
sonalized. If you want to move a subtopic simply 
click on it and drag it. The order subtopics appear 
when presenting is shown in the left sidebar.

g) Using animations

●● In the editor, click on the animation icon in the con-
text toolbar or go to View > Animations to show the 
sidebar. Once you open the sidebar, you’ll see start 
and end points that show where the animations ap-
pear in your presentation. 

(See Fig. 4.5)

●● Select the object or text and select the animation 
you’d like to add.

●● Fade in and fade out. With Fade-in animation you 
control when the object or text appears or disap-
pears. You can fade in or out of images, text, video, 
topics, and subtopics.

●● Add zoom area. Click Add zoom area and a rectangle 
will appear. Resize it and place it to fit the area you’d 
like to include in the zoom.

Fig. 4.6 – Start presentation. 
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h) Adding image, video, audio 

●● Click on Insert at the top of the page. A drop down 
menu will appear that will allow you to add an im-
age, video, audio and much more. 

●● To add a video, you paste the YouTube video URL 
(that’s its address in the internet) into the text field 
and click on the Insert button. The video will be add-
ed to your presentation. Or you can select a video 
from your files. 

3. Present
●● For presenting your presentation to an audience, 

you click the Present button top right. Prezi will 
switch to presentation mode, usually in full screen. 

(See Fig. 4.6)

●● Using the mouse, you can easily jump between 
slides. 

●● Instead of displaying the presentation in a classroom 
through a project, you can also use the Prezi mobile 
app to show the presentation anywhere, whenever 
opportunity strikes.

4. Share 
●● You can send a link to your colleagues. Anyone with 

link can view it but not edit it.

●● Click on the Share button and give the link a name 
so that you later remember what it is for (what pres-
entation, to be shown to whom)

4. 	 The Blended Educator: Advanced Activities
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Teaching Benefits
●● With Prezi you can focus on detail, but you can also 

see the big picture.

●● It creates visual impact. With the zoom in/zoom out 
function, it brings your message to life. 

●● Your audience can navigate the Prezi themselves, 
observe connections of ideas and get a visual im-
pression of concepts.

●● If you already have all your notes in PowerPoint, you 
don’t need to start all over again. Use the Power-
Point Import feature to transfer your existing con-
tent directly into your Prezi.

Common Mistakes to Avoid
●● Confusing transitions: Consider your transitions and 

make sure that you aren’t constantly moving from 
one corner of the presentation board to the other.

●● Printing: Other than standard desktop presentations 
such as Powerpoint and Keynote, Prezi presenta-
tions are not printer friendly. If you need to hand out 

your slides be aware that this might present a bit of 
a road block.

●● Presentations can fail at a crucial moment:  If you 
don’t have the Prezi desktop app, Prezi completely 
depends on your internet connection. But the desk-
top app is only available in paid subscription plans. 

Online or Offline?
●● The default mode of using Prezi is in online mode. To 

show your presentation you go to your account on 
the Prezi site and click the blue “Present” button. For 
situations where you do not have access to the Inter-
net, there is the Prezi desktop app (paid subscription 
required).  

●● If you and your learners have access to the internet, 
you can share it with them. A view link allows anyone 
with the link to view, but not edit, a presentation.

●● Downloading a presentation is available for users 
with a paid subscription such as Prezi Plus.

●● Exporting a presentation to PDF: also only for paying 
subscribers.
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4.2 	 Podcasts

1	 Linguists like calling this a portmanteau word, the notion going back to Lewis Carroll’s Through the Looking Glass.

A podcast is an audio recording mimicking a radio pro-
gramme, but usually distributed as a downloadable file 
via the internet. –  The term “Podcast” is a blending of 
two words1  with pod referring to portable audio devic-

es such as the iPod (which got its name because it re-
motely resembles a pod of peas), and broadcast relating 
to radio programmes.  

4.2.1 	 Podcasts –  How and Why 

What do you need?
●● Pen and paper. Or perhaps you are used to take 

notes on your computer. Anyway, you need some-
thing to write with for planning and scripting.

●● A device to record audio with good quality. You 
could use a voice recorder, but usually you would use 
a computer. Almost all mobile phones, laptops and 
tablets have recording software on them. However, 
important for good quality is a g  ood microphone. 
So, Podcasters usually use external microphones of 
better quality. Good USB microphones start current-
ly (2019) at around 60 euros. Standard advice is to 
purchase a dynamic microphone that is front-firing 
with good rejection, meaning it picks up your voice 
clearly without the unwanted sounds of wherever 
you are recording. That helps for example recording 
your voice but not the hum of your computer’s fan 
or noise from the street outside.  

●● Of course, you theoretically can use any microphone, 
even the built-in one of your computer or mobile 
phone. But this will usually result in less enjoyable 
audio quality.

●● Audio editing software, for example Audacity, which 
will be introduced in the next chapter in detail.

●● An online platform to host your files. Or storage 
memory to save them, and give them to your audi-
ence.

Where to look for help?
●● Simply look in the internet, using your preferred 

search engine, for terms like “Podcast tutorial”. This 
will get you to websites, videos etc. published by 
experienced podcasters. It would not make much 
sense to publish a selection here, as these things be-
come outdated quickly. 

●● You will find good up-to-date podcasting tutorials 
on specialised websites that offer podcasting host-
ing, such as Podomatic, Soundcloud or Audioboom. 

●● Be aware that many of those who publish tutorials 
for podcasting are actually trying to sell stuff, e.g. 
software, podcasting platforms (where you could 
publish your podcasts), or simply equipment like 
microphones. 

●● But to start with, on the following pages of this book 
you will find introductions to two crucial topics:  au-
dio recording, and audio editing. 

Further reading
If you want to read more about the use of podcasts in 
education, try these research papers: 

●● Andrea Chester, Andrew Buntine, Kathryn Ham-
mond and Lyn Atkinson: Podcasting in education: 
Student attitudes, Behaviour and Self-Efficacy. 

https://pdfs.semanticscholar.org/c5dd/a0851367ef6582fad-
42be08a2454ad9dd869.pdf 
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●● Brandon I Collier-Reed, Jennifer M. Case and Angela 
Stott: The influence of podcasting on student learning: 
a case study across two courses. 

https://core.ac.uk/download/pdf/43958163.pdf 

What do I do?

Writing your script
For a start: think of a 5 minutes lecture to give to your 
students (learners, auditory). 

Usually you will need a written text which you then 
read / perform for the record. Experienced teachers and 
writers will be able to write their text right away. But for 
beginners it is better so develop a script step by step. 
Write down the key words you need to mention about 
your topic, and based on these words create some sen-
tences. Using those sentences and the content from the 
Template Script above, create a script that you can read 
for the podcast. 

Think also of reading your text together with a col-
league, in dialogue. This can be much more palatable 
for the audience. One of our colleagues produces a pod-
cast for learning French, and she regularly publishes in-
teresting dialogues in French where she debates issues 
of French language with her friend. 

If you want to create a 5 minutes podcast, that is usually 
somewhere between 500 and 750 words.

Record your audio 
●● Rehearse reading the script a few times before re-

cording.

●● Some of us prefer sitting down at a table when re-
cording, others like to do it standing. Just stay com-
fortable.

●● Start the recording device and read the script. 

●● If you make a mistake, just stop the recording, and 
take a breath and start again. If you keep making 
mistakes after 5 recordings, take a break, make your-
self a cup of tea and come back to it later. 

Publish your audio
●● When you are happy with the recording, save that 

recording, e.g. as an mp3 file. 

●● Publish your podcast on your preferred podcasting 
platform. –  Well, right. Where to publish podcasts, 
that’s an entire topic of its own. It is, unfortunately, 
not covered by this book.  

Teaching Benefits
●● Podcasts allow for portability and convenience; 

learners can access learning resources anytime, an-
ywhere and anyhow, with very little effort. It only 
needs a mobile device.

●● Podcasts can be listened to in otherwise wasted 
time, or alongside a routine activity (sitting on the 
bus, driving the car, washing the dishes or in the 
gym).

●● Learners can be involved in the creation of podcasts, 
asking them to contribute with questions, discus-
sions, presentations or projects.

●● Podcasts may consist in the simple recording of 
your lectures, allowing learners to review them or to 
make up for missed classes.

●● Podcasts can be a great aid for learners with mental 
or visual impairments.

Common Mistakes to Avoid

Use of technolgoy
●● Avoid poor recording quality, which might discour-

age learners to listen until the end of the podcast. 

●● Try to place your microphone so it picks up a min-
imum of the room’s noise (including computer 
noise). Set up the microphone so that it is 4 to 6 
inches away from your mouth.

●● Avoid poor recording quality, which might discour-
age learners to listen until the end of the podcast. 

●● Try to place your microphone so it picks up a min-
imum of the room’s noise (including computer 
noise). Set up the microphone so that it is 4 to 6 
inches away from your mouth.

●● Avoid rooms with a lot of echo from bare walls, ceil-
ings and floors. If necessary, cover parts of them with 
sheets of acoustic foam. Sometimes even a woollen 
blanket or curtains may help.
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Being a voice artist
●● Don’t move too much. While talking, try to look only 

in one direction - moving your head left or right, up 
or down, while you’re talking will change the tonal 
quality of your voice, and may be distracting to your 
listeners. 

●● Don’t speak in monotone with a flat voice. Stress 
meaningful parts and try to hold the attention of 
your audience.

●● Speak in a normal, clear and conversational tone of 
voice.

●● Be consistent in your speech and follow the logical 
progress of your arguments. 

●● Avoid extensive vocal pauses.

●● Don’t break your discourse with a large use of inter-
jections (uhm, ahem, etc.).

●● While talking, speed and slow down at different mo-
ments. Find your own speech pace. 

●● Follow your script. Improvisation doesn’t always 
pays off.

Online or offline?
To make your audio record (your podcast) available to 
your audience, you can do various things. 

●● You can simply copy the file to a memory stick (or 
any other memory, even a CD) and hand it out to our 
audience. This is called “offline” distribution.

●● If you and your learners have access to the internet, 
you have a lot of options to distribute your record-
ing to your learners. 

●● You can share it with them using cloud storage (e.g. 
Dropbox, Google Drive, and AWS).

●● You can email it to them

●● If you have a website you can upload it there

●● You can upload it to a Virtual Learning Environment 
(such as  Moodle, Blackboard, and Edmodo) if you 
have access to one. This could be the Moodle site of 
your adult education organisation. 

●● You can add it to a dedicated podcasting site (e.g. 
Podomatic, Soundcloud or Audioboom). They usual-
ly provide a basic account for free, and ask for mon-
ey if you want more sophisticated features. 

●● Some people publish their audio records also by 
uploading them as videos (with simply one picture 
added to it) on video sharing platforms such as You-
tube. 

4.2.2	 Record Audio with Audacity 

Being able to edit audio recordings is an important skill 
for the blended educator. It is therefore a good idea to 
do even the initial recording with a suitable audio re-
cording device (as opposed to simply pressing the Re-
cord button of your smartphone’s audio recording app). 
Also, usually your audio will not perfect just from the 
initial recording. You will have to do some audio editing. 
We are considering here the use of Audacity, a free soft-
ware programme that allows us to do this.

What do you need?
●● A script for your podcast. (See Chapter 4.2.1 Pod-

casts.) 

●● Audio editing software, here specifically Audaci-
ty (www.audacityteam.org), and a device to run it. That’s 
usually your computer, plus ideally a good external 
microphone. 

●● An online platform to host your files, or a storage 
memory to save it.

Where to look for help?
●● The Audacity online guide:  	

https://manual.audacityteam.org/quick_help.html  

●● The Audacity tutorials:

 https://manual.audacityteam.org/man/tutorials.html 
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●● Simply use an internet search engine and type e.g. 
“Audacity export mp3”. Audacity is a very popular 
programme, so people discuss questions they have 
about using it broadly.

How do I prepare?
●● Go to the Audacity website and download the soft-

ware version compatible with your device (Win-
dows, Mac, or whatever).

●● Install it. 

Here is a little obstacle: usually you will want to save 
your podcasts in the .mp3 audio file format. Audac-
ity can do this, but for reasons of patent law, the au-
dio encoding software for this format is not included 
in the installation package. You need to download 
and install it separately. The Audacity website will 
lead you through that process. 

●● Be sure that audio on your computer is working 
properly, especially that there is a microphone, and 

that it is working. If not, you have to figure out how 
to solve the problem. 

●● Usual things to do in case of problems are checking 
your computer’s sound control panel or the custom 
mixer application for your specific sound card. If you 
use an external microphone, sometimes you have to 
select it in the audio settings to make it work.  Se-
lect the input device you want to use and verify that 
you are getting sound into the computer from that 
device. 

What do I do?	
When Audacity is launched, you will see something like 
this:

(See Fig. 4.7)

First, pay attention to the Device Toolbar.

(See Fig. 4.8)

Fig. 4.7 – The Audacity screen on start of the programme, with not yet any tracks created. 

Fig. 4.8 – Audacity’s Device Toolbar. Settings here are crucial for getting the software working with your hardware.
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You see four dropdown fields. They allow you to select 
(from left to right) a) audio host b) recording device c) 
recording channels e) playback device.,

●● Choose your preferred Audio Host from the drop-
down menu. The Audio Host is the software interface 
between Audacity and the physical sound device 
on your computer. The available choices will vary 
depending on the operating system and your hard-
ware.

●● Choose your preferred recording device from the 
dropdown menu Recording Device. For recording 
podcast, you will simply choose your microphone. 
– Other choices would include loudspeaker. This 
means that the audio signal is taken from the input 
port of your loudspeakers. Or in other words: you re-
cord what your loudspeakers are currently playing.)

●● In the Recording Channels dropdown menu you 
can choose whether you want to record in mono 
(1 channel) or stereo (2 channels). Usually when  re-
cording with one microphone you will want to re-
cord in mono.

●● Turn on the monitoring: click on the microphone 
symbol in the recording meter and start monitoring 
your audio input. 

●● Get your microphone in place and talk at a normal 
volume and watch the recording meter: 

Try to aim for a maximum peak of around -6 dB (or 
0.5 if you have your meter set to linear rather than 
dB). You can always increase the level later after you 
have completed your editing. But recording with 
too low a volume will increase the amount of back-
ground voice on your record, so avoid recording at 
low levels. 

●● Adjust the recording volume with the Recording Vol-
ume Slider:

The meter should get close to the right-hand edge 
without hitting it during the loudest parts (-6 dB is 
a good target).

●● Now you are ready to start with a test recording. 
Click the red Record button in the Transport Toolbar:

Try and record a few sentences, and then click on the 
Stop button.

Have a look at the recorded waveform. This is how a 
properly recorded waveform should look like:

This is in strongly zoomed-in view. The default view 
is more like this:

A clipping waveform, on the other side, has the tops 
and bottoms of the wave chopped off.

This is what happens when the volume of the source 
sent to Audacity is louder than what Audacity can 
record.

Checking the waveform of your record can help you 
create audio files with good quality. If clipping oc-
curred, turn down the recording level a bit and try 
again.

You can also check for clipping by clicking on View > 
Show Clipping. Audacity will display vertical red bars 
in the waveform wherever it detects clipping.
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●● When you are done with your recording, there might 
be some bits at the beginning or end that you want 
to delete – between the time you clicked the Record 
button and the time you started talking. In that case, 
click repeatedly the Zoom in button until the dis-
played waveform expands so you can see from the 
beginning of the recording to the time you started 
talking. Select the area that you want to get rid of 
and choose Edit > Delete (or simply the Delete button 
of your keyboard).

●● If you realise that the volume of your recording is not 
as loud as it needs to be, you can adjust this using 
the Normalize effect. Choose Select > All to select the 
entire track and then click on Effect > Normalize to 
normalise the volume.

●● When you are happy with the final result, save your 
track by clicking on File > Save Project. Choose a 
name for your project and a place to save it.

●● To export your audio file and listen to it in other au-
dio software, choose File > Export > Export Audio, se-
lecting your preferred file format (usually mp3).

●● You can now use this file for publishing your pod-
cast.

Online or offline
(See the section at the end of Chapter 4.2.1 above.)

4.2.3 	 Editing Audio Records by Adding Other Audio 
Elements 

Audio recordings can be augmented with background 
music, ambient sound, audio effects etc. The final prod-
uct is sometimes called a “soundscape” (think of an 
acoustical landscape). For example, the intro, the outro  
and transitions can be highlighted with the use of audio 
pieces, making your whole podcast more attractive and 
engaging. You know this from radio programmes. 

In this chapter we introduce you to a number of things 
you can do in audio editing with Audacity.

What do you need?
●● A script describing the interaction between oral 

texts and music pieces; or at least a good plan for 
this in your mind.

●● A device to record audio with good quality (comput-
er, voice recorder, etc.)

●● Audio editing software, here: Audacity

●● Music or other audio files you want to mix with your 
voice; of course only such that you have to right to 
use for.  

Where to look for help?
●● The Audacity online guide:

 https://manual.audacityteam.org/quick_help.html  

●● The Audacity tutorials:

 https://manual.audacityteam.org/man/tutorials.html 

●● Just do an internet search for topics you are inter-
ested in. Audacity is very popular, so there is a lot 
of help sites and forum discussions around using it.
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How do I prepare?
We assume here that you have already recorded your 
podcast text and saved it to an audio file. (See Chapter 
4.2.2 above) 

●● Choose the music or sound effects you want to mix 
with your voice, and where to place them. 

For royalty free soundtracks you can check here: 

http://freemusicarchive.org/genre/Soundtrack/ 

●● Check that the selected music or sounds effects are 
of good audio quality, making sure that they won’t 
sound bad on your recording.

What do I do?

Setting up the project:
●● Start a new project in Audacity. In practical terms 

that means: open Audacity with a clean screen. 

●● Import the background music file on your project. 
Click on File > Import > Audio… to choose the audio 
file you selected. This will appear as a stereo track on 
the Audacity screen. 

●● Import your podcast record File > Import > Audio... 
This will become a second track on your Audacity 
screen. 

Or alternatively, if you haven’t yet recorded your 
own voice and rather want to talk and record while 
listening to the background music: first, make sure 
that the option Transport > Transport Options > Over-
dub (on/off) is checked; then, using headphones to 

Fig. 4.9 – Typical sight of an Audacity screen with a stereo track, a section of it marked (that’s the lighter area).
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listen to the background track, record your voice. 
The Overdub function makes sure that while record-
ing on a new track, you listen to the sound that is 
already there on other tracks.  

●● Save everything as an Audacity project: File > Save 
Project As >  [Give it a name]. This creates a set of files 
(.aup) that allow for editing. 

Your screen will now look more or less like this:  
(See Fig. 4.9)

Editing the record:
●● Click the Skip to Start button (to make sure you start 

from the beginning), then click the Play button. 

Note that Audacity automatically mixes the music 
and speech from the two tracks for you. Click the 
Stop button when you’re done. 

The Mute and Solo buttons of each track can be used 
to control which track will be heard when clicking on 
the Play button.

●● In the record of your voice, you may want to remove 
some sections, e.g. where you coughed, cleared 
your throat or misspoke and started again. 

You do this by marking the section in question with 
the selection tool: 

With this as your mouse pointer, drag-select a sec-
tion of an audio track. A marked section of the audio 
appears in lighter grey (in older versions of Audacity 
it was darker grey) like here:

(See Fig. 4.10)

In the waveform above, the speaker wanted to cut 
a piece of recording where he/she paused, cleared 
his/her throat and continued with the next sen-
tence. To do so, the throat-clearing chunk has been 
selected (light grey area), with extra space around it 
to make the transition sound natural. 

To remove the selected area, use the Cut tool: 

Or simply press the Delete button on your keyboard. 

But before you do this, you perhaps want to check if 
the cut is well selected. You can do this using Cut Pre-

Fig 4.10 – Marked sections have a different shade, here: lighter grey.

Fig 4.11 – A track with two split points. This splits the track in three parts that can be moved independently.
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view. Simply press “C” on your keyboard, and Audac-
ity will play the section as it would sound after cut-
ting. It starts playing about 2 seconds before the cut. 
That’s the Cut Preview feature. If you are happy with 
the cut, do the cut (Delete or Scissors). If not, adjust 
the selection, until you are happy with the result. 

●● You can split your narration in different clips by 
choosing Edit > Clip Boundaries > Split. This will split 
the track either where you left the Select tool, or at 
both the beginning and the end of a selected area 
(dark grey, or light  grey). 

For example, the track below has two split points, 
resulting in three separate .

(See Fig. 4.11)

With the track split that way, you can now move the 
individual parts around (back and forth) on the time-
line. For doing this, use the Time Shift Tool.

●● To let the talk start at a certain point of your back-
ground music: find the spots in the background mu-
sic where you want each of the different narration 
clips to start. You might even put a label on each 
section, to identify them best throughout your work.

(See Fig. 4.12)

Using the Time Shift Tool, drag the narration clips to 
line them up with the background music’s points 
where you want them to start.

●● When you have the narration clips where you want 
them to be, lower the volume of the background 
music so your listeners can hear what you are say-
ing. You can do it manually by clicking on the 
Envelope Tool on the Tools Toolbar selecting two 
control points and then adjusting them to get the 
length of the track you want the fade to be effective. 
Go back and change the fades until you are happy 
with the result. 

Alternatively, you can use the Auto Duck effect which 
does¬ the same job automatically (Effects > Auto Duck). 
With Auto Duck you can pre-set a certain characteristic 
of transition, and then apply it to selected sections of 
a track. (But note that this needs a second track being 
there against which the reduction of volume will be 
measured.)

Fig. 4.12 – Use labels (bottom row) to mark spots on the timeline in order to find them quickly later.
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●● If you want to fade out the music, first find the point 
where you want the effect to begin. Then choose Se-
lect > Region > Cursor to track end, than choose Effect 
> Fade Out.

●● Check your waveform for possible clippings or bad 
signal.

●● Use the Gain Slider left of your current track to set 
the gain for the track (thus correcting possible clip-
pings). “Gain” means effectively the strength of the 
signal. 

●● Use the Pan Slider to balance the signal between 
right or left side of your speaker or earphone.

Gain and Pan sliders are underneath the Mute and 
Solo buttons. 

●● Save and export the final version of your project. 
Saving means: you save Audacity’s .aup files. If you 
want to create a file that you can give others to listen 
(usually .mp3), you use File > Export.

Online or offline
(See that part of Chapter 4.2.1 Podcasts)
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4.3	 Videos

1	 These were the conditions when checked in April 2019. Of course they will change over time.

Videos can be useful in e-learning environments to add 
more of the human element of teaching. Videos –  as 
opposed to classroom presentations of content –  can 
help learners to control the pace of their learning. 

There are many kinds of videos for educational purpos-
es. A simple concept (but demanding in terms of equip-
ment) is video-recording a gifted teacher lecturing. Or 
you probably have seen full-sized educational films pre-
senting historical events and developments, explaining 
phenomena of physics or chemistry, mathematics, or 
whatever topic, often with a lot of special effects used 

to visualize things. Producing such videos is, of course, 
a lot of work. 

In this part of the book, we want to focus on something 
very simple, but effective: creating short animated vid-
eos that can be used to present some facts. We use an 
online service by the name of Powtoon. This allows us 
to create animated videos in cartoon style. The result is 
something like a beefed-up slides presentation: Power-
point with much more animation than usual, so to say. 

4.3.1	 Creating Animated Videos with Powtoon

Powtoon (www.powtoon.com) allows you to create and pub-
lish animated videos in a relatively simple way as you do 
not need anything but internet access for your comput-
er. Everything is done online. 

Powtoon is a London based company founded in 2012. 

Here is a summary of what you do with Powtoon:  You 
create animated slide shows online. You add to your 
slides cartoon characters that can move; text elements; 
all kinds of drawings; you can use a repertoire of visual 
elements from Powtoon, or you can upload our own 
(images, drawing, videos), and add animated effects to 
them. You can add sound to your slideshow for creating 
a soundtrack with background music and with text spo-
ken (“voiceover”). The animated video can be watched 
on the Powtoon website; it can be exported to video 
places such as Youtube; or you can download it as a vid-
eo file and store it on your own device. 

The company running Powtoon advertises it chiefly 
for business communication. They suggest employees 
using animated slide shows to present information to 
superiors, or HR departments create health and safety 
instructions for employees. But it can also be used for 
creating e-learning content for Blended Learning.  

Basic functions are free. For more sophisticated options, 
however, including the option to download your video 
file, you would need to buy a subscription. Subscrip-
tions are currently (2019) sold from 228 dollars per year 
(including VAT) for the cheapest version.  There is no 
option to subscribe for a shorter period. There are, how-

ever, special “education” subscriptions that are cheaper, 
starting from 85 dollars per year for a “student” account 
(videos up to 10 minutes) and 228 dollars per year for 
full access to everything (for 90 students).1   

The Powtoon site (www.powtoon.com) has a number 
of sample videos, and a detailed help centre. As there 
are many functions, it would fill a book of its own to de-
scribe them all. What we can do here – in this collection 
of useful tools for creating content for Blended Learning 
in adult education – is give you the basic idea, and lead 
you through first steps. 

But be aware that creating such animated videos (or 
animated slideshows) that you can use in your Blend-
ed Learning environment, you will need to dive much 
deeper into the topic. You will need to learn to use the 
many options, and you will need to get a feeling for 
when to use ready-made elements (characters, draw-
ings, chiefly available for paying subscribers), and when 
to use elements you create and upload yourself. 

Another thing to be aware of: Powtoon is not the only 
company providing such services. One recent alterna-
tive is Doodly (www.doodly.com) which is for creating 
doodle videos. “Doodle videos” is a name for that fa-
mous type of videos where you see cartoon-style draw-
ings being created on the fly by a moving pencil, and 
sometimes a hand. 

In the future other such services will appear, and as we 
have seen old ones will disappear e.g the Google+ so-
cial media site has recently been discontinued (2019).  
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Now, here is our “First steps into Powtoon” tutorial: 

What do you need?
●● A computer

●● Internet access

●● The Powtoon site: 

www.powtoon.com

Where to look for help? 
●● The Powtoon Knowledge base:

 https://support.powtoon.com/en/

●● Powtoon tutorials:

 www.powtoon.com/tutorials/

●● A good book is Power Up Your PowToon Studio Project 
(2015) by Bruce Graham, Packt Publishing.

●● Another good book is The Power of Cartoon Market-
ing (2013) by Ilya Spitalnik, CreateSpace Independ-
ent Publishing Platform.

How do I prepare?
●● The first thing to do is develop a script, that’s the 

story you want to tell. This should include the text 
you need, and ideas about visualisation: what to 
show, and in what sequence. Ideally, your story has 
a dramaturgical curve, for example getting back at 
the very end to something that was introduced at 
the beginning. 

●● If you want to create a 5 minutes video with some-
body talking, that is usually somewhere between 
500 and 750 words in the script.

What do I do? 
●● Go to the Powtoon site

●● Create an account (if you do not have one)

●● Skip any initial screens

●● Create a new slideshow by selecting a Blank Pow-
toon:

(Note: The appearance of buttons and all other ele-
ments shown here may be different when you visit the 
site. Websites are under constant reconstruction and 
re-design. Screenshots printed in a book like here get 
outdated quickly.)

●● You will be presented with a number of themes:

(See Fig. 4.13, next page)

●● Select one, and you will get to the main composition 
page:

●● Powtoon uses a slide-based approach to videos. 
That means that the whole story is split over a num-
ber of basic pages (or slides). In traditional film, you 
would call this a scene.  You create and edit one slide 
at a time. Each slide is by default 10 seconds long, 
but you can change this from 1 to 20 seconds. 

●● You see your stack of slides in a column at the left 
hand side of the main page (quite similar as in Pow-
erpoint).
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●● At the bottom of the main page you see the timeline 
for the current slide.

 (See Fig. 4.14)

●● If you want to increase the time a slide is displayed 
you can do this using the + and - buttons on the 
right. A slide can last between 1 seconds to 20 sec-
onds:

(See Fig. 4.15)

The dark triangle indicates the timeline position of 
what is displayed at the moment.

●● To add content to the slides, you use the control tabs 
on the right 

(See Fig. 4.16)

●● First select a background:

You add  elements to your slide simply by clicking on 
them in the right column. The element then appears 
in the middle of your slide, and you can move, resize 
it or otherwise edit it.

●● Next you can add in some text:

●● When you added a text element, look down at the 
timeline: a tab has appeared at Second 1 with the 
first letters of your text, here “TEX”. This means the 
slide will display for one second blank, after which 
the text will appear. You can change the moment for 
the text element to appear by moving its tab to any 
position along the timeline.

(See Fig. 4.17)

●● Next you might want to add “characters”. 

“Characters” are cartoon figures readily available 
for you to use. Each character is provided in various 
moods or activities (called “poses”), such as a greet-
ing, typing at a writing desk, thinking, being happy, 
being angry, or having an idea. 

Powtoon offers various sets of characters. Only two 
or three of them are free. The others are available 
only when you are a paying customer (subscriber).

Fig. 4.13 – Themes for animated videos as available on Powtoon in April 2019 (free account).

Fig. 4.14 – Timeline of the Powtoon video.

Fig. 4.15 – Increase the time a slide is presented with the +/- buttons right hand side.
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Fig. 4.19 – Adding a character into the current slide. 

Fig. 4.17 – A text element inserted at Second 1 of the Timeline.
Fig. 4.21 – Adding sound clips.

Fig. 4.20 –  Move the appearing of the new object (here: a character) on the timeline. 
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●●  Select from the menu of characters:

(See Fig. 4.18, this page)

●● Select a character, and add them into the current 
slide:

(See Fig. 4.19, previous page)

●● We see that the character will appear 2 seconds into 
the timeline.  We can change this by moving the tab:

(See Fig. 4.20, previous page)

●● We also note that each character has four controls 
associated with it (Settings, Pose, Swap, and Flip):

With these you can swap a character with another 
(by keeping the other settings); select its different 
poses; flip it; control a number of other settings, for 
example how it moves. 

●● Adding in Shapes works the same way:

                                            

Shapes are things like squares, triangles and circles. 
Props are drawings of various objects – everything 
that exists in the world, from cars over machines, 
clothing, furniture, and so on. Props are the requi-
sites of your tiny video theatre. As always: only a very 
small selection are available for free, for the rest you 
need a paid subscription. 

●● Adding in sound works as follows:

(See Fig. 4.21, previous page)

You can add voiceover (spoken text). You can record 
this yourself, or you can upload a ready-made record.

●● You can add Media (Videos and Images) and Special 
features. Special features are drawings for various 
events such as Birthdays, Christmas, etc. 

        

Multiple slides make a movie 
●● So far you have worked only on one slide, or one 

“scene” of your animated video. A typical animated 
video of 2 minutes would have about 12 or more 
slides. You have to create all of them. You see: this 
can be rather time-consuming. You will be doing 
this especially when you know that you have a large 
audience and can use the video over a longer period 
of time. 

●● What we explained here is how to create a an ani-
mated video starting with a blank slide (or stack of 
slides). Powtoon offers also something else: they 
have a number of ready-made animated videos that 
can be used as templates that you fill with your own 

4. 	 The Blended Educator: Advanced Activities

Fig. 4.18 – Character sets to choose from (as in May 
2019).
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content, particularly by leaving the story flow as it is, 
but change the text (written and spoken words).  For 
testing we created this video.

You can watch it at:

www.youtube.com/watch?v=zYDYuVekfJI

As you can see in this video, one problem of those 
pre-fabricated video templates can be their shal-
lowness and their sales- and marketing focus. Adult 
educators usually seek more substance, and that 
would mean that the templates cannot be used as 
they are but need heavy editing. The good news is: 
this is possible. Although it is a lot of work. 

Download or share
●● Once you are happy with the completed project, by 

clicking on the Preview and Export button on the top 
of the page, you can upload, download or share the 
project (options vary with subscriptions):

(See Fig. 4.22)

Teaching Benefits
●● There can be great novelty and thus motivation in 

using animated videos.

●● Sometimes when dealing with sensitive issues like 
plagiarism or bullying, it can be better having ani-
mated characters discussing it rather than real peo-
ple.

●● When explaining intangible concepts, like magnet-
ic fields, animation can give the learners a concrete 
conceptualisation. 

●● Animated videos can appeal to a wide range of 
learners.

Common Mistakes to Avoid
●● As you create each slide, always ask yourself, what 

are the educational value of each of the element in 
the slide. It is very easy to add a wide range of effects, 
but they must have a purpose to help the learners 
learn, so don’t add special effects unnecessarily.

●● In a related piece of advice, there is no need to clut-
ter a slide with too much content, since Powtoon is 
a slide-based system, you can break content over a 
number of slides.

●● When you are doing your recording, speak with pas-
sion and don’t be too deadpan.

●● Maintain continuity between slides by using the 
same fonts and design elements. But don’t use the 
same graphics to represent different things on dif-
ferent slides.

●● Avoid using fancy transitions between slides.

●● Read one of Edward Tufte’s books.

Fig 4.22 – Various options for sharing the video, download it, and export it.
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Online or Offline?
●● If you want to distribute this recording offline, you 

can copy the video file onto a USB memory stick and 
hand it out in class. However: for downloading the 
video you need a paid subscription. 

●● If you and your learners have access to the internet, 
you have a lot of options to distribute the video to 
your learners. Except from sharing the video file with 
them via e-mail or file sharing services, you can pres-
ent the video on your website etc. Powtoon also of-
fers direct publishing on major video platforms such 
as Youtube, Vimeo and others. 

4. 	 The Blended Educator: Advanced Activities
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4.3.2 	 Making Videos Interactive Through Add-on 
Quizzes

1	 Information as publicly available in April 2019.

There are a number of ways to add quiz questions to 
pre-existing videos. Here we present one of them: Ed-
puzzle. 

The Edpuzzle website allows you to add questions to 
existing videos at any point of their timeline. It also al-
lows you to edit existing videos to some extent, e.g. by 
cropping or adding content. In this short introduction, 
however, we use it only for adding quiz questions to vid-
eos. 

Edpuzzle is run by a company with its headquarters in 
Barcelona, Spain. Registered in 2014, it is a typical start-
up company supported by business angel and venture 
capitalist money. 1

When we last checked (in April 2019) the pricing mod-
el was as follows: the service is free of charge, but with 
the restriction that only up to 20 videos can be stored 
in one’s space. If you need more, you can try to invite 
friends to subscribe to Edpuzzle, and consequently you 
get more storage. Or you subscribe to the paid service, 
starting at 8,50 dollars per month. And this time the 
pricing is really on a monthly basis, meaning that other 
than for other web services discussed  in this book you 
indeed can subscribe only for a short time, for thorough 
testing.  

What do you need?
●● A computer

●● Internet access

●● The edpuzzle site: https://edpuzzle.com/

Where to look for help?
●● The edpuzzle help centre: 

https://support.edpuzzle.com/hc/en-us

●● Edpuzzle resources: 

https://go.edpuzzle.com/resources/

●● Edpuzzle on twitter: 

https://twitter.com/edpuzzle

How do I prepare?
●● The first thing to do is to locate a video that you 

want to add quiz questions to. “Locating” means: 
make sure it is available somewhere on the typical 
video places in the internet such as Youtube, Vimeo, 
etc. That means: you can use practically every video 
that is out there in the internet. For example, if you 
want to teach maths, you can use the fantastic vid-
eos of the Numberphile series in Youtube, and add 
quiz questions to them. Or of course you can upload 
your own education videos to one of the platforms, 
and then tell Edpuzzle to use that. The important 
thing to understand here is simply that you do not 
upload videos to Edpuzzle. You tell Edpuzzle to use a 
video from one of the popular channels. 

●● Watch the video, and identify what parts of the vid-
eo you want to create quiz questions for.

●● Create the quiz questions –  so far just as a script for 
yourself.  

What do I do?
●● Go to the Edpuzzle site

●● Click on Sign up 

●● Sign up as a teacher

●● Add yourself to an existing or new school.

●● You will be presented with a search window:
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Search for the title of the video you wish to add 
questions to. As explained above, Edpuzzle can take 
any video that is somewhere on the popular video 
platforms in the inter

In the left column of your screen there are places to 
select from:

●● After selecting the channel (Youtube etc) search for 
your video by entering appropriate search terms in 
the search bar.

●● When you have found it, put your mouse pointer on 
the video. Three icons will appear:

●● You can now add this video to your personal collec-
tion of videos by clicking the Copy button. 

●● Go then to My content (menu item in the left column) 
to get your personal collection of videos displayed.

●● Select the Edit icon, and you’ll have the options to 
crop the video, add voiceover, add audio notes, or 
add a quiz:

●● Select  Quizzes and you’ll be presented with the vid-
eo, with a progress bar, with a pointer with a green 
box containing a question mark (?):�

Play the video to the point you want to add a ques-
tion in, pause the video, and click on the green ques-
tion mark underneath the timeline.

●● A small window will appear to the right of the video:

Using the three green buttons, you can create either 
an open-ended question, a multi-choice question, 
or simply add a comment.

You then continue playing the video until you reach 
the next point on the timeline where you want to 
interrupt the video for a question or comment.  

●● Once you have completed your edits, click Save, 
then Finish.

●● Now you have two options: either assign the video 
quiz to a class, or create a public link.

4. 	 The Blended Educator: Advanced Activities
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●● To Assign to a class you need to create a new class:

●● By selecting Public links you can get a URL or an Em-
bed code:

You can give your learners that link, or you embed 
the video quiz in your website, e.g. your Moodle 
learning environment. 

1	 Szpunar, K.K., Khan, N.Y., Schacter, D.L. (2013): Interpolated Memory Tests Reduce Mind Wandering and Improve Learning of Online 
Lectures. Proceedings of the National Academy of Sciences, 110(16), 6313-6317.

An experimental video with quiz
Here is a video with quizzes that we created whilst 
proofreading this book:  

https://edpuzzle.com/media/5ca751dc7270df407df877e4

Teaching Benefits
●● Video quizzes  can be a great novelty and thus a 

great motivator1 

●● They help learners remember key points in the vid-
eos

●● They can help the learners to self-assess their pro-
gress

●● They increase the interactivity of the blended con-
tent

●● They can lead to learners taking active ownership of 
their learning

Admittedly, this is all quite oriented to a school-type 
learning environment, or possibly to vocational training 
in a company. In classical liberal adult education, where 
direct interaction between people is as valued as build-
ing upon their rich life experience, and where topics of-
ten are more complex and philosophical, opportunities 
to use such simple quizzes are restricted. But if you think 
of learning foreign languages, video quizzes can indeed 
be a nice add-on teaching and learning element. So, as 
always, everything depends on finding the right place 
for the right tool.  
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Common Mistakes to Avoid
●● Try to make sure the questions are phrased as clear-

ly, and as simply, as possible. Consider piloting the 
questions on a test group. 

●● Don’t add too many questions to the video. It will 
make the learners feel that they are being over-test-
ed.

●● Review each question: is there a strong reason to 
add it to the video? Could it be merged with another 
question? 

●● Try to avoid “negative” questions, as they can be con-
fusing, e.g. Avoid “Which of the following are not …”. 
Instead, try to have questions that ask “Which of the 
following are…”

●● Consider using fun alternative answers in the ques-
tions

●● Read Oppenheim’s book Questionnaire Design.1

Online or Offline?
You need to be online to use Edpuzzle

1	 Abraham Naftali Oppenheim: Questionnaire Design, Interviewing and Attitude Measurement. First issued 1966
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4.4 	 Documents
A vital part of Blended Learning is providing content to 
learners that they can interact with at their own pace. 
One thing in common use are simple documents deliv-
ered in file formats such as Odt, Docx, or Pdf, which have 
become a world-wide quasi standard. They can be seen 

as electronic representations of an actual piece of print-
ed paper. But there are ways to  make such documents 
interactive and thus more engaging for the learners.

4.4.1 	 Creating Interactive PDF Content

Documents such as reports, articles, or e-magazines of-
ten come as PDF files (Portable Document Format). This 
is a file format initially created to get documents into a 
printing press whilst being sure that formatting is me-
ticulously preserved across platforms, i.e. on all different 
computer systems. But in the recent 20 years, PDFs have 
also become a standard for distributing documents of 
high visual quality to everybody. 

Typically such documents are not meant to be editable 
by the reader. However, today it is possible to create 
PDFs that comprise plenty of tricks and multimedia con-
tent to make them interactive documents – behaving 
not much different from a website. 

For example, you can 

●● add links 

●● add entire menus from where the reader can select 
where to go next 

●● add audio or video files and let your reader view 
them without leaving the document

●● add quiz elements, etc. 

These all are elements you probably know from web-
sites. In an interactive PDF, all these things are includ-
ed in the document. The document can be delivered to 
other people the usual way (e.g. via e-mail). It will dis-
play these functions when opened with Acrobat Reader 
or another suitable PDF reader software. These are usu-
ally available for free. 

What do I need?
●● Computer or laptop (of course)

●● PDF reader software, for example the free Adobe Ac-
robat Reader 

●● A programme to create interactive PDFs. We recom-
mend here Adobe InDesign. That’s what this section 
is about. InDesign has become the industry stand-
ard application to prepare professionally printable 
documents. This is actually an expensive applica-
tion. But you can install it and use it for seven days 
free of charge, for testing. Adobe also has rebates for 
educational institutions.

Note that there are also other ways to create inter-
active PDFs. Very basic things such as hyperlinks 
to external resources can be done in text process-
ing software (MS Word, etc.) and then exported to 
PDF. For more options, using Adobe Acrobat Pro was 
standard over a long time, especially with the “PDF 
form” functions.

Where to look for help?
You will definitely need more help than this book can 
offer you. Adobe InDesign is a complex product. If you 
are so far only familiar with Microsoft products, the way 
organisational layout in Adobe products may be diffi-
cult to grasp (briefly: “palettes” instead of “menus”), and 
you need some time to get used to it. InDesign also has 
a lot of functionalities, and you will need guidance in 
order to find your way through them. Finally if you have 
an older product version, you may run into considerable 
differences as compared to functionality in the newer 
versions. Here are some places to look for help:

●● The Adobe help centre (online) gives useful tips on 
how to get started, tutorials to expand your skills 
and step-by-step instructions. You can also see fre-
quently answered questions and forum discussions 
for solving problems. 

https://helpx.adobe.com/gr_en/support/indesign.html 
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●● There are many websites providing advice on how 
to create interactive content: 

●● Create PDF button tips: 

https://indesignsecrets.com/pdf-button-tips-tricks-and-problem-
solving.php 

●● Create an Interactive PDF form from a word docu-
ment: 

https://theblog.adobe.com/create-an-interactive-pdf-form-from-a-
word-document/   

●● Note however that this then involves the use of Ado-
be Acrobat (full version, not the reader), another 
piece of pricy software that is good to have, but not 
accessible to everyone. 

●● A nice blog that provides instructions for first steps 
with Adobe InDesign: 

https://mariahalthoff.com/blogposts/create-interactive-pdf-indesign

How do I prepare?
We do not have the space here to explain how to use 
use InDesign for total beginners. Adobe programmes 
work in different fashion to Microsoft or OpenOffice. 
In what follows we presuppose that you have already 
some experience with InDesign e.g. because you used it 
to create leaflets, posters, or a brochure.

●● Design your pages in InDesign as you would normal-
ly do. Your document needs to be (almost) finished 
before you start adding interactivity into it.

●● Decide which kind of interactivity you would like to 
add. 

The field of expertise you might want to explore 
here is called Instructional Design. It can help you 
on where it is useful to include interactive objects in 
order to not overdo it with them. 

For a start read the Golden Principles of High-Quality Instruc-
tional Design to find out more.1  

●● Prepare yourself for engaging interactive content: 

○○ Identify your target audience and their needs

1	 This is a commercial website selling a tool for creating e-learning courses. They have, however, also a good collection of brief 
instructions and tips. - Website checked last in April 2019.

2	 That’s if you use a newer version of InDesign. If you happen to have an older version (such as CS3), you do not have these 
workspaces. But the palettes you need are available there as well: Windows  Interactive  Bookmarks/Hyperlinks/States. You 
will not have some of the more fancy things such as page transitions.

○○ Use marketing psychology to trigger their cu-
riosity

○○ Use your creativity to make your content fun

○○ Combine data with visual content

○○ Invite your learners to participate

○○ Last and most importantly: personalize your 
content.

What do I do?
●● Open your InDesign file and select the Interactive for 

PDF workspace.2

This will display a set of panels on the right side of 
the screen. Panels (or palettes) in Adobe products 
are like menus in other software: collections of tools 
to use. Here you get the following:

(See fig. 4.23)

You can now do various things to make your Pdf 
document interactive. Let’s start with creating hy-
perlinks.
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1) Adding hyperlinks 
As in websites, hyperlinks let the reader quickly jump to 
some place, e.g. a different page, an external website, 
a file stored on the same computer, etc. These are the 
types of hyperlinks InDesign currently offers: 

This is the Hyperlinks palette (here already filled with 
various hyperlinks). Most functions you will need are 
hidden behind the small Menu icon in the top right.

1	 Alternatively, there is the Create New Hyperlink icon on the bottom oft the palette, shaped like a tiny piece of paper. As in all 
palette in Adobe software, this is to create a new item (specific for the type of palette).

a) Hyperlinks to jump to a different page

Let’s start with a very simply one: jumping to a different 
page. 

●● Select any element in your document, for example a 
line of text saying “Got to Page 5”. 

●● Open the New Hyperlink dialogue. – To do this, in the 
Hyperlinks palette click the Menu icon, then select 
New Hyperlink.1  

This is the New Hyperlink dialogue:   

●● Give it the desired settings, here especially: what 
page to go to. The other settings are optional. You 
can play around with it to find out what they do. 

●● Hit OK to save your settings. 

●● The Hyperlink palette will now display your freshly 
created link:

b) Hyperlinks to jump to any piece of text 

Sometimes you want to send the reader not only to a 
different page in your document but to a more specific 
section of text. Here is how you do this. 

Blend-it-well Handbook 

Fig. 4.23 – Collection of 
panels (palettes)  under the 
“Interactive pdf” workspace 
environment.  
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●● First you should set a text anchor. That’s a hidden 
mark in InDesign that you can attach to any piece of 
text. Setting such a text anchor is easy, but the func-
tion to do it is hidden away a bit. Do the following: 
1) Mark a piece of text in your document. 2) In the 
Hyperlinks palette, select from the menu: New Hyper-
link Destination. Under Type, the option Text Anchor 
should be preselected; if not, select it. (Alternatives 
are URL or Page). 4. Click OK. That’s it.

Fig. – New Hyperlink Destination dialogue, for 
setting text anchors.

●● Now you can set a hyperlink pointing to that text 
anchor.

On any page of your document, select any element 
(a text, box shape, whatever) which you want to 
carry the hyperlink. On the Hyperlinks panel, in the 
menu, click New Hyperlink to open the New Hyper-
link dialogue you already know. Under Link to select 
Text Anchor, then under Destination select the text 
anchor you previously created. Click OK. 

(Fig. 4.24 – The New Hyperlink dialogue with settings for 
creating a link to a text anchor. Existing text anchors can be 
selected from the Text Anchor dropdown. Here a text anchor 
“That’s my piece of text” has been selected.)  

1	 If you have programmed website, you know what this is. – The last version we tested was InDesign CC 2018, Version 13.1. 

2	 Thanks for this tip to Keith Gilbert, https://indesignsecrets.com/creating-relative-hyperlinks-in-indesign.php. We checked his method, and found 
it working in Indesign CC 2018 (Version 13.1)

c) Further types of hyperlinks 

Further types of links you can use:  

●● To create a link to a web page (URL), simply select 
URL instead of Text Anchor, and fill in the URL.

●● Link to create an e-mail including the address and 
a pre-defined subject line. – This can be useful if e.g. 
you want your learners send you an email, e.g. for 
submitting homework. This, of course, requires that 
they have some e-mail software installed on their 
computer, for example Thunderbird or MS Outlook. 
In standard office environments, this will be the case 
most probably. But already now (2019) many, espe-
cially younger, people write e-mails only via online 
services (Gmail and so on), and with those this func-
tion might not work. 

●● A hyperlink to a file will open a different file, for ex-
ample another PDF, or a DOCX, or XLSX. 

Standard procedure to create such a link to open a 
file: In the New Hyperlink dialogue box, under Link to 
click on File. If you have a path, type the pathname; 
otherwise click on the Folder button and locate the 
file on your computer system (or computer network, 
see below). Remember to click OK to save your ac-
tions.

For such links to work, the precondition is that this 
file is available on your learner’s computer. This un-
fortunately is a more problematic issue than you 
would think. If all of your students are in one large 
shared (company) computer network, you are okay, 
because they typically can all access the same folder 
on your network. But as you are an adult educator, it 
is more likely your students use their own comput-
ers. So, what you can do is send them the interactive 
PDF together with the accompanying files and ask 
them to store them in one and the same folder. But: 
InDesign‘s file links cannot be set to be relative, they 
are always absolute.1 That means you cannot just 
save the PDF and the other files in some folder and 
expect that everything works fine.  

There is one workaround though: if you do not use 
the ordinary Hyperlink - File method, but instead cre-
ate a Button (see below) and assign to it a File Open 
action, the link to the folder will be relative (although 
it is still displayed as absolute).2    
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For more on hyperlinks, the Adobe online help may be 
a good place to search: https://helpx.adobe.com/indesign/using/
hyperlinks.html

2) Adding bookmarks
A very good service to your readers is adding bookmarks 
to you document. This helps readers navigate through 
your document quickly and precisely. Bookmarks are an 
extremely useful feature in PDF documents, especially 
in cases with larger numbers of pages. Strangely, not 
many people seem to know about them or use them 
actively. 

Below you see how a PDF with bookmarks looks when 
opened in Acrobat Pro or Acrobat Reader, and with the 
Bookmarks pane switched on (left hand side):

(See Fig. 4.25)

For creating bookmarks in InDesign, you use the Book-
marks palette:

(Fig. – The Bookmarks palette provides you with the tools needed 
to create a set of bookmarks for readers to quickly navigate 
through your document. Here it is empty since no bookmark has 
yet been created.) 

Bookmarks can refer to either an entire page, or to a 
specific element on a page. If you want a bookmark to 
refer to a page, simply put the cursor on that page, then 
click the Create new bookmark icon on the palette (high-
lighted in the bottom area of the palette seen above). – 
If you want the bookmark to refer to a specific element 
on the page (a headline, a paragraph, a word), first mark 
that element, then click Create new bookmark. 

As bookmarks can be nested, you should pay atten-
tion to which existing bookmark is highlighted in the 
Bookmarks palette when you click Create new bookmark. 
In case a bookmark is highlighted, the new bookmark 
will be created as a subordinate (child) to it. If nothing 
is selected, the new bookmark will simply be added at 
the end. Eventually you will see a tree-like structure like 
here: 

(See Fig. 4.26)

You can also manually rename, delete, arrange, group 
or nest a list of bookmarks. Nesting is used to show a 
connection between topics.
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Fig. 4.25 – A bookmarked PDF, with the bookmarks displayed in the special  Bookmarks column left hand side in 
Adobe Acrobat. Note that bookmarks can be nested. 
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3) Adding action buttons 
Adding action buttons to a PDF document is an idea 
that obviously came from the world of websites. In web-
sites, buttons are used to offer users the option to select 
a topic, do the next step in a procedure, etc. 

Buttons are not totally different from hyperlinks, but 
they are distinguished through their visual appearance: 
usually like physical buttons on a machine (although in 
recent years with the emergence of “flat design” the old-
styled pseudo-three-dimensional buttons have widely 
disappeared). You can use such buttons also in your in-
teractive PDF. 

To create buttons, open the Buttons and Forms palette. 

(See Fig. 4.27)

In your document, select any element you want, for ex-
ample a shape or a text box. Then, click on the Convert to 
button icon (footer area of the panel). Finally, click the ‘+’ 
sign next to Actions to select the required action. Click 
Event to select how the button is activated and how it 
will act. A whole host of Actions are available:

1	 Unfortunately, the Go to Page function where you can set the page number to go to manually does not work in interactive 
PDFs. (We tested in InDesign CC 2018, Version 13.1) 

(See Fig. 4.28)

We cannot explain all these actions here. Most of them 
are largely self-explanatory. We recommend trying 
some of these options out to get a feeling for what you 
can do with them. 

A very simple thing would be to use a button to jump to 
a different page (Go to First Page, Go to Next Page, Go to 
Previous Page, and so on).1  Or use a button to link to a 
certain website that your learners should visit. Also pay 
attention to the Open File action we mentioned already 
above, because this offers a (secret) way to use relative 
file paths that otherwise are not supported. 

Now, creating buttons yourself is quite a bit of work. You 
have to mind a lot of settings for their behaviour, and 
you have to invest time and energy into graphic design. 
Here is a typical Button and Forms palette with settings 
for buttons with different visual appearance depending 
on where is the mouse pointer.

(See Fig. 4.29)

One thing to help you saving time for creating graphic 
design for your buttons: In the Buttons and Forms pal-

Fig. 4.26 - Bookmarks palette with a number 
of bookmarks created. Two of them have 
bookmarks nested in them.  

Fig. 4.27 – The Buttons and Forms palette, 
here with the Types dropdown opened to 
select various types of elements such as 
buttons, check boxes etc.  

Fig. 4.28 – Quite a number of 
“actions” can be assigned to buttons. 

.
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ette, from the menu, choose Sample Buttons and Forms, 
to get a selection of pre-formatted elements that you 
can use: 

(See Fig. 4.30)

For more on buttons in InDesign: 

●● General introduction to interactive pdfs: 

https://helpx.adobe.com/indesign/using/interactivity-5.html

●● Nice and easy introduction into using buttons:

 https://www.youtube.com/watch?v=SikuzxPwufM

●● First steps into the more complicated stuff: use but-
tons to make things appear and disappear on your 
pages with buttons: 

https://indesignsecrets.com/showing-and-hiding-objects-in-interac-
tive-pdf.php

4) Adding sound and videos clips
Making audio and video material accessible directly in 
your interactive PDF can improve the learners’ experi-
ence considerably. One click in the PDF, and they will 
hear you talking or see you dancing (or whatever au-
dio-visual material you include). 

The downside is that such files – especially videos – of-
ten take a lot of space, and thus your PDF can become so 
large that you cannot reasonably ship it to your learners. 
Or you have first to create sufficiently small video files.

Anyway, here is, in brief, how you add audio-visual me-
dia files do your PDF. It is surprisingly simple:  

●● Click File > Place, select the file and position it in your 
PDF. 

●● A resizable media object appears, linking to the me-
dia file. 

●● See below for how audio and video files appear in 
InDesign.

(See Fig. 4.33)

●● There are various settings you can make, e.g. change 
the audio icon, change the picture for the video, 
determine if these clips play automatically or only 
when the reader clicks them, and so on. All these 
settings are accessible in the Media palette.

(See Fig. 4.31)

●● If you want to change the video or audio file, use the 
Links palette. 

Fig. 4.29 – Buttons and Forms palette, filled in with various settings for a typical 
button. You can set different visual appearance for the button depending on 
what the mouse does, but doing this well needs a lot of attention to graphic-
design.  

Fig. 4.30 – Ready-made buttons and other elements.  
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●● Instead of including the video file into the PDF, you 
can also reference it to a file that sits somewhere on 
a server on the internet. Do this by first creating an 
empty frame in your document, then in the Media 
palette menu, click Video from URL. But note that this 
needs a real file sitting on that URL. A Youtube link 
does not work. A practical scenario is that you store 
your video files on your organisation’s server. This al-
lows you to display larger videos without pumping 
up your PDF file size too much. 

More about video and audio in PDF documents: 

https://helpx.adobe.com/indesign/using/movies-sounds.html

5) Page transition effects 
Page transitions can decorate your content when turn-
ing the page. They are those optical effects you proba-
bly know from presentation tools such as PowerPoint: 
pages move away, dissolve, pop up etc. Such visual ef-
fects don’t contribute much to the didactical value of 
your material, but used in healthy doses they can make 
a document look a bit more “professional”.  InDesign 
provides a number of effects. You can add different tran-
sitions to different pages or one transitions to all. This is 
what is offered currently (2018):

(See Fig. 4.32)

To apply page transition effects: 

●● On the Pages panel and select the spreads (or pages) 
that you want to add transition to. 

●● Then use the Page Transitions palette (if not visible, 
choose Window > Interactive > Page Transitions) and 
choose from the Transition dropdown the one that is 
most suitable. 

Fig. 4.31 – The Media palette offers a 
number of settings for the appearance of 
the element in the PDF document, and for 
its behaviour. 

Fig. 4.32 – The various options 
for page transitions, here from 
InDesign CC 2018. In earlier 
versions the selection may be 
slightly different. This list is in 
the Transition dropdown on 
the Page Transitions palette.  

Fig. 4.33 – That’s how audio (above) and video 
(below) files typically appear in the InDesign file: A 
loudspeaker icon for audio, a picture from the video 
clip, both with tiny symbols for audio and video top 
left. 
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Fig. 4.33 – The Page Transitions palette let’s you select and 
fine-tune a transition effect for one or multiple pages. Mouse 
pointer over the little image shows the animation that will be 
produced.

●● You can customize the effects a bit via the Direction 
and Speed dropdown fields. 

6) Other elements for interactive 
PDFs 
There are many more options for interactivity in PDF 
documents. You can add checklists, checkboxes, fillable 
forms with text or signature fields, or cross-references.

Before you start, take some time to navigate through 
the tool and discover their features. Here are some use-
ful notes: 

●● In InDesign you may see an option to include ani-
mations (palette: Animation), that make elements 
(shapes, text elements, etc.) move and change their 
shape similar to an animated movie. However, this 
does not work for PDFs. To use this, you would need 
to create Flash files (Shockwave Flash, SWF), which 
is a form of video that does not work across all plat-
forms. 

For more on this, see 

https://helpx.adobe.com/indesign/using/animation.html 

●● It is possible to create entire quizzes, or sequences 
of elements that appear on a page step by step. But 
this needs a lot of settings to be done in the Buttons 
and Forms palette. 

●● A good introduction is here:

https://indesignsecrets.com/showing-and-hiding-objects-in-interac-
tive-pdf.php

●● More on check boxes: 

https://www.webucator.com/how-to/how-create-check-box-form-
field-adobe-indesign.cfm

Fig. 4.35 –  The Export to Interactive PDF dialogue offers a number of settings you may want 
pay attention to. Here from InDesign CC 2018 (Windows). 
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●● A short video introduction of good quality about 
working with form elements: 

https://www.youtube.com/watch?v=TtCpu_XUJFo 

7) Exporting your work to PDF
So far you have created various interactive elements, 
but you have not seen them in action. To do so, you 
have to create the actual PDF document. This is called 
“exporting”. You will do this repeatedly during your 
work on this document, because there is no other real-
ly working way to check if the interactive elements do 
exactly what you want. So it is a process of export, test, 
redo, export, test, redo... 

Luckily, exporting is simple. Click File > Export > Adobe 
PDF (Interactive) > Save, and you are done. Mind that 
“interactive PDF” must be selected. Otherwise you get a 
normal PDF document without interactive features. 

(Fig. 4.34 – Setting “Adobe PDF (Interactive)” during export is 
crucial.) 

You may also want to pay attention to the various set-
tings in the export dialogue that will pop up:

(See Fig. 4.35, previous page)

Note that in earlier versions of Adobe InDesign (which 
you may still use), the export procedure was a bit dif-
ferent. There, you had to explicitly tick a set of options 
in the Export dialogue to include interactive behaviour. 
Just check your version of InDesign. 

Teaching Benefits
PDF is a very popular format of documents used across 
the web, especially in professional publishing. Its large 
advantage is that is can be used across platforms with 
documents remaining consistent in design and func-
tionality. For teachers or learning facilitators, being able 
to create PDFs is therefore an important skill. 

Here are some more benefits of interactive PDFs:

●● When using interactive PDFs as teaching aids, your 
learners do not need additional resources (except 
a computer, obviously). Your learners can respond 

and interact, as everything is processed within the 
document. 

●● Creating interactive PDFs is simple in so far as it 
does not require additional skills such as writing 
programme code for websites. (It requires, however, 
some training in using InDesign, ideally supported 
by good self-directed learning skills.)  

●● You can turn your already existing PDFs into interac-
tive material. (The typical way to do this would be: 
adding interactive elements in Adobe Acrobat Pro-
fessional). 

●● Teaching aids delivered as PDF look more profes-
sional than such provided in text processing formats 
(DOCX, ODT).  Your learners will be impressed by the 
range of capabilities included in a PDF. 

●● PDFs are easy to distribute. 

●● Interactive PDFs help your target group become 
more engaged. Learners are given the possibility to 
respond without even using a permanent internet 
connection. 

●● Presentations are no more one-way. 

●● Interactive PDFs can help you create content that 
leads to an action. They allow you better incorpo-
rate actions, such as submitting details, respond to 
mini quizzes or watching a video. This can make you 
more compelling and competitive among other ed-
ucators. 

Common Mistakes to Avoid
●● It is quite common for educators to get excited with 

interactivity. However, too much of it can make the 
content tiring for the audience. 

●● When you have a wide variety of options, it is dif-
ficult to keep consistency throughout the content.

●● Monitor the size of the file that is created when add-
ing interactivity. Especially included videos can lead 
to undesired increase of file size. 

●● Here is another drawback of the entire idea of inter-
active PDFs: The concept works well as long as your 
learners use something like a classical computer (PC, 
MAC). If they try to use your PDFs on their smart-
phones or other mobile devices, it may well happen 
that the PDFs lose their functionality just because 
the PDF reading software on these devices may not 
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be able to deal with it. Reading will work. Interactiv-
ity may be impeded. 

Online or Offline?
Interactive PDFs can be published both online and of-
fline. Readers use them offline.1 

1	 With „Publish Online“, Adobe offers users of InDesign also a free hosting server for interactive PDFs. If you use this, your students 
work with your PDFs online.
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4.4.2	 Creating accessible PDF

“Accessibility” of documents means: the document 
can be “accessed” (read, used) by all people, including 
those with some disabilities, especially with visual im-
pairment up to blindness, but also other problems e.g. 
of the musculoskeletal system. Depending on where 
you work, “accessibility” may be required by law or by 
company policies. Documents, especially those in ed-
ucation, are created to be readable and intelligible. So 
why not create them in a way everybody can use them, 
including people with special needs? 

In everyday practice this means that the document 
should be “readable” not only for the ordinary human 
eye. Rather, it should be possible that “assistive technol-
ogies” can process them. This includes screen magnifi-
ers, special colour settings, and most naturally screen 
readers (robotic voices reading a written document). 

To achieve accessibility in this sense, two things are to 
be done. 

To begin with, the document should be well-structured 
for the human eye. Rules to be followed coincide largely 
with what professional journalists and publishers have 
been doing for centuries. (For example: write an article 
always in a self-sufficient form. Don’t expect the reader 
to have read the headline first.) 

Second, the document should be well-structured for ro-
botic readers. The structure for robotic readers will usu-
ally be included in the page without being visible to the 
human eye. For example, if on a page there are several 
areas of text (columns, boxes, or what ever), the docu-
ment should include information (hidden to the eye, 
but readable for machines) about the order in which to 
read. That’s because a robotic reader cannot do what 
the human brain and eye can do: scan the entirety of 
a page and instantaneously decide along certain her-
meneutic criteria what to read next. The robotic read-
er needs information about the structure of a text that 
is interpretable for it. For example, it needs indicators 
what are the headlines, what is contiguous text, what 
are navigation elements, and what is just a letter head 
or logo that appears on each page but should not be 
read as it occurs each time. 

A document that is technically well-structured can be 
processed by software to assist people with disabilities. 
You may have learners with such special needs. 

In this chapter we will have a look how we can improve 
our PDF documents so that they fulfil accessibility cri-
teria. 

Adobe Acrobat Pro is the industry standard programme 
for editing and processing (rather than authoring) PDF 
documents. It provides various tools to check docu-
ments for accessibility, and to fix problems. We will use 
Adobe Acrobat Pro here, but of course, the same thing 
can be done with other PDF editing tools as well. 

Main PDF accessibility features that can be provided via 
Acrobat are features to make documents readable for 
screen readers (robotic readers) and screen magnifiers – 
programmes to selectively enlarge parts of a screen so 
that people with weak sight can read them. It includes 
also document colours to be swapped with high con-
trast colours. Individual steps are

For blind people (using screen readers) 

●● set the language of a document so that a screen 
reader knows what to do

●● set the reading order (“tagging”) for text elements 
on each page 

●● set alternate texts for images so that the robotic 
reader would read aloud “Picture of a house in green 
meadows” when a picture of a house in green mead-
ows is on the screen; the robotic reader does not 
recognize the picture; it simply reads a line of text 
that the author of the text assigned to the picture 
for that purpose.

●● re-open documents to the last viewed page. This 
helps blind people to get back to where they were 
with reading when they closed the document.

●● adjust document zoom; generally a good setting 
is “fit page on screen”, that way screen readers and 
screen magnifiers can work optimally. 

For people who can read but need special visibility 
aids 

●● highlighting form fields 

●● disable text smoothing, which increases contrast

●● display the document in other colours for better 
contrast  

There are various standards for accessibility of internet 
documents, for example the Web Content Accessibility 
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Guidelines (WCAG) and the PDF Universal Access (ISO 
14289). If you are generally interested in the topic, a 
source for quick oversight information is http://www.
section508.gov by the government of the United States. 
(There is no special prevalence here to standards set by 
that country; it just happens that they have a good web-
site on the topic in English.)  

What do I need?
●● Computer or laptop 

●● Adobe Acrobat Pro. – Note that this is not the Adobe 
Reader. Adobe Acrobat Pro is a full-sized PDF manip-
ulating tool, wide-spread in professional publishing, 
both print and screen. It is not cheap.  

●● A word processor (such as Microsoft Word or Ope-
nOffice Writer) that allows you to output a docu-
ment as PDF. – If you have Adobe Acrobat Pro in-
stalled, the respective plug-ins should be available 
in your MS Office applications automatically.

How do I prepare?
Here are some rules for “accessible” PDFs. They are basic 
things that are good to know in advance before diving 
further into the topic. 

●● The visible (and invisible) structure of your original 
document should be clear and easy to follow. Head-
ings, table of contents, links and bookmarks are 
elements to help structure a document. – That’s of 
course a thing everybody writing any documents 
should heed anyway. 

●● Visual content (pictures) should have text alterna-
tives. That’s text to be displayed or to be read aloud 
instead of the picture. – We will show you how to 
create these. 

●● PDFs must be properly tagged. Tags are (invisible) 
mark-ups in the document that provide structure, 
especially for robotic readers. – We will show you 
how to check for these tags and set or improve them.  

●● The language of the texts should be specified explic-
itly so that robotic readers know what to do. – We 
will show you below how to do this.

●● The security settings of the document should be 
operable also for users of assistive technologies. – 
Security settings include rules on what can be print-
ed, and whether a password is needed to read (or 
manipulate) the document. – If you have never used 
these settings in PDFs, don’t worry as you will most 
likely not be affected.

Fig. 4.36 – Two of the high-contrast 
colour settings available in Adobe 
Acrobat via Edit > Preferences > 
General > Accessibility. This can 
be helpful for people with certain 
forms of visual impairment. (If you 
are old enough, you may like the 
sight because it remembers you 
of your first steps with computers, 
in the 1980s and 1990s.)  
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Know how to make Acrobat read 
documents out loud to you 
One feature of Acrobat (Reader and Pro) not many peo-
ple know about is the ability to read out text aloud. You 
can test this very easily by switching the function on: 
View > Read Out Loud > Activate. In any open PDF docu-
ment click on something with your mouse pointer, and 
it should be read aloud (with some artificial voice and 
an ugly mechanic but intelligible pronunciation).  

Note: by default your computer system might provide 
only one single “voice” to use for reading, and that voice 
will most probably speak English only.  Although you in-
deed can make it read also your German, Spanish, Greek 
or Italian texts, and have fun with that for five minutes, 
that’s just a nonsensical game. So, if a “voice” for your 
language is not already available, you have to install ad-
ditional languages. That’s surprisingly simple. We show 
you how, below. 

View your documents in high 
contrast mode 
Also, you can make a quick experiment to get acquaint-
ed with “high contrast screen” views. You simply have to 
tell Acrobat to display documents that way. In Acrobat 
Pro or Reader: Edit > Preferences > General > Accessibil-
ity >  Document Colours Options. Try out the  various 
options. You may end up with screens like those below 
(Two of the high-contrast colour settings available in 
Adobe Acrobat. This can be helpful for people with cer-
tain forms of visual impairment): 

(See Fig. 4.36, previous page)

Letting a screen reader read your 
document aloud
There are various assistive tools available, e.g. high 
contrast screens as seen above. However, the most out-
standing tools are screen readers, that’s robotic voices 
reading aloud what your document says.  There are 
specialty software programmes to do that, both open 
source and commercial.1  Also, modern operating sys-
tems (Windows, Apple OS, Android) usually have some 
form of a screen reader built in. 

1	 For more on that: https://en.wikipedia.org/wiki/Screen_reader. A list of currently available screen readers, with comparison of their 
features is at https://en.wikipedia.org/wiki/List_of_screen_readers.

2	 All links mentioned here were tested in April 2019.

A basic screen reader is built in in Adobe Acrobat Pro 
and Adobe Acrobat Reader. Start it with View > Read Out 
Loud > Activate Read Out Loud.

You will probably find that this reads only English texts. 
Not good for you if you are living in some other coun-
try. The solution is: you have to install additional screen 
reading elements to your operating system. For Win-
dows the current solution (2019) can be found at http://
espeak.sourceforge.net/download.html. You have to follow the 
instructions given there. instructions by Microsoft on 
the same topic are available here: https://support.office.com/
en-us/article/download-voices-for-immersive-reader-read-mode-and-
read-aloud-4c83a8d8-7486-42f7-8e46-2b0fdf753130?ui=en-US&rs=en-
US&ad=US. 2

This let’s you add one or several of the most common 
languages in use . Once installed in your operating sys-
tem, you have to tell Adobe Acrobat (Pro or Reader) to 
use this in the screen reader. You do this via Edit > Prefer-
ence > Reading > Voice (dropdown field where the newly 
installed languages should be visible now.) This will look 
something like: 

When you listen to your document being read aloud, 
you may at the first moment be surprised as it is not a 
beautiful human voice presenting a text in good pro-
nunciation and prosody. What you will hear is most 
probably (and unless you use one of the more expen-
sive stand alone systems) a rather distorted voice like 
of a caricature robot. Screen readers are not made to 
provide you with the pleasure of a refined reading ex-
perience (a thing only a well-trained voice actor can 
do). They are software tools to help especially those 
who cannot use their eyes for reading; aesthetics is not 
considered.
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Where to look for help?
The Adobe Help Centre (in the internet) has useful tips 
on how to get started. There are tutorials and step-by-
step instructions. You can also join the community fo-
rum to ask for specific issues. 

https://helpx.adobe.com/gr_en/support.html 

Especially for accessibility: 

https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibili-
ty.html

If you are interested in the topic of “accessibility” of doc-
uments more generally: the US government has a web-
site on the topic that is very good. It also offers check-
lists for accessibility of various document formats.

 http://www.section508.gov

A basic video tutorial for using Adobe Acrobat for creat-
ing interactive PDFs can be found here:

https://www.youtube.com/watch?v=kWCciN7y64M

What do I do?

1) Checking the accessibility of an 
existing PDF
For checking accessibility of PDFs, Adobe Acrobat 
has an automated way, called Full Check. This feature 
checks a PDF for many of the characteristics that acces-
sible PDFs should have. 

●● Choose Tools > Accessibility. Then the respective 
toolset will be displayed in the toolbar.1

1	 If your Acrobat has a different screen language, you might need to look out for something fitting the idea. In German the tool 
is called Ein-/Ausgabehilfe.   If a tool like that is not visible at all, use View > Tools to select the tool you need. It will henceforth 
be visible in the Tools column right hand side of your Acrobat window.

●● Click on the Full Check button. You get displayed a 
large dialogue with plenty of settings.

●● In the Report Options area, choose options for how 
the results shall be displayed. Basically you can 
choose between a report to be saved somewhere 
on your computer, and “Create comments in docu-
ment”. 

●● In case you want to check only specific pages in the 
document, select a page range.

●● Choose one or more of the Checking Options. You can 
also select from various standards to be used in the 
Checking Options - Name dropdown field. There you 
find e.g. the “Section 508” standard used by US au-
thorities to ensure accessibility of their documents; 
but also other standards. If you choose “Adobe PDF” 
as the standard to check against, the check will use 
the following criteria: 

●● Click Start Checking.

●● The results will be displayed in the Accessibility Checker 
column on the left of your screen. (What you see 
there is actually the report that has also been saved 
to some place on your computer.)

(See Fig. 4.39 on next page)

If you selected Create comments in document your 
document will show highlighting like this:

Fig. 4.38 – The “Adobe PDF” criteria set for checking 
for accessibility issues. This is a relatively concise set 
of criteria. Some of the other standards available have 
considerably more detailed lists of criteria. 
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Fig. 4.39 – Window of Adobe Acrobat Pro (here version X) with a document opened in the middle, the tools column to the right, and the 
report in the column to the left. 

Fig 4.40 – Reading order view  of a page. On this document 
the Add Tags to Document command was used. The tags 
are more or less okay, but could be improved by assigning 
individuals tags to the headlines (as they are currently 
included in tags 3, 5, and 7 together with text. 

Fig. 4.41 – Left column of your Acrobat window. The Order pane 
is open. We right-clicked on one of the elements on Page 1 and 
got a dialogue displayed to adjust the properties of the element. 
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Fig. 4.42 – Document with highlighted sections where 
problems were identified. 

●● According to what the report says, and of course 
according to what accessibility features your docu-
ment is set to have, you can now start fixing the is-
sues. Here are some typical issues, and quick advice 
how to solve them: 

○○ Language not defined: This means that 
screen readers will not be able to read your 
document correctly. It might happen that 
your French text will be read by a voice try-
ing to read it as if it was English (if you want 
to have fun, try). – For correctly setting the 
language use File > Properties > Advanced > 
Language

○○ Image does not have alternate text: Select, 
in the left column, the Order pane. Pictures 
that do not have alternate texts should be 
marked like so: 

○○ You can now right-click on the black note and 
select Edit Alternate Text. 

○○ Document not tagged. This means that the 
various elements on the pages (headers, text 
blocks, pictures, etc.) are not marked explicit-
ly as such. You can use the Add Tags to Docu-
ment command (in the tools column, section 
Accessibility) which will do the tagging au-
tomatically, as good as possible. This works 
usually well in documents that are not too 
complex. If you are not happy with the result, 
you can fix everything manually by using the 
Touch up Reading Order tool (same place). Or 

1	 May be called completely differently in your localized Acrobat version. In German this is called „Barrierefreie PDF-Dokumente 
erstellen“.

you can use the Touch up Reading Order tool 
right away without a detour through the Add 
Tags tool.

●● To check your document structure visually: open the 
Order pane (left column, where the bookmarks are) 
by clicking this icon:

●● You now will get your pages displayed in “reading 
order view” like this:

(Fig. 4.40 on previous page)

You can now use the Touch up Reading Order tool. 
Basically you mark with the mouse a rectangle 
around any element on the page, then press one of 
the buttons available to identify the marked section 
as headline, text, picture, table, or whatever it is. 

Alternatively, you can access all individual elements 
in the left column, Order pane (right-click on the 
items listed there), and assign new values. 

(See Fig. 4.41 on previous page)

2) Use the Make Accessible action 
As an alternative way to do it, Acrobat Pro has the Make 
Accessible action that provides you with step-by-step 
guidance on how to make a PDF accessible. 1

“Actions” in Acrobat are tiny programmes to carry out 
a series of tasks that otherwise would need to be done 
manually one by one. The Make Accessible action leads 
you through a number of checks and shows you what 
needs to be fixed. 

●● First, open the PDF that you want to check and im-
prove.

●● Choose Tools > Action Wizard. Then, the Action Wiz-
ard toolset is displayed in the toolbar. 

(See Fig. 4.45)

●● From the Action list, choose Make Accessible (in Acro-
bat Version X it is Create Accessible PDFs)

●● The panel appearing displays each task that needs 
to be done in order to make the document accessi-
ble, as well as instructions of how to execute.

(See Fig. 4.46)
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In the process you will repeatedly get advice on 
what to do, for example:

●● Follow the advice given. For example when it says 
“Add alternate text to images ad needed”, do so. – 
From notes such as this it becomes clear that Adobe 
expects you to know how to do this. (That’s why we 
showed you the manual way first. Old Chinese prov-
erb: There is no knowledge without knowing.)

Teaching Benefits
You will use accessibility features for your PDF docu-
ments especially when you have learners with special 
needs. Whilst in general adult education it will not hap-
pen so often, it might. Often blind and visually impaired 
people will already be equipped with assistive technol-
ogies (special screen readers etc.), and in this case by 
preparing your documents accordingly you are really 
assisting them and making their life easier. 

Admittedly, doing this for only one learner, with docu-
ments that are one-off for a one-semester course, is per-
haps a bit unrealistic with regard to the work required. 
However, if you have documents that are expected to 
be used over years and are directed to a wider public, 
checking them for accessibility features is definitely a 
good idea.   

Common Mistakes to Avoid
●● Be careful with colours. Good contrast for reading is 

important not only to visually impaired, but actually 
for everybody.

Advice given during the “action”. Obviously it is 
expected that you know how e.g. to add alternate texts 
to images. 

Fig. 4.45 – Adobe Acrobat Action 
Wizard (here from Acrobat X, 
other versions may appear 
slightly different.) 

Fig. 4.46 – The “action” starts with showing you the steps you 
will be going through. 
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●● Do not use images just to decorate your content. All 
material included in your document should convey 
useful information.

●● Pay attention that repeating headers and footers 
should be exempt from the reading order for screen 
readers. 

●●  It is better not to try make your interactive PDFs (see 
previous chapter) “accessible”. Making PDFs accessi-
ble may remove crucial elements of their interactive-
ness such as links or included files. 

Online or Offline?
For making your PDF “accessible”, use the Adobe Acro-
bat Pro, which is by its nature an offline application. The 
resulting PDF file can of course be published both of-
fline and online. 
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4.5 	 Games
Games and gamification are becoming a very impor-
tant tool in the blended educators’ skillset. Games allow 

learners to enjoy their learning, and look at topics from 
a new direction. 

4.5.1 	 Creating and Using Interactive Games

The internet allows you to both play and create a wide 
range of games that can be very helpful for learners. 
This activity is focussed on the creation of quizzes and 
word games. We introduce you to two of them in detail. 
For more examples, see Chapter 7 where more tools are 
presented briefly.

 What do you need?
●● A mobile phone, desktop, laptop or tablet

●● Internet access

●● Game generator tools – We will introduce you to 
three of them. The idea is simply to give you some 
idea what is available. You can take this as a point 
to start to search for others. New gaming opportuni-
ties in the internet with an educative agenda appear 
constantly.

Where to look for help?
Generally on the topic of games in education:

●● A good collection of short, introductory articles and 
resources on the topic of game-based learning is 
provided by www.edutopia.org (run by George Lu-
cas Educational Foundation). This is predominantly 
school-oriented, but it is not bad for a first glance. 

https://www.edutopia.org/game-based-learning-resources

More tools:

●● On word-grabber.com you can find various word 
generator tools to make words from letters for dif-
ferent word games like Scrabble Word Finder, the 
Words with Friends Cheat and Anagram Solver. The 
site is one of several run by a small company based 
in Bavaria, Germany, that specialises in crowd- based 
information portals. 

●● Free crossword generators, for example:

https://crosswordhobbyist.com (we present this below)

http://www.crauswords.com

http://www.eclipsecrossword.comHow do I prepare?

Reading this book will be helpful but the most useful 
thing for you to do is to actually go and try play the var-
ious games. 

In this chapter we will introduce you to two tools: Ka-
hoot, a platform to create and play quizzes and surveys, 
and Crosswordhobbyist, a tool to create crosswords. 

●● For the Kahoot quiz,  go to https://kahoot.com  and regis-
ter an account filling in your role (educator). You will 
create your username and a password. 

●● For Crosswords, except from registering an account 
at https://crosswordhobbyist.com, you may, in preparation, 
think about a list of words relevant to the topic of 
your classes, plus “clue” for each of them. The clues 
can be used in the crossword, as well as for hints in 
Hangman, and as questions in the quiz activity.

What do I  do?

1) Create Quizzes and Surveys with  
Kahoot 
Kahoot is an internet platform offering user-created 
quizzes and surveys that can be used for spicing up 
events starting from normal classrooms up to very large 
auditoriums. Kahoot quizzes and other online tools are 
used by schools, universities, and in other educational 
environments. 

The platform is run by a company in Oslo, Norway. It 
was started in 2013 by a number of students and aca-
demics of the Norwegian University of Technology of 
Science. In 2019 it announced that it had registered 2 
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billion players with 60 million games created by users.1 
The company name uses an English expression “cahoot” 
meaning to be in company or partnership. 

The main product are user-generated multiple-choice 
quizzes that can be accessed via a web browser, smart-
phone apps, etc. 

The most typical way to use Kahoot-quizzes is, first, 
to create a quiz for a certain lecture you are giving. In 
the classroom you then can display the quiz on your 
whiteboard. Questions will be displayed on that screen. 
Students use the Kahoot! app on their smartphone: af-
ter entering the code number of the current quiz, they 
can use their smartphones as voting devices to answer 
the multiple choice questions displayed on the white 
board. A typical quiz could for example have 10 ques-
tions. Participants get scores for correct answers, with 
the speed of answering also factored in. Between the 
individual questions, the current scores of the partici-
pants are displayed on the white board, which adds a 
spirit of competitiveness. 

This can be fun for students while offering an enter-
taining way of repeating the core things learned in that 
lesson. Obviously this approach will work best with 
learners who are what today is called “digital natives”, i.e. 

1	 Data from their website: https://kahoot.com/company, accessed April 2019. Note: „2 billion players“ is not to be misunderstood 
as „2 billion registered users“. It means  2 billion counts of somebody participating in a quiz etc.

people who operate their mobile phones all day long 
and are familiar with using all sorts of apps. It will not 
work so well with learners who are not familiar with us-
ing smart phones that way. 

No user account is needed for simple participating in 
quizzes. For creating quizzes, however a user account is 
needed. Basic user accounts are free. More advanced ac-
counts are available for 12 and 36 Euros annually (prices 
as in April 2019).

Test our sample quizzes
Enough theory. Just try it! We created a mini quiz about 
the fascinating topic of Blended Learning for you:

https://create.kahoot.it/share/blended-learning/0093de63-d390-
4d88-bd1b-0a992fd2087d

This one is quite similar, created by somebody else: 

https://create.kahoot.it/share/blended-learning/189beb65-d0c2-
40bb-a40d-0ba83a84caa4

This one is about current issues of sustainability on 
planet earth. It was one of the most-used quizzes in 
April 2019: 

Fig. 4.50 – A typical screen of 
a simple quiz. The question 
is displayed on top. The four 
answers have buttons with 
different symbols and colours. 
These buttons are displayed 
also in the smartphone app 
(right). 
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https://create.kahoot.it/details/1ec244d9-87fa-45fa-81b6-c3fe63e-
fafd0

These are quizzes with multiple-choice questions with 
2-4 answers. 

Currently Kahoot allows users to create three types of 
online games:

●● 	Quizzes with multiple-choice questions

●● 	Quizzes where four answers have to be put in cor-
rect order

●● 	Surveys, a classical voting tool: participants can vote 
on up to four options (without there being wrong 
and correct answers). 

Kahoot can be used to review students’ knowledge, for 
formative assessment,  or as a break from traditional 
classroom activities. 

Create a quiz yourself
For creating your own quiz in Kahoot, log in to the plat-
form and choose an activity you want to create: a quiz, 
a jumble, or survey. 

The website will lead you through the process of creat-
ing your quiz. Here are some tips to keep in mind: 

●● Questions have a 95 characters limit. 

●● There can be 2-4 answers, each with a 60 characters 
limit. At least one of them must be marked as “cor-
rect”

●● You can set a time limit to answer the question. The 
default is 20 seconds, but you can set it between 5 
and 120, depending, chiefly, on how thoroughly the 
question and the answers need to be read.  

●● You can embed an image or a YouTube video into 
the question. Thus, for example, you can show some 
object and ask something about it.  

●● Select whether you want to make your game public 
or private. Public games can be used by everybody, 
private ones only by people who know the link. 

Play the game – or let your students 
play

●● When you want to launch a game, select it from 
“MyKahoots”, or via the link identifier, and press the 
Play button. You will get a game PIN (a number con-
sisting of 6 figures). 

●● To participate, learners start the Kahoot app on their 
smart phones or computers, enter the game PIN, 

Fig. 4.51 – Two types of 
crosswords available on 
the Crosswordhobbyist 
website: “Standard” 
and “Newspaper Style”.  
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and also some make-shift username (pseudonym) 
that will be displayed on the central screen. 

(See Fig. 4.50)

2) Create Crosswords with 
Crosswordhobbyist
The Crosswordhobbyist offers assistance for quickly cre-
ating crosswords. 

https://crosswordhobbyist.com

Here you can create two types of crosswords, “Standard” 
and “Newspaper”: 

(See Fig. 4.51)

The “Newspaper” type is extremely complex to create. 
Even experienced crossword creators need 3-4 hours to 
create one such (with 15 x 15 squares), and beginners 
may need 6-8. All the placement of words must be done 
manually, or better: by the human brain. Clearly not an 
option for the average adult educator. Not due to lack of 
brain, of course, but due to lack of time.

Much easier is the “Standard” type. Here, the task is sim-
ply: collect a number of words (ten perhaps) that be-
long to your teaching topic. On pressing a button, the 
software behind the website will arrange them in the 
best way possible, i.e. with as many cross sections as 
possible. 

For each word you also enter a “clue”, that’s the descrip-
tion of the word to find, for example, the famous “male 

sheep” when “mutton” is the solution. Or, of course, 
something more in the form of a riddle: “What we do 
when we are not passive”, as a clue for “activity”. 

Here are some tips for using the Standard crosswords 
mechanism of the Crosswordhobbyist website: 

●● Enter all your words in the ‘Auto-Arrange’ section at 
left.

●● You can arrange your words manually, automatical-
ly, or any combination of the two.

●● You can add all your words at once or a few at a time, 
as you think of them. If you are adding words a few 
at a time, try to start with at least 6 words to increase 
the likelihood that they all intersect.

●● You can also add words directly to the grid, if that’s 
your style. Type across or down, and use the space-
bar to switch directions.

●● When you are ready, click the Make Printable button 
to save your puzzle. That’s the moment when you 
need to pay. Subscription plans cost 4,25 - 6,80 USD 
per month, payable via credit card (Paypal was not 
accepted when we tested in April 2019). Conven-
iently you can also pay for individual puzzles (6 dol-
lars).

●● Your puzzles are saved to your account. They are 
accessible from any computer with connection to 
the internet. They can be solved online, or you can 
download them as PDF. 

(See Fig. 4.57)

Fig. 4.57 – For testing the tool we quickly created a „Blended Learning“ crosswords. That’s how it 
looks on the computer screen at the time of creating. 
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Teaching Benefits
●● Using games, an educator can organise teamwork 

and competition which is motivating for some types 
of learners.

●● Games bring interaction to the classroom. Some 
types of learners enjoy the competitive nature of 
the game and comment that it helps them retain 
concepts.

●● Some games are good for making people cooperate 
in groups.

●● Word games can be used to introduce key words/
terms of a topic; quizzes help to check learners’ per-
formance, and to consolidate the understanding of 
key concepts. 

●● Some games can be used in the online part of a 
Blended Learning environment.

Common Mistakes to Avoid

In Kahoot:
●● Remember that there is a character limit of 95 for 

questions and 60 for answers.

●● Be sure to extend question time limit in a proper way 
as images don’t show before answer options do. 

●● There is no limit for the number of questions in 
quizzes and surveys, but it is recommended to keep 
them between 10-20 questions.

●● If you’re a Kahoot admin or educator of a team, you 
can edit and host other educators’ quizzes or sur-
veys, but at a time only one person can edit a Ka-
hoot.

●● Be sure your audience (your students) are familiar 
with using smartphones and apps. If there are peo-
ple without smartphones in your audience, they 
cannot participate and might feel excluded.

In Crosswords:
●● Sometimes it’s not possible to connect all the words 

from your list into an intersecting group because the 
combination of letters doesn’t line up. To solve this 
you can try adding word, or you can set the number 

of groups you are willing to accept at more than 1. 
Bigger numbers make larger puzzles.

●● In Newspaper style crosswords (which however are 
time-consuming to build), if you use grey (instead of 
black) squares to fill the gaps, you will need less ink 
for printing

Online or Offline?
Online games are, obviously, played online. 

●● Kahoot can be played online (with users sitting at 
their devices at home or elsewhere), but this still 
requires a synchronicity (everybody participating at 
the same time). Unless a person fills in a quiz just for 
herself, without competing others. The more typical 
case is however to use Kahoot quizzes and surveys 
in a classroom or an even larger auditorium.

●● Crosswords can be played online one by one. Or 
they can be used in classroom setups, for example 
to be solved in groups. In this case you will have to 
print your crosswords out.  
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Fig. 5.58 – This is how it looks when output to PDF, ready for use.

Fig. 5.58 – The crosswords created on previous pages how it looks when output to PDF, ready for use. 
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Across Down
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What we do when we are not passive.

He who is most ac�ve. Or should be.

We are not fixed to a certain place. We enjoy...

Working in this form - joy for the one, horror for
the other

2

3

4

8

What students should do together

Speaking to the eye, and listening to the nose.

The facilitator, not anymore.

Everybody at his own...

Words used:

Activitiy - Cooperation - Group - Learner - Multilocality - Multimodality -  Pace - Teacher
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4.5.2 	 Using Digital Badges

Digital badges are a form of recognition of educational 
achievements. They are a bit like the textile badges that 
for example youth scouts organisations hand out to 
girls and boys when they have proven to be able to do 
certain things: light a fire, erect a tent, and so on. Digital 
badges are similar, just in the internet. In this section, 
we present the topic in more detail. There will also be 
two or three practical things for you to do in order to 
get a feeling for what digital badges are. Don’t, howev-
er, expect a full introduction into issuing digital badges 
to your learners. This would require an entire book. 

What do I need?
●● Internet access

●● Typically (but not necessarily) an LMS (Learning 
Management System) for e-learning.

●● Learners who are susceptible to symbolic recogni-
tion of achievements. Typically younger learners are 
more interested than older ones. But adults who love 
collecting will enjoy the digital badges experience.

●● If you take it very seriously, you have to make sure 
that the badges you issue are aligned with the ed-
ucational standards of your country. (See below the 
example how Technical University Dublin uses digi-
tal badges.)

Where to look for help?
●● A good, comprehensive introduction into digital 

badges is on the OpenBadges website.

https://openbadges.org

●● History and background are explained, along with 
technical details, on the elearningindustry.com 
website in form of a 15 pages e-book (for free, but 
you have to leave them your e-mail address). De-
spite its brevity, it is of high quality as it manages to 
see things from a certain distance not usual for this 
industry: 

https://elearningindustry.com/guide-to-digital-badges-how-used

●● Also have a look at the Wikipedia pages for “Digital 
Badges” and “Open Badges”

How do I prepare?
Read this section of the book

What do I do?
One topic you will come across at some point as a teach-
er or educator facilitating Blended Learning is digital 
badges. 

Digital badges are a form of recognizing a learner’s ef-
forts and achievements. To understand the concept, 
think about the badges – physical signs of metal and 
textile – stuck to the breast of high ranking or well-per-
forming military persons, most prominently in the So-
viet Union. Or if you are familiar with the traditions of 
some youth scouts organisations: some of them hand 
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Fig. 4.60 – A veteran participant of the “Great Patriotic War” of 
the Soviet Union with many (non-digital) badges.  
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out textile badges that boys and girls can sew onto their 
shirts for achievements like lighting a fire or erecting a 
tent. 

This concept has, beginning with about 2010, been 
introduced into online learning. It started from online 
games, where a user – identified through his or her user 
account – got awarded certain “badges” usually in form 
of images shaped like medals. 

From there, the concept was transferred into online 
learning environments. Various systems were devel-
oped, both commercial and free, that should allow as-
signing “badges” for achievements to individuals across 
platforms. This means that these badges are not fixed to 
a certain environment, for example the Learning Man-
agement System (LMS - think of Moodle, Canvas, etc.) of 
a certain adult education organisation. Rather they are 
fixed to the individual user (i.e. his/her e-mail account), 
and different online learning environments (or educa-
tion providers) are able to process these badges: they 
can create such badges fitting their courses, and assign 
them to their learners. 

1	  Badgr is an open source project started in 2014 to serve as a reference implementation for Open Badges.

If you are working in an adult education organisation 
that provides online teaching (or Blended Learning) it 
is possible – but not obligatory – that your organisation 
uses such badges already. For example, Moodle has 
badges built in since 2012. Other such platforms such as 
Canvas also have them. It is, however, well possible that 
your organisation simply does not use them although it 
uses an LMS. (See below the section about problematic 
aspects of digital badges.)

(See Fig. 4.61)

You can also use the services of a number of companies 
and organisations who provide badges implementation 
either for free (in smaller quantities) or for paid subscrip-
tion. Such organisations include Badgr (www.badgr.com)1, 
Accredible (www.accredible.com) and RedCritter (www.
redcritter.com). These offer various services sometimes 
including an online application that helps do create 
nice looking images for the badges. 

(See Fig. 4.62)

“Open Badges” is the name of a group of specifications 
and open technical standards originally developed by 
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Fig. 4.62 – If you find one of these logos on a 
website of an educational organisation, you 
know that they issue digital badges based on 
the Open Badges standards.

Fig. 4.61 – Using the services of the Accredible company 
(www.accredible.com) we quickly created this badge for 
potential use by the Blended Learning project. The idea 
is to assign it to people who in some way prove that they 
have read the book. But so far we only created the visual 
badge; we have not yet done all the other steps necessary. 
There is also a special technology (called “baking”) to 
include certain invisible data into the image.   

4.5.2 	 Using Digital Badges

4



121

the Mozilla Foundation1 since 2011.2 The Open Badges 
standard describes a method for packaging information 
about accomplishments, embedding it into image files 
as a digital badge, and establishing an infrastructure for 
badge validation.

As you see from the above paragraph, we are here al-
ready deeply into technology relevant predominantly 
for IT personnel who has the task to integrate a badge 
system into some organisation’s online learning envi-
ronment. Most probably your are not such a person, 
and we will not dive deeper into these technologi-
cal aspects. However, it is good to have an idea of the 
“ecosystem” (the network of stakeholders) that makes 
a badge system work. There are “issuers” (schools, adult 
education organisations, etc.) “recipients” (the learner), 
“displayers” (various websites and online environments 
where the badge can be shown, and “consumers”, that’s 
in this case people to whom the recipient (learner) will 
eventually show the badge to prove how skilled she is. 
This could for example be an employer.

1	 Mozilla Foundation is a foundation in the USA. It was created to support free software products such as the Firefox Browser 
and the Thunderbird e-mail application. Income is generated chiefly through contracts with Google (and other search engine 
providers) who pay for their search engines being set as default search engine in the Firefox browser. For these contracts, 
Mozilla Foundation runs a 100 per cent subsidiary commercial company, Mozilla Corporation, with revenues of about 60 
million dollars per year (data as of April 2019).

2	 A paper titled An Open Badge System Framework published in 2011 by Peer2Peer University and Mozilla Foundation is 
commonly seen as a cornerstone oft he development. See this article under http://bit.ly/badgepaper4.

(See Fig. 4.63

Back to practice: 

Below you see a badge one of the authors of this book 
received will writing this book and testing various 
things: 

Fig. 4.63 – The Open Badges Ecosystem with the various types of stakeholders involved. (Diagram by Erik Knutson, Concentric Sky, 
licensed CC-BY) 
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This is a badge by the name of “Navigator”. The author 
of this article got it awarded after he fulfilled a number 
of tasks related to using an internet browser: tasks like 
typing an URL into the address field, re-sizing a resizable 
form field, and so on.

You can try this yourself. It will cost you 5-10 minutes:  

●● Go to

 https://backpack.openbadges.org 

●● and create yourself an account. This “Backpack” is 
used to store your badges. You identify yourself via 
your e-mail account.1 

●● Go to 

http://toolness.github.io/hackasaurus-parable/navigator-badge/#  

●● This is a website giving you a quick task to fulfil, on 
completion of which you will get awarded with the 
“Navigator” badge proving that you have demon-
strated to be able to use an internet browser skilful-
ly. – This badge was created to give a simple exam-
ple how such badges work. The badge you get will 
be sent to the “Backpack” mentioned above. 

One important feature of digital badges is that their 
various claims must be verifiable. Therefore, each badge 
has a set of information fixed to it. For the “Navigator” 
badge this looks as follow: 

(See Fig. 4.64)

1	 Note however that this service is planned to be retired, and all accounts are going to be moved to the “partner” project Badgr 
(www.badgr.com). When we checked in Mai 2019, Backpacker worked still fine.

This includes information about the issuer (who award-
ed the badge), the awardee (who received the badge; 
here blurred out by the book editors for privacy), and 
what are the criteria for awarding the badge. To see 
these details, one can follow the links. (In this case, the 
“criteria” are simply the website where one can fulfil the 
tasks.) 

Some or all of this information will be shown wherever 
the badge is displayed, but it is also stored within the 
digital badge’s meta-data (i.e. information hidden in the 
image) so it can be verified any time – even if you only 
have the image.

Problems

A dose of scepticism 
Back to the general context. When you read information 
on digital badges published by organisations (compa-
nies included) who provide them, you will usually find 
an enthusiastic sermon on how useful badges are, espe-
cially how motivating they are for learners. 

But it is important to look also at the other side. First, 
although there are many education providers who use 
digital badges, there are also many who don’t. Some out 
of inertia, some for good reasons. 

Fig. 4.64 – Information given on the issuer of a badge, and other details. These data are stored in the badge 
itself and can be read at any time.
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Criticism of digital badges points out that digital badg-
es come with significant problems or question marks. 

●● Given the long history of physical badges in military 
context, some critics say that the proximity to mili-
tary culture is unbecoming for the humanistic idea 
of education. Education should be a means of au-
tonomy and emancipation of the human being, not 
of discipline and subordination. 

●● 	Badges have been criticized for rewarding tasks that 
are not inherently interesting to badge recipients. 
The argument is that badges are created to promote 
behaviour that aligns with the goals of the badge is-
suer, and not necessarily the badge recipient.

●● 	Some critics have observed that badges are a type of 
extrinsic motivator that could compete with an indi-
vidual’s intrinsic motivation for accomplishment and 
mastery. 

●● 	A permanent problem of badges is their validity: can 
they be viewed as “trusted credentials”? For exam-
ple, in fact the badge earner’s performance is often 
not directly observed, so there could be some diffi-
culty in making sure that the badge is awarded to 
the person who completed the assignment or met 
the specific criteria. Is an e-mail address sufficient to 
prove the identity of a badge earner? 

●● 	Some sceptics see the “gamification” of education 
critically. They feel that students would be driven to 
be concerned with earning the most badges rather 
than focusing on the material presented. 

●● 	There is also the danger of a slew of badges that do 
not mean anything at all, like earning a badge be-
cause your name starts with the letter A. Issuers may 
feel compelled to issue such badges just in order 
to keep learners (who might be paying customers) 
in good mood. The creation of these meaningless 
badges reinforces the issue of validity because now 
the badge earner needs to decipher which badges 
are valuable, and various institutions need to do the 
same.

Benefits

A positive perspective
After so much criticism, should we at all consider the 
use of digital badges in (non-military) adult education? 
There is at least one aspect that can be used for a strong 
argument in favour of digital badges in adult education: 

For many years now the countries in the European Un-
ion have been trying to develop their education systems 
further in order to get away from acknowledgement of 
time spent in the education system (“she has passed 
a 5 years higher education course in xyz”) to acknowl-
edgement of concrete skills and competencies (“she has 
proven to be able to write a book that complies with sci-
entific standards”), ideally independent of time spent in 
the system. This long-term goal, labelled “competence 
orientation”, has proven to be difficult to achieve, espe-
cially as the idea is to create a uniform system of rec-
ognition of skills and competencies across all sectors of 
education (school, vocational, higher, non-formal, etc.) 
and to include also skills and competencies that have 
been achieved by the individual completely on herself, 
without the involvement of an educational institution. 
This overarching (dreamed of ) system is called the Euro-
pean Qualification Framework (EQF), which breaks down 
into country sub-systems called National Qualification 
Frameworks (NQF). 

One attempt to realize such a method of recognition of 
skills and competencies of the individual is the so-called 
Europass initiative to provider individuals with stand-
ardized documentation of their skills and competencies 
including CV, documentation of experience abroad, and 
various credentials about educational achievements 
and competencies, made comparable between coun-
tries.  However, getting this system broadly accepted 
seems to be a very long process. 

All the more it strikes the eye that digital badges actu-
ally deliver many of the things the EU countries try to 
achieve with these policies: they provide recognition of 
skills and competencies on the individual level; they are 
international; and they are independent of sectors of 
the education system.

Therefore, perhaps can digital badges become a step 
towards a common competence-oriented education 
system in European countries? 
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And in Reality? 

What are we really doing?
So far for theory. Looking at practice can bring further 
insights. While writing this book, we quickly asked 
around at organisations involved in the project (and 
also one external) to see what role digital badges actu-
ally are playing in their everyday educational work. Here 
is what we found:  

TU Dublin is clearly a champion in using digital badges: 
they use digital badges in a number of educational pro-
grammes implemented through both the Moodle and 
Blackboard systems. The programmes range from IT 
to Education/Pedagogy; and to more learner-focussed 
content such as Induction and Volunteerism. Badges 
are both pre-existing badges, and badges created for 
specific modules. Some badges have accreditation (or 
recognition) from discipline-specific professional bod-
ies. Often the learners are awarded a number of badges 
per module, so for example if a learner has to do one 
activity (or milestone) for each week in a module, the 
learner may be awarded a badge per completed task. 
Students extol the virtues of digital badges, specifically 
mentioning that they aid in the pacing of a module, as 
well as giving a clear roadmap to the content associat-
ed.”

VHS Hannover has a proprietary Moodle platform 
used  basically for computer courses (computer liter-
acy, IT) and as an add-on for some language courses. 
As digital badges are a built-in feature of Moodle, they 

are available, however, they are not used systematically 
but perhaps by individual teachers who on a course-
by-course basis decide to use them. Overall, the use of 
badges is currently a marginal thing at VHS Hannover. 
This has clearly also to do with the type of learners VHS 
Hannover has: they are interested in the actual topic 
they learn, and in the social experience with co-learners. 
Most of them would see digital badges as something 
from primary school where teachers gratified them with 
stars written into their notebooks for well-done home-
work. 

Ljudska universa Žalec does not use badges so far. 

Västerås folkhögskola is a Swedish adult education or-
ganisation providing many online and distance courses 
in a professional way, partly to enable people living in 
remote places to partake in their courses. Asked if they 
used digital badges, they answered us, displaying their 
typical humanistic Scandinavian understanding of edu-
cation: “Sorry, we do not make use of badges or other out-
side rewards, just the participants’ inner pride and deep 
personal satisfaction.”

Online or Offline?
●● Using digital badges somehow seems to be requir-

ing an internet connection. Badges themselves (the 
images including the data hidden in them) can be 
stored on non-connected computers. 

●● Sewing textile badges for your classes can be a fun 
project, too.  
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4.6 	 Searching 
Searching in the internet is sometimes an under-esti-
mated activity. Many of us are so used to it in everyday 
life that we take it for granted and do not think about it 
very much. However, there are things to consider when 
internet search is used in a context of education and 
learning. 

In this chapter we will focus on two different topics re-
garding internet search:

One is related to you as a teacher who wants to prepare 
e-learning materials for Blended Learning contexts. We 
introduce you to techniques of searching especially for 
multimedia content that you may not be fully aware of 
even if Google is your daily companion for quickly look-
ing up something. Of course there would be much more 
to say. Take the section on multimedia search simply as 
an appetizer.  

The second part of this chapter focusses on using the in-
ternet as a source of information for students, and thus 
as a method of learning through self-directed work. 
This is largely based on constructivist and connectiv-
ist  concepts of learning: the claim that learning works 
best when a topic is not presented to students as a 
ready-made unit; rather students should explore things 
themselves step by step, in their own way and pace, and 
thus construct their own understanding related to ex-
perience they already have as the individuals they are; 
and that learning should make use of networks where 
people mutually recognize and apply their different 
pre-existing knowledge and competences. One form of 
leading students into such self-directed learning activ-
ities are Web Quests. You will learn about them in the 
second part of this chapter.

4.6.1 	 Searching for Multimedia Content

Multimedia is a frequently used word today. But what 
does it actually mean? Here is a short definition: “Mul-
timedia is content that combines different forms such 
as text, audio, images, animations, video, and interactiv-
ity.” In contrast, traditional media concentrates on one 
form of content delivery. (Hence one could call them 
“monomedia”). For example, newspaper publishers 
once concentrated on information printed with ink on 
paper. Music cassette producers sold magnetized plas-
tic ribbons that could be used to reproduce sound. With 
the advent of computers in everyday life, the separate 
media started to merge, giving raise to “multimedia”: a 
form of delivery that uses virtually all possible channels 
simultaneously. One day, sensory and olfactory chan-
nels will be used, too.  

So, in a strict sense, multimedia is a word for media that 
use multiple channels (or “modes”, as communication 
and education academics call it) to address multiple hu-
man senses: show a text, include a movie, let the user do 
something (interactivity), and so on. That’s the narrower 
meaning of the word. In a broader sense, the term “mul-
timedia” is also used as a short word for “pictures, vid-
eos, audio etc.” without these modes being necessarily 
combined. “I use multimedia in my lessons” often means 
simply “I hand out written material, I draw pictures, and 
I show movies.” 

In this section we will look at two different approaches 
to retrieving specific multimedia content from the inter-
net. First we will look at searching for images using the 
TinEye Multicolr (https://labs.tineye.com/multicolr/) search tool. 
Second we will look at a search tool for multimedia con-
tent (https://search.creativecommons.org/) licended for free use.

What do I need?
●● A computer

●● Internet access

●● The TinEye Multicolr site:

 https://labs.tineye.com/multicolr

●● Creative Commons search: 

https://search.creativecommons.org

Where to look for help?
Helpful websites

●● The TinEye help page:
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 https://tineye.com/how

●● The TinEye API: 

https://services.tineye.com/TinEyeAPI

Useful books

●● Simone Aliprandi (2011): Creative Commons: A User 
Guide. Ledizioni Publishers.

●● Sarah Pearson, Paul Stacey, and Sarah Hinchliff 
(2017): Made With Creative Commons. Ctrl-Alt-Delete 
Books.

How do I prepare?
●● The first thing to do is decide what type of content 

you are looking for. Be as specific as possible. If you 
are looking for an image, sketch on paper what you 
would like to find; if audio or a movie, note down a 
sentence or two about what you want it to contain. 
(These are simple techniques to become aware of 
your ideas and intentions. Some people do not need 
this, for others it is helpful.) 

●● Next decide what impact you want the multimedia 
to have on your learners, and well as what mood you 
wish to set by using it.

●● Determine how much storage space you have avail-
able to store this content.

1	 In June 2019 it was not possible to find this service via the www.tineye.com start page, but the direct link as stated above was 
working.

What do I do?

1) Image Search by Colour 
●● Go to the TinEye Multicolr page. 

https://labs.tineye.com/multicolr

This site allows you to search images by colour. The 
site uses the picture database of Flickr (a large pic-
tures and videos sharing website).1

●● Click on one colour on the colour palette:

Each colour you add will appear in the “Slide Divid-
ers” beneath the colour palette:

●● Also images of that colour will appear in the main 
window

●● Click on another colour on the palette and it will ap-
pear in the “Slide Dividers”

 

●● The main window will have images with 50 % green 
and 50 % red content

●● If you wish more green than red, slide the bar in be-
tween the two colours to the right:
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●● The main window will now have images with 70 % 
green and 30 % red content

●● If you wish to remove the green, and just leave red, 
place your mouse pointer over the green block, and 
two small icons will appear:

●● The first icon, the dustbin, will allow you to delete 
that colour.

●● The second icon will let you change the brightness 
or darkness of the colour:

(See Fig. 4.76)

●● You can add up to five colours in each search.

●● Underneath the “Slide dividers” is a text box that you 
can type in a word to further refine your search.

●● The result you get may look like the image below; 
results of a TinyEye Multicolr search where we asked 
for pictures with 50 % yellow and 50 % blue.

(See Fig. 4.77)

2) Search for Creative Commons 
Licensed Content 
When searching for pictures, videos and audio on the 
internet you cannot always use what you find in your 
classes or your Blended Learning materials because au-
thors may not grant you the right to use it (or only when 
you have a contract with them). That’s were Creative 
Commons licensing comes in again. (For details on this 
see Section 3.4.) There is a website that offers search for 
visual and other material with special preference on ma-
terial that can be used under a CC licence.

●● Go to the Creative Commons search page:

https://search.creativecommons.org

●● Using this site, you will be able to search for a range 
of multimedia content.  The clue is:  this search en-
gine looks especially for content that is (likely to be) 
CC licenced, i.e. it is legally available to you to be 
used for developing educational content. (For de-
tails on CC see Section 3.4.)  Content that isn’t legally 
licensed won’t appear. Or at least that’s the idea. The 
Creative Commons organisation that runs the web-
site recommends its users to individually check the 
licence status of material retrieved, to be on the safe 
side.

●● The site does not present you the result directly. 
Rather, you will be redirected to one of the site’s 
source sites (see list below), on which a search is ex-

Fig.  4.77 – Result of a picture search by colour, with settings 50 per cent blue 
and 50 per cent yellow.

Fig. 4.76 – TinEye colour selector wheel.
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ecuted with special parameters to possibly restrict 
results to such with Creative Commons licence. Such 
a search string can for example look like this (here 
we searched for European cultural heritage pictures 
of hamsters): Hamster AND RIGHTS:*creative* AND 
NOT RIGHTS:*nd*

●● Search will be based on a range of websites with me-
dia repositories including:1

○○ Europeana.eu – the EU site for cultural her-
itage, including images, audio, documents, 
and video.

○○ Flickr – video and image hosting site.

○○ Google – text search.

○○ Google Images – Google image search.

○○ Jamendo – a music hosting site.

○○ Open Clip Art Library – an image library 
(openclipart.org)

○○ SpinXpress – an image and audio hosting site

○○ Wikimedia Commons – has text, images, au-
dio and video

○○ YouTube – a video hosting site you may have 
heard of

○○ Pixabay – an image and video hosting site

○○ ccMixter – a music hosting site.

○○ SoundCloud – a music hosting site.

To summarize: the Creative Commons Search website 
gives you quick access to various online databases with 
multimedia content, with a good chance to pick mate-
rial you are allowed to use in your lessons and for your 
blended teaching material to to Creative Commons li-
censing. 

Teaching Benefits
For certain learners, there can be great novelty and thus 
motivation in using multimedia content. For others, it 
may be confusing do deal with so much new things 
at once. You are the teacher or learning facilitator. You 
should know what is good for your learners. 

1	 Information as in autumn 2018. In the meantime (May 2019) the website has developed further. The „old style search“ that 
included buttons to select these sources, is available only as a secondary option.

●● When explaining intangible concepts, like magnetic 
fields, animation can help learners to get the idea. 

●● Multimedia content can appeal to a wide range of 
learners, including those with a range of language 
abilities

●● Multimedia content can encourage discussion and 
feedback

●● Multimedia can help make learning personalised. 

Common Mistakes to Avoid
When using multimedia content, always ask yourself, 
what is the educational value of each element? It is 
very easy to add a wide range of multimedia content 
to teaching materials, but they must have a purpose to 
help the learners learn, so don’t add content unneces-
sarily.

●● There is no need to clutter all the multimedia con-
tent in one place. You should spread the multimedia 
content over the lessons.

●● Make sure you have the hardware resources (mem-
ory, and processor power) to store and display the 
multimedia content. 

●● Make sure you have the correct viewers and players 
available for the learners to interact with the multi-
media content.

●● Read one of Edward Tufte’s books.

Online or Offline?
●● If you want to distribute  multimedia content offline, 

you can copy the content onto a USB memory stick 
and hand it out in class.

●● If you and your learners have access to the internet, 
you have a lot of options to distribute your mul-
timedia content to your learners. You can share it 
with them using cloud storage (e.g. Dropbox, Goog-
le Drive, AWS, etc.), you can email it to them, if you 
have a website you can upload it there, or to a Virtual 
Learning Environment (e.g. Moodle, Blackboard, and 
Edmodo).
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4.6.2 	 Developing a Webquest

If you have been in contact with pedagogical studies 
in the past decade, you’ll be familiar with notions such 
as critical thinking, co-operative learning, digitalisation 
and authentic assessment. You have heard of the learn-
ing theories of cognitivism, constructivism, and recently 
also connectivism. If you are like many educators, you 
feel positive about new ideas for helping learners learn; 
but then you ask yourself how you could implement 
these abstract ideas in your everyday practice? Being 
motivation-rich but time-poor, how can we add these 
concepts in our adult education activities? Here is a sug-
gestion: try webquests.

Webquest – that’s a name for a method to facilitate 
learning processes in groups by bringing together the 
most effective instructional practices into one integrat-
ed learner activity based on self-directed exploration 
of a topic. Wow. That sounds complicated. So what is it, 
actually? 

In a more everyday type of language you could say: a 
webquest is research done in groups of learners using 
all possible sources of information, most prominently 
the internet (simply for practical reasons: the internet 
provides vast amounts of information instantly).  Some 
call webquests a learning facilitation strategy. As the 
word “web” suggests, the internet is  part of it; but so is 
also cooperation and exchange with others. These two 
things together make webquest a natural candidate for 
Blended Learning activities.

Webquests as a form of learning activity were devel-
oped starting from 1995 by a number of educators in-
cluding Bernie Dodge and Tom March around San Die-
go State University, California. Since then thousands of 
teachers have embraced webquests as a way to make 
use of the internet while engaging their students in 
the kinds of thinking that the 21st century requires. The 
model has spread around the world, so far especially to 
Brazil, Spain, China, Australia and the Netherlands.

In what follows we approach the topic in three ways: 

First, we outline a bit more of theory why webquests are 
a good learning tool aligned to the ideas of constructiv-
ism and connectivism. 

Second, we present a simple form of a webquest (so 
simple that it almost does not deserve the name) for a 
short Blended Learning activity. This can be implement-
ed as part of an ordinary classroom teaching lesson, or 

as Blended Learning homework plus subsequent pres-
entation and discussion in the classroom. 

Third, we relate you to some databases where you can 
find more elaborate webquests so see real-world exam-
ples beyond the superficial insight we can give you in 
this book. These are descriptions of blended learning 
activities that can take up to a week. 

The Theory Behind Webquests
Webquests are good learning tools because they use 
and promote learners‘ intrinsic motivation, learners‘ 
cognitive competences, and learners‘ ability to co-op-
erate with others. 

a) Motivation
Motivation is key to learning. WebQuests use several 
strategies to increase student motivation. 

First, good webquests use a central question (task) that 
honestly needs answering. Students are asked to under-
stand, hypothesize or problem-solve an issue that con-
fronts the real world, not something that only carries 
meaning in a classroom.

Second, when doing webquests, learners use real-world 
resources of information, not dated textbooks. Students 
can directly access individual experts, databases, cur-
rent reporting, and even fringe groups to gather their 
insights. Seen under this angle, doing a webquest with 
learners is like making them act as investigative journal-
ists. 

Third, when students take on roles within a cooperative 
group, they must develop expertise on a particular as-
pect or perspective of the topic. Their teammates count 
on them to bring back real expertise, and this boost mo-
tivation. 

b) Thinking skills 
Built into the webquest process are strategies of cogni-
tive psychology and constructivism. The question posed 
to students can not be answered simply by collecting 
information and spitting it back. A good webquest forc-
es students to transform information into something 
else: a comparison, a hypothesis, a solution, etc.
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However, learners should not be left completely alone 
with the task. You, the facilitator, should help them by 
breaking the task into meaningful chunks. You can ad-
vise them to undertake specific sub-tasks, to help them 
step through the kind of thinking processes that more 
experienced people would use. This form of support 
is called scaffolding. The challenge for you as an adult 
educator is to know your learners and their abilities 
very well so that you can provide suitable scaffolding 
to them. 

Constructivism claims that learning is a process in 
which the individual extends her existing knowledge 
by actively dealing with new situations. What students 
need are many examples with lots of information and 
opinions on the topic through which they will sift until 
they have constructed an understanding that connects 
to their individual prior knowledge. Webquests offer 
exactly such as rich playing field related to real-world 
tasks.

c) Co-operative learning
In good webquests, students cooperate in small groups 
to solve tasks with distributed responsibilities. This al-
lows webquests to tackle large, complex and contro-
versial topics. (Think of climate change, abortion, or the 
social responsibility that comes with wealth.) Nobody 
can be an expert in all relevant aspects of such a topic, 
but everybody can concentrate on one aspect, and con-
tribute expertise. This teaches also a lesson about how 
knowledge is organised in society in general. Moreover, 
if you run several webquest groups in the same class, 
students will also see that teams come up with different 
solutions. 

Summary
Putting the fancy word “webquest” aside, if you had 
to describe a webquest to your colleagues in standard 
terms, you could say: 

“I am doing with my students a form of project based 
learning. They get tasks they have to solve, ideally in 
groups. A larger part of the task is related to finding 
and assessing information; we mostly use the internet 
for this, but they can also use other resources, for ex-
ample the municipal library, or interviewing experts 
or whatever. Based on their research, they have to 
produce something, usually a written document like a 

1	 http://questgarden.com

report or an article. The idea is to work self-directedly, 
and in teams, and the task they get should be relevant 
for them, so they do it with intrinsic motivation, not just 
because I say so. So, these are actually research pro-
jects with the purpose of exploring a topic. Depending 
on the topic, this can be done in one hour, or it can last 
several days.” 

Examples 
To give you some examples, here is a list of webquests 
prepared by teachers at colleges and universities in the 
USA in recent years and published on the Questgarden 
website for the benefit of everybody who wants to use 
(or further develop) them.1 We filtered the database for 
webquests made for an adult auditory (as opposed to 
students at school), dealing with the broader subject of 
economics and business. 

Aesthetics and Visual Design in Word Processing

You know good design when you see it. Let’s enhance 
your intuitive ability with a framework of principles on 
message and communication theory, design theory, 
and colour theory.

Macroeconomics

The economy is a complex being. In the blink of an 
eye, a booming economy can be hit with a crippling 
recession. For centuries, economists have been left 
wondering what is in charge of the market and how 
they can modify it. The goal of this webquest is for 
students to create an in-depth economic analysis of 
different aspects of global economies and determine 
what factors are helping and which ones are hurting 
them.

Pizza Project – Entrepreneurship Training

The purpose of this webquest is to teach students 
about some of the challenges that face entrepreneurs 
starting a new business including ways to identify 
a market, reach the market, and keep the market. 
The webquest follows many of the National Business 
Standards. Work is done in teams.

Build Your Budget! – Financial Skills Training 

Building Your Budget! is designed for students to 
learn, understand and practice the basics of building 
a realistic budget, and sticking to it. Students will learn 
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to evaluate all aspects of their spending, and create 
reasonable spending boundaries based off of their 
predicted income. 

Our recommendation is: visit the website, filter the 
webquests for a topic of your interest and read through 
four of five of them (Intro, Tasks, Process, Evaluation...).  
This will considerably improve your understanding of 
the idea of webquests. 

Here are now some more practice-oriented tips:

What do you need?
●● Your learners should have computers and internet 

access.

●● Good webquests are complex and need time. Al-
though it is possible to create very simply webquests 
that can be solved in an hour, the idea is rather to ex-
plore a topic more deeply, so 2-3 days of work for the 
learners would be a good orientation 

Where to look for help?
Internet resources: 

●● The article Why WebQuests by Bernie Dodge and 
Tom March (the fathers of the webquest idea):  

https://www.internet4classrooms.com/why_
webquest.htm

●● Web quest databases to look up good practice ex-
amples: 

https://www.quickbase.com/articles/the-complete-
guide-to-creating-web-quests

http://questgarden.com

●● The Webquest Generator, an online tool to quickly 
draw a plan for a simple webquest:1

http://www.teach-nology.com/web_tools/web_
quest

1	 Teach-nology is a website with online resources for teachers. Its services are free of charge. The service is financed via advertising 
and sponsorship. It is run by a small company in New York, USA. The website provides a broad range of materials and tools (in 
English), for example more than 30 000 ready made lesson plans in various subjects relevant for school teachers. –Just when 
we checked the WebQuest generator in Mai 2019, they had a programming problem on their site, and we are not sure when 
they will fix it.

Books on the topic:  

●● Margaret M. Thombs, Maureen M. Gillis, Alan S. Can-
estrari (2008):  Using WebQuests in the Social Studies 
Classroom: A Culturally Responsive Approach. Corwin 
Publishers.

●● 	Charles Wankel, Patrick Blessinger (2012): Increas-
ing Student Engagement and Retention using Online 
Learning Activities: Wikis, Blogs and WebQuests. Emer-
ald Group Publishing.

How do you prepare?
●● The best thing to do first is developing a better un-

derstanding of what webquests are. This description 
here will definitely not be enough. You will need to 
see at least three or four real-life examples. Therefore 
we strongly recommend you to visit one of the vari-
ous webquest databases. These are websites where 
people publish their webquests for further use by 
others (addresses mentioned above). – With that 
understanding, the following steps  become self-ev-
ident: 

●● Choose a topic for your webquest. For example, if 
your task is to lead a group of young adults through 
a process of learning how to make a business plan, 
then “Create a business plan” can be your topic. De-
pending on circumstances, you would narrow down 
your topic (“Create a business plan for a new pizza 
restaurant in your city”), or leave it open to increase 
complexity.

●● Be aware that webquests can be as short as for one 
hour, or as long as for two weeks. It simply depends 
on what you are planning. 

●● Break your topic down into manageable chunks 
that you can explain to your learners (see below, 
part “Process”). As part of this you will probably also 
identify a series of resources (online, or what ever is 
available) that will help students fulfil the task and 
thus automatically learn about the topic.
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What do I do?
Without this being a necessity or dogma, it has become 
a tradition to use the following structure to setup and 
present a webquest: 

●● Introduction: provides the learners with back-
ground information: what is this webquest about, 
and why are we going to do it; what is the purpose 
general problem to be addressed. 

●● 	Task: a summary description of what students are 
expected to do. – A good webquests offers a task 
that needs, for solving, thorough investigation of 
various topics. Moreover, a good webquest makes 
learners work cooperatively in groups with distrib-
uted roles for the individuals. However, there are 
also many webquests out there made to be solved 
by single learners, without much interaction with 
peers. That’s not the exact idea of a webquest, but, 
well, the world is not a perfect place...   

●● Process: This is the breakdown of task in single 
steps, in detail. Here you provide learners with all 
information they need for getting started, and for 
working through the various phases of the task. This 
can be detailed description of sub-tasks, hints for 
helpful sources of  information, and general require-
ments for the product students are invited to deliver. 
Also you would ideally include advice about distri-
bution of work to different people in the team. (For 
example, in a webquest with the aim of developing 
a business plan for a new restaurant, teams may con-
sist of a boss, an office manager, a marketer and a 
finance guy.) You can offer advice on how to manage 
time, collect data, and provide strategies for working 
in group situations.

●● Resources: Links to websites and videos, or clues to 
tools that will help learners complete the task. (If not 
already included in the “Process” part). Sometimes it 
can be necessary to provide materials such as pre-
pared readers with crucial information on a topic, a 
glossary of core terminology to get acquainted with, 
mathematical tables or other things for download. 

●● Evaluation: Here you lay out your criteria: what is 
needed for the webquest to be considered well-
solved? For example, if part of the solution is provid-
ing a written document (as essay, a business plan, a 
news article, a CV...), probably correct spelling and 
grammar are first (but not sufficient) requirements 

for a good rating. Criteria really depend on the topic. 
– It is common practice to organise criteria in form of 
a table, like “solved excellent if..., solved acceptably 
if... solved badly if...“ (see examples in webquests 
published on http://questgarden.com).  

●● Conclusion: Here you sum up the task. 

You find an example for a webquest described in a grid 
like this on the next pages. But do not take this as man-
datory or as too prototypical. You can of course use a 
completely different system of describing the task to 
your learners for organising their work. 

Teaching Benefits
●● Webquests can be a novelty and thus a source of 

motivation. 

●● They encourage learners to develop independent 
study skills.

●● They encourage a structured use of web resources.

●● They accommodate a wide range of learner needs.

●● They can be done individually or in groups.

Caveat: as a teacher in adult education, you probably 
have already understood that the concept of webquests 
was developed initially mostly in traditional school en-
vironment. Webquests are certainly not appropriate 
for all groups of learners in your adult education cen-
tre because often your participants prefer other forms 
of interaction. However, for certain groups of learners 
and for certain subjects, webquests may anyway be a 
suitable method. 

Common Mistakes to Avoid
●● Try to make sure each of the phases are clearly ex-

plained, and the “Process” phase covers enough in-
formation to complete the task. 

●● Ensure all learners have access to computers and 
sufficient connectivity to complete the WebQuest

●● Try to make sure the students don’t lose focus and 
end up wandering around the internet with no pur-
pose

Blend-it-well Handbook 
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●● The first webquest needs to be easy to complete, 
and a success for all learners, otherwise some will be 
put off.

Online or Offline?
Learners need internet access to do the research part 
of a webquest. – If the webquest is part of a Blended 
Learning arrangement, this is of course anyway  a given.

***

On the next page you find a template you can use to 
quickly create WebQuests for your learners.  

The form is also included in the collection of supple-
mentary documents to this book: 

BL_Sup02_WebQuestTemplate.docx

4. 	 The Blended Educator: Advanced Activities
4.6.2 	 Developing a Webquest
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Webquest
Title Blended Learning - What is it?

Subject Area Pedagogy / Andragogy 

Tutor Franziska Maier-Müller

Academic Year Spring 2019

1. Introduction

“Blended Learning” has become something like a buzz 
word. But not everybody has a clear idea what it actually 
is, or what people who use it mean by it.

2. Task

Do research in the internet to find out what Blended 
Learning is. 

Then,  write a short article of 150-200 words, like for a 
dictionary, to explain it. 

3. Process

Search in the internet for suitable sources. 

Read them, and take notes of things that seem important to 
you.

-- Don’t copy-paste. Your article must be your original 
work. 

-- Write an article (150-200 words) to explain “Blended 
Learning” to a broader, average public.  You have 60 
minutes for research and writing.

-- Print your article  

4. Resources

You can use whatever internet resources you think are 
useful. 

You may start with
-- Wikipedia
-- A general search engine such as Ecosia or Google
-- The website www.blenditwell.eu 

5. Evaluation

When you are finished, we will gather in the classroom,  
(anonymously) compare them (method for this will be 
explained by teacher) and discuss which is best, and why. 

6. Conclusion

Do we have come to a comprehensive and consistent idea of 
“Blended Learning?” - Let’s discuss.

Fig. 4.78 – Example for a very simple WebQuest concept, using the WebQuest planning form available next page.  

4.6.2 	 Developing a Webquest
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WebQuest 

 

 

<Picture  
illustrating 
 the topic > 

 

Title  

Subject Area  

Tutor  

Academic Year  

1. Introduction  
 
 
 
 

2. Task  
 
 
 
 

3. Process  
 
 
 
 

4. Resources  
 
 
 
 

5. Evaluation  
 
 
 
 

6. Conclusion  
 
 
 
 

 

Fig. 4.79 – You can use this form to create a simple WebQuest activity for your learners. (You can do this of course also without 
this form; the form is meant only to remind you of the most crucial issues to be thought about.) This form is availabe also in the 
collection of forms (supplement to this book) at www.blenditwell.eu/handbook/templates/BL_Sup02_WebQuest.docx 
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The mind is not a vessel that needs filling, 
but wood that needs igniting.

 Plutarch – De auditu
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The Blended Learner

One of our jobs as educators is to equip our learners 
for the future. Ensuring that they have the ability to 
use online content in the most useful way possible is 
crucial. Many learners will have familiarity with the on-
line world, but possibly as a casual user rather than in a 
teaching and learning context. They may therefore have 
developed attitudes and strategies that are ineffective 
for Blended Learning in a teaching and learning setting. 

For example, learners who are familiar with sending 
emails to their friends might potentially have  the habit 
of using casual language, or abbreviations (sometimes 
called “SMS language”), which might not be acceptable 
in a teaching and learning context. In addition, learners 
may consider it acceptable to be excessively critical of 
others on social media, and think that attacking some-

one’s character is acceptable, which definitely is not 
acceptable in a teaching and learning context. Finally, 
learners who are using the internet to search for con-
tent may have become used to picking the first article 
related to that topic, irrespective of whether or not that 
article is authoritative, which might not be acceptable 
in a teaching and learning context.

In this chapter we will look at some of the key online 
skills that need to be taught to learners, particularly in 
a teaching and learning context. It might be the case 
that your learners already have some of these skills, and 
if you feel they are sufficiently equipped in a particular 
skill, please feel free to skip that section of this chapter.

	 The Six Key Skills of the Blended Learner

Basics

Learning to use a mouse, point-and-click, 
drag-and-drop, double-click.

Referencing and Citation

Correct referencing and citation of both 
offline and online content.

Conducting Yourself Online

Understanding how to interact and react 
online in a learning context.

Notetaking

How to take effective notes for offline and 
online content.

Assessing Online Content

Questioning the authority and accuracy of 
online content.

Team work

How to work in an offline team, and the 
additional challenges online.

5
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5.1	  Computer Basics 
Sometimes it seems that all learners have very good 
computer skills, but this is not always the case. Lack of 
computer skills can be a significant barrier for learners 
to successfully engage in Blended Learning. You do not 
want your learners sit alone at home and struggle with 
basic operations. 

Giving advice how to teach computer basics to begin-
ners is clearly a task beyond the scope of this book. 
There are other books out there, doubtlessly also in your 
home language. 

Here is a simply a list of things a participant in a Blended 
Learning setup should be able to do: 

●● Switch a computer or mobile computing device

●● Have a basic idea what an operating system is and 
what it does

●● Use a mouse (behaviour of the mouse pointer)

●● Use a touch screen (various universal gestures) 

●● Use a keyboard. – Being able to use all ten fingers 
(“touch typing”) is already the master class here. 

●● Use text processing software (such as OpenOffice 
Writer or MS Word) to produce simple documents

●● Know what an internet browser is and how to use it

●● Have some experience with online communication 
tools (chat tools, messaging tools, e-mail etc. ) 

Useful is also

●● Have some understanding how content in the inter-
net is created: by whom, and why, with what intent. 
Is everything that is said in the internet true? How 
can I assess the reliability of information?

●● Be self-confident enough to explore new software 
tools without the help of a teacher.

Therefore this section will outline an approach to teach-
ing the basic computer skills. If all of your learners al-
ready have these skills, please feel free to skip this sec-
tion.

We think it is best to start with the basics when explain-
ing to the novice learners how to use a computer, so you 
may want to explain the use of: let us start simple:

5.2	 How Learners Should Conduct 
Themselves Online

The learners may or may not have experience online, 
but we want them to think about these blended activ-
ities as very different from their normal online activity, 
the same way that reading a book for study is different 
from reading a book for pleasure. We need them to 
think that each time they are going online for blended 
activities that they are representing your organisation, 
particularly if they are using your organisation’s equip-
ment to go online. The basic rule of online conduct is 
to treat others as you would have them treat you, and 
below we are suggesting a series of ten specific sugges-
tions for good online communication: 

Using email
Another technology that learners will use as part of a 
Blended Learning experience is email. It is such a com-

monly used technology that many learners will have 
used it casually already.  However, again we need to 
remind them that when they are using email for educa-
tional purposes they should communicate in a profes-
sional manner. 

Digital Identity
A digital identity or cyber identity is the online presence 
of an individual, including any social media accounts, 
any pictures, any email accounts, any accounts for on-
line interaction with government bodies and/or oth-
er organisations. Our digital identity is a dynamic and 
changing thing. There are a wide range of places data 
about us is being stored: organisations store data about 
us, our browsers store data about us, our computer and 
mobile devices store data about us. 

Blend-it-well Handbook 
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As mentioned in Chapter 3 digital identity can be divid-
ed into four distinct concepts: 

●● Digital footprint 

●● Digital reputation 

●● Digital shadow 

●● Digital tattoo 

Some general advice about digital identity manage-
ment includes:

●● If you create a social media account and later decide 
that you no longer wish to use it, do not just aban-
don it, make sure you delete it.

1	 Gordon, D., O’Leary, C. (2003): Zen and the Art of Web Site Evaluation: Tools to Assist in the Successful Development of an eLearning 
Portal. CAL 2003, Queens University, Belfast.

●● Learn how to use the privacy settings on all the var-
ious social media.

●● Google yourself regularly to make sure there is noth-
ing coming up that you do not want.

Sometimes learners have an unquestioning faith in 
online services, and are surprised when services like 
Dropbox or Google Drive become temporarily unavail-
able. Therefore we would always remind them that it is 
important to make a backup of all important material. 
There are multiple ways of doing that, from emailing 
themselves that material, to using cloud storage, to 
backing up using USB memory sticks. 

(See also next page, Ten Commandments of Online 
Communication.) 

5.3	 Assessing the Quality of Online Content
Before the creation of the World-Wide Web, the main 
source of information that learners had were libraries. 
The quality of content in libraries is very high, which 
stands in stark contrast to the highly variable quality of 
information that is available online. Learners need to 
develop a new set of skills when engaging with online 
content. These skills are sometimes called “Information 
Age Skills”, and they include things like:

●● Discernment: The ability to know what you are 
looking for, and recognise it when you find it.

●● Searching: The ability to find what you are looking 
for using a range of search techniques.

●● Monitoring: The Web is changing constantly, the 
nature of the information you require changes con-
stantly, so searching for what you need to know is an 
ongoing activity.

●● Just-in-Time Learning: The quick, continuous learn-
ing and unlearning of new skill sets.

It is important that the learners have some appreciation 
of how search engines work and therefore understand 
why they are getting the results that they do when they 
run a search. The web is not centrally developed or cata-
logued. Individuals and organisations all over the world 
are adding content to the web and because there is no 
central catalogue of what has been added (or removed) 
the search engine companies have to run computer 

programs that jump from website to website looking for 
new or changed content. Once the list of websites are 
compiled, the search engine company has to decide an 
ordering of that list (trying to rank the list from highest 
quality to lowest quality websites).  The search engine 
companies have specific rules as to how they determine 
what represents a high-quality website. One of the key 
rules that many search engines use to rank a website is 
that they look at how many other websites link to that 
website. The assumption is that if many websites link to 
that site, it must have good content in it. Unfortunate-
ly, no matter how good a ranking process is, there will 
always be some excellent websites that are not ranked 
as highly as they should.  Therefore the learners should 
be willing to not simply look at the first few results of 
a search, but to look at the first few pages of results. It 
is worth noting that many search engine companies 
accept payments from organisations to rank their web-
sites more highly, as well.

To help learners develop a critical eye on the contents 
of a website we think the two-page check sheet de-
veloped by researchers Damian Gordon and Ciarán 
O’Leary1 (starting on the following page) is extremely 
useful. We recommend you to  ask your learners to com-
plete this check sheet a few times, each time on a differ-
ent website. Then after a while the learners will internal-
ise the questions and become more discerning about 
the quality of the websites they are reading. The check 

5. 	 The Blended Learner

5



142

142

The Ten Commandments of Online Communication

Blend-it-well Handbook 

1. Do not use 
CAPITAL LETTERS in online 

communication. It is the equivalent of  
shouting at someone in the offline world.

2. Do not post anything online that you would be 
embarrassed your family to see.

3. Do not personally attack people online. You can 
strongly disagree with people’s ideas, but never call people 

names or insult them.

4. Do not post copyrighted materials online. You might get in 
trouble, and the online site where you post it, too.

5. Do not criticise people for their spelling or grammar. You do not 
know what their native language is, and you do not know if  they have 
dyslexia or another specific difficulty.

6. Do not use rude or coarse language.

7. Do not post pictures online unless you have permission of  
everyone in the picture to do so.

8. Do not write long, rambling essays; try to be concise and to 
the point.

9. Do not overshare personal information. People can use it 
to harm you and your family.

10.  Do not ignore the Rules of  Conduct and 
Community Standards on given online sites.

5
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sheet has divided the analysis into four categories, as 
presented below:

●● Content:What type of information is on the site and 
is it useful?

●● Format: Is the layout of the site effective and easy-
to-read?

●● Technical: Is the site compatible and does it have 
useful technical features?

●● Authority: Is it clear who created the site and what 
perspective they represent?

5.4 	 Correct Referencing and Citation
Part of the job of a learner is to read teaching and 
learning content, to summarise, and to reflect on that 
content in their assignments. To identify the content 
that the learner has read they normally have to do two 

things. They have to put a label in the body of their text 
(called a citation) and at the end of the assignment, the 
learner lists details about the teaching and learning 
content (called a reference):

This of course is chiefly a concern of learners in academ-
ic of some kinds of vocational training, not that much of  
learners in typical adult education situations. 

In academic writing, there are many very detailed rules 
as for how to cite and refer correctly, the rules being 
different for different branches of academic studies 
and even for different journals and publishing houses. 
Refering them here does not make sense. The teacher, 
who usually will have academic training, will be able to 
explain the rules to learners where necesssary. 

Here are, just as an example, suggestions how to cite in 
an orderly manner: 

Citations
To cite in text:  

Cite the name of the author and the date published or 
last revised: 

(International Narcotics Control 
Board, 2017)

References
To reference a website:

Author/Article title, Year, Publisher, Date of Publication, 
<Retrieved from URL>

International Narcotics Control 
Board 2017, United Nations, accessed 
1 October 2017, <www.incb.org>

To reference a book:

Last, First, Year, Title. City: Publisher.

Smith, Henry, 2017, The Ambassadors. 
Rockville: Serenity.

5. 	 The Blended Learner
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To reference  a research paper: 

Last name, First initial, Year published, Title of Paper or 
Proceedings, Title of Conference or Journal, Location, 
Place of publication: Publisher.

Cloyd, A.M., 2017, “Surveying 
Students: A Look at Citation Habits 
of College Students”, EasyBib Info 
Lit Conference, New York City, 2014. 
New York, NY: EasyBib Publishing.

Plagiarism
Because there is so much free content available to 
learners online, they can become tempted to simply 
copy-and-paste text without referencing the source of 
that text. We have to emphasise that they actually get 
more credit if they locate quality content online and ei-
ther quote it, or restate it in their own words, and cite 

1	 D.I.T. General Assessment Regulations, http://www.dit.ie/services/academicregistrar/student-assessment-regulations/general/

the source. One of the most important skills a learner 
involved in Blended Learning can develop is the ability 
to engage with other people’s ideas by reading about 
those ideas online or hearing about them in videos. It is 
very important that they learn to give credit where it is 
due, in accordance with the scholarly method. Various 
definitions exist as to what plagiarism is, including that 
it is “regarded as either intentionally or unintentionally the 
‘passing off’ of others’ work as one’s own. This includes the 
using of others’ ideas, information presented or accessed 
in either visual or audio formats and asking or paying an-
other to produce work.”1 

Our purpose in reminding learners about plagiarism is 
not to catch them out. It is to teach them the correct 
teaching and learning behaviour and conventions of 
referencing. 

Below is a quiz you can give to the learners to check 
their understanding of plagiarism:

Table 5.1. – Plagiarism Quiz

Scenario Is this OK?

1 Copying and pasting text from online content without acknowledging its source

2 Copying and pasting text from online content with a citation at the end, e.g. 
(Smith, 2006)

3
Half-copying the author’s sentence – either by mixing the author’s phrases with 
your own without using quotation marks or by plugging your synonyms into the 
author’s sentence structure without acknowledging its source

4 Copying and pasting text, and putting it in italics, with quotation marks (“ ”), 
with a citation at the end, e.g. (Smith, 2006)

5 Restating the author’s views in your own words without acknowledging its 
source

6 Restating the author’s views in your own words with a citation at the end, e.g. 
(Smith, 2006)

Answers: 

1) No – This is obviously not OK.  

2) No – If the learners do not put it in quotes, they should 
not just copy-and-paste, they should restate

3) No – Not Okay, and very underhanded

4) Yes – This is Okay, but we do not  want too much of 
this.

5) No –  This is just as bad as the first one

6) Yes –  This is the best one, we want to hear the learn-
er’s own words and opinions, informed by their reading.
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5.5	 Successful Note Taking

1	 Tuckman, B.W. (1965). “Developmental Sequence in Small Groups”, Psychological Bulletin, 63(6), 384-399.

Another key skill that learners need to develop is note-
taking. It is a skill that is rarely taught but a useful skill 
for learners to have. One of the most difficult issues to 
decide about notetaking is how much detail is neces-
sary for good notes; should your learners take down 
every word said, or just the key words, or somewhere 
in between? For us the answer is somewhere in be-
tween. They need to be discerning in what they write 
down. The types of things we recommend they write 
down are:  the ideas that are new to them, the facts that 
might be asked on an exam or would be useful for an 
assignment, and most importantly that they write down 
things (in a classroom setting or a webinar) based on 
the verbalcues of the educator.

Cornell Note Taking
Cornell Note Taking is a method of notetaking when the 
learner fills out the main body of notes during a lesson.. 

If at any point during the lesson (or later when review-
ing the notes), the learner comes up with a question or 
memory aid (a diagram, a mnemonic, an acrostic, an ac-
ronym, or an association) they write it in the left hand 
margin. When revising the content, the learner writes 
a 2-3 line summary of that page on the bottom of the 
page. 

This approach helps the learners to create effective 
notes, encourages them to revisit their notes a few days 
after they have taken them, to complete the summary 
section, and therefore encourages good study habits. 
We recommend that the learners feel free to change the 
Cornell Note Taking system to suit their own preferenc-
es.  A template for Cornell note taking is provided after 
the next page.

5.6	 How to Work Effectively in Teams
Working in teams is seen as a necessary key skill for 
learners to develop, and can be a very effective ap-
proach to learning. Although sometimes people distin-
guish between the notion of a team (formed to achieve 
multiple goals) and a group (formed to achieve a sin-
gle goal), in this document we will use the terms inter-
changeably. In 1965 psychologist Bruce Tuckman1 de-
veloped a model of four phases that all teams must go 
through to become effective:

Forming
This is the first stage of team development. At this point 
the team members are polite to each other and usual-
ly reasonably positive. Some members of the team are 
worried about the task ahead, whereas others as look-
ing forward to it. The team must define their individual 
roles at this stage and clearly define the problem they 
are going to solve, as well as some strategies to solve 
it. Unless team members make a genuine effort to get 
to know each other, they can get stuck in this stage. It 
might be worth getting the learners to search online 

for a Team Charter template (an agreement on how the 
team will work) that suits their needs.

Storming
The next stage sees team members pushing against 
their assigned roles, and pushing against the approach-
es defined in the previous stage. This will cause conflict 
in the team, and might result in the team breaking up 
unless they can get past these issues. It is important to 
recognise at this stage that different team members 
have different styles of working, and they need to be 
tolerant of their diverse approaches. It might be worth 
exploring a model like the Myers-Briggs Type Indicator 
to understand each other’s approaches. The general ad-
vice here is “be soft on people, and hard on the prob-
lem”, as well as making sure to listen to everyone and 
communicate in clear, non-judgmental language.

5. 	 The Blended Learner
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5.5. Successful Note Taking
Another key skill that learners need to develop is notetaking. It is a skill that is rarely 

taught but a useful skill for learners to have. One of the most difficult issues to decide 

about notetaking is how much detail is necessary for good notes; should your learners 

take down every word said, or just the key words, or somewhere in between? For us the 

answer is somewhere in between. They need to be discerning in what they write down. 

The types of things we recommend they write down are:  the ideas that are new to them, 

the facts that might be asked on an exam or would be useful for an assignment, and most 

importantly that they write down things (in a classroom setting or a webinar) based on 

the verbal cues of the educator.

Cornell Note Taking

Cornell Note Taking is a method of notetaking when the learner fills out the main body 

of notes during a lesson.. If at any point during the lesson (or later when reviewing the 

notes), the learner comes up with a question or memory aid (a diagram, a mnemonic, 

an acrostic, an acronym, or an association) they write it in the left hand margin. When 

revising the content, the learner writes a 2-3 line summary of that page on the bottom 

of the page. 

This approach helps the learners to create effective notes, encourages them to revisit 

their notes a few days after they have taken them, to complete the summary section, 

and therefore encourages good study habits. We recommend that the learners feel free 

to change the Cornell Note Taking system to suit their own preferences.  A template for 

Cornell note taking is provided after the next page.

Title:___________________________________________________    Date: ______________________

Questions, 

Diagrams, 

/Cues

Main Notes

Summary:

Cornell Note Taking

Template 5.1: Cornell Note Taking.

Fig. 5.1 – The Cornell note taking system is meant to help learners develop good note taking and study habits.
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Norming
In this stage, people begin to appreciate the importance 
of the diversity that exists amongst team members, and 
are able to see the strengths of all members. At this 
stage, team members are also more strongly commit-
ted to the team goals, and see that the goals can be ac-
complished. Because of this shared appreciation of each 
other’s strengths, the team will develop the ability to ex-
press criticism constructively. As new tasks come up, the 
team members may temporarily revert back to the pre-
vious stage in their behaviour, so it is important to see 
that there is some overlap between these two stages.

Performing
In the final stage, the team is able to work well together 
to successfully achieve their goals. The various roles that 
team members had in the first stage may have changed, 
but by this stage, everyone knows their role and how 
it supports the team. The structures and processes that 
have been developed support this process very well. 
This is the stage that the team will remain at until they 
are disbanded.

***

In an online context, the stages will be the same, but the 
challenges of developing the social dimension are more 
complex. It is important that you require the learners to 
create a profile page where they upload a real picture 
of themselves and they write a few paragraphs about 
themselves, listing interests, hobbies etc. It is also im-
portant that groups are formed early and are encour-
aged to contact each other regularly using both email 
and a range of social media applications. Finally, the 
educator must be available online for weekly meetings 
to ensure that the team members can express their con-
cerns, and ask questions.

5. 	 The Blended Learner
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6. 	The Blended Manager

If you put fences around people,  
you get sheep.

William McKnight, 3M



150

Blend-it-well Handbook 

6



151

The Blended Manager 

This chapter is written for the educational manager who 
has overall responsibility for the entire delivery of edu-
cational content in a department or school. It will help 
you understand some of the challenges and opportuni-
ties that blended learning can offer.

The first section of the chapter deals with some of those 
challenges that you might face, including understand-
ing the costs associated with blended learning, under-
standing some of the technology challenges, and un-
derstanding some of the organizational challenges.

The next section will look at some of the potential or-
ganisational benefits of blended learning, including the 
cost effectiveness, the extended reach and flexibility, 
and the political benefits it offers.

The final section will look at advice for you, the blended 
manager, including looking at sample financial costings, 
contingency planning, compliance issues, and forming 
a team to help the blended process.

Fig. 6.1 – Main topics in this chapter.
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6.1 	 Management Challenges of Blended 
Learning

6.1.1 	 Understanding and Justifying the Costs 

It is important to understand that there are additional 
costs associated with the development of a Blended 
Learning module, particular at the initial stages of de-
velopment. There are all manner of cost considerations 
to take into account, but broadly speaking we will think 
about costs as falling into one of two categories; (1) set-
up costs, and (2) on-going costs.

The set-up costs include both equipment and software 
(but we will note that it is possible to source open source 
software for most requirements). The equipment might 
include cameras, lighting, green screen, and micro-
phones, but it is important to start small, using existing 

equipment like the camera on your phone. There may 
be other costs including personal and training costs, as 
well as the hosting of the online content. 

The on-going costs include issues such as maintenance, 
upgrading, and patch management, which all relate to 
the ongoing upkeep of the software. Another crucial 
consideration is the training costs associated with the 
equipment and software, and how much training will 
be needed.

Finally, there will also be security considerations, back-
up costs, as well as the potential cost of system failure. 
These must also be factored into the overall cost.

6.1.2 	 Understanding the Technology Issues

This issue has some elements in common with the 
previous one, but is broader in scope. Cost is only one 
consideration to be taken into account when purchas-
ing new software or equipment. We must also consider 
what features all the alternative systems might provide. 
Sometimes people are tempted to purchase the system 
with the most features, but most of the features might 
never be used, so it is important to know exactly what 
you need, and identify the system that most suits those 
requirements. 

Another crucial consideration is to determine how easy 
the system will be to use. You want something that will 

have a high adoption rate. A further consideration is 
whether or not the system comes with dedicated sup-
port, and another is around the area of compatibility 
(which applies equally to software and equipment). We 
must consider whether the new system will function 
within the existing technology ecosystem. 

One final consideration is how you will liaise with your 
potential IT department. Granted that your organisa-
tion has such a service it is’s important you liaise with 
them regarding

6.1.3 	 Understanding the Organisational Issues

Some of the organisational challenges that a manager 
needs to be aware of include most significantly staff re-
sistance and resentment. Staff must feel that blending 
learning is going to be good for them, and that it will 
benefit them professionally. If they feel that blended 
learning is in any way a threat to them, it will become 
a potential source of conflict. It is therefore important 
to introduce blended learning in a thoughtful and con-

sidered way. Another consideration is the nature of the 
educator’s contracts of employment- It is important to 
check if there are any restrictions or prohibitions that 
prevent staff receiving full credit for their work in the 
blended context. For example, if the contract states 
that to be paid, the staff must physically stand in front 
of the class. It may also be worth investigating if there 
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any organisational, political or union issues that might 
be worth taking into consideration.

6. 	 The Blended Manager

Table 6.1 – Studio Inventory List (Example)

Item Description

H
ow

 m
an

y

Cost
 (per unit)

Overall 
 cost

Canon XF200 HD 
Camcorder 

1920 x 1080, 1/2.84" CMOS Sensor 20x 
Zoom with Zoom, Focus, Iris Rings 50Mbps 
MPEG-2 & 35Mbps MP4 Recording 4:2:2 
Color Sampling

 1 3,100.00 € 3,100.00 €

Rode Video Mic Pro
Compact Directional On-camera  
Microphone with Rycote Lyre Shockmount

 1 187.00 € 187.00 €

Sennheiser EW 100 G3 Wireless Lapel Mics - UHF Wireless System  1 789.00 € 789.00 €

Fancier Studio Softtbox 
Lights

with 10'x12' Chromakey Green Screen and 
Three Softbox Lights

 3 €40.00 € 120.00 €

Manfrotto MN502AH Camera tripod with Fluid Head  1 170.00 € 170.00 €

Fotodiox 5'x7' 
Collapsible Chromakey 
Green

Portable GreenScreen  1 47.00 € 47.00 €

Prompter Tablet 
Ultralight Teleprompter 
UL-IPADU

Flexible Mobile Prompting Solution
Supports Any Size Camera
Universal Tablet Bracket (7” and Up)
Weighs Only 4.5 lb

 1 325.00 € 325.00 €

SanDisk SDHC Card 
Extreme, SD, 64GB

SDXC and SDHC compatible Memory 
Cards

 1 64.00 € 256.00 €

Interfit Matinee  
LED Lights

LED Lights  3 60.00 € 180.00 €

Total €5,174.00
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6.2 	 Management Benefits of BL

6.2.1 	 Costing Effectiveness

1	 Maloney, S., Nicklen, P., Rivers, G., Foo, J., Ooi, Y.Y., Reeves, S., Walsh, K., Ilic, D. (2015) A Cost-Effectiveness Analysis of Blended Versus 
Face-to-Face Delivery of Evidence-Based Medicine to Medical students. Journal of Medical Internet Research, 17(7).

We have already seen the costs associated with blended 
learning. In this section we will look at the potential cost 
savings and gains that blended learning can produce. 
It has to be acknowledged that there will be an initial 
cost in terms of software and equipment. As we have 
said we can use open source software to mitigate that 
cost, and acknowledge that this cost is a short term one. 
What studies have shown is that within three years1 of 
developing blended learning programmes, they pay for 
themselves, and in the long term, they can generate sig-
nificant revenue. 

It is possible to package up all the blended content into 
a professional training course as well as create a new 
course on how to develop blended content based on 
your experience. Once you have sufficient blended con-
tent there is also the opportunity to write eBooks. Once 
you have a number of effective blended templates for 

your content, you could sell those templates to other 
educational institutes.

Blended learning can also be used to increase the num-
ber of learners taking programmes, which is always 
important to the senior management. The blended as-
pects to our programmes mean that learners who pre-
viously could not take our programmes because they 
cannot commit to a full-time programme can now par-
ticipate in these programmes because they can do the 
blended aspects of the content in their own time. 

There will also be a huge interest in this new approach, 
so there will be publicity about it on social media and in 
the newspapers. This could increase your geographical 
reach as learners will not have to travel to classes every 
night, thus you will be able to attract a completely new 
section of the learner market who do not live in close 
geographical proximity to your organisation. 

6.2.2 	 Extended Reach and Flexibility

The extended reach that blended learning offers can 
be a significant advantage. This includes extended ge-
ographical reach, and extended demographical reach, 
as well as improved retention and improved re-applica-
tion of learners.

Blended learning that is done well will result in increas-
ing the number of learners taking programmes. The 
blended aspects to the programmes mean that learn-
ers who previously could not take our programmes 
because they cannot commit to a full-time programme 
can now participate in these programmes because they 
are either geographically dispersed, or they would be 
unable to attend due to work, personal, or other com-
mitments. 

This approach also means that learners are more likely 
to find time to undertake the programme, and therefore 
retention and programme/course completion is more 
probable. A positive experience with blended learning 

will also mean that students are more likely to apply for 
further programmes of study.

Blended learning can offer a great deal of flexibility to a 
teaching institute in a number of dimensions. That flex-
ibility includes flexibility for the learners, in terms of the 
number of days they need to attend college physically. 
It also means there is flexibility in terms of the schedul-
ing of the programmes, and well as the delivery of the 
programmes. This, in turn, means that there is more flex-
ibility in terms of staff scheduling and staff availability. 
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6.2.3 	 Professional and Political Benefits

It is important to be aware that many organisations 
have a clearly articulated series of strategic aims, often 
incorporated into organisational policy documents. If 
blended learning can be aligned with the organisation-
al policies or its goals and vision, it makes it more likely 
to be grant support at an institutional level. Typically, 
an organisation’s strategic plan will include an aim to 
incorporate more technology-based learning into the 
delivery of content. Therefore when proposing the in-
troduction of blended learning, a knowledge of these 
documents would be beneficial, and would reflect well 
on your department.

In a larger context, there will be government policies 
and statements that highlight the importance of tech-
nology-based learning. This could also help justify the 
need for blended learning. It would be beneficial to 
collect a series of policies and statements, as well as 
looking for any legal rationale, including improving ac-
cessibility.

6. 	 The Blended Manager
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6.3	 Some Advice for Blended Managers

6.3.1 	 Financial Costs

We have already mentioned the costs in the two previ-
ous main sections. In this section the goal is to mention 
that once we have some blended content developed, it 
can be used for other purposes including recruitment 
and advertising. The content can be used in mainstream 
media, as well as on social media. All promotional con-
tent can be branded with a stamp saying something 
like “Now with Blended content”, and this will hopefully 
result in additional revenue. It is worth reflecting that 
there will be an initial cost of creating new promotional 
material and advertising.

There will be costs associated with staff in terms of al-
location of time both for the development and the 
delivery of the blended content. The allocation for the 
development of the content should be given in the pro-

ceeding school year to the educator involved, and the 
allocation should be the equivalent number of hours 
to the amount an educator would be given for a typical 
module. 

There may be additional staffing needs for developing 
the blended content, for example, you might need vide-
oing experts, or video editors, or other production staff, 
on either a part-time or a full-time basis, depending on 
the volume of content being developed.

As mentioned before, the technology costs include 
hosting, software, equipment, and support. It is worth 
exploring free hosting sites, as well as open source op-
tions for the software, and attempting to source sec-
ond-hand equipment, and use existing support if pos-
sible.

6.3.2 	 Blended Teams

A crucial element for the introduction of successful 
blended content will be to create a strong team around 
the process. The most obvious members of the team will 
be the educators who are developing the content, but 

it is also important to encourage other educators who 
can advise and provide guidance on the development 
process to have legitimate peripheral participation in 
this process.

Good Management
“As our business grows, it becomes increasingly necessary to delegate 
responsibility and to encourage men and women to exercise their initiative. 
This requires considerable tolerance. Those men and women, to whom we 
delegate authority and responsibility, if they are good people, are going to 
want to do their jobs in their own way.

Mistakes will be made. But if a person is essentially right, the mistakes he or 
she makes are not as serious in the long run as the mistakes management 
will make if it undertakes to tell those in authority exactly how they must do 
their jobs.

Management that is destructively critical when mistakes are made kills 
initiative. And it is essential that we have many people with initiative if we 
are to continue to grow.”

William McKnight, 3M
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Another crucial dimension to team is the technical sup-
port staff. They must be informed from the beginning 
about the process, and they must be made aware of 
any new software and equipment introduced, as well as 
being given a schedule to indicate when there may be 
an increased demand for online resources. There may 
also be an instructional designer and a video expert in-
volved in the team.

It may also be possible to work with your colleagues 
who are in charge of marketing and PR activitiesto inter-
nally advertise the blended innovation (on the organ-
isational website, at internal meetings), and well as to 
liaise with them to give interviews to local newspapers, 
and potentially national ones about the innovative ap-
proach being taken on your blended programmes. This 

way you could generate both interest and support in 
the blended initiatives. 

Sample letters are provided below.

6. 	 The Blended Manager

Hi,
I just wanted to let you know a 
little bit about a new teaching 
approach we are taking in our 
school, and put together a 
little article for the website 
about it if you think it 
might be useful to put on the 
organisation’s website. I am 
also going to liaise with a few 
local newspapers to see if I can 
generate some interest in this.
Kindest regards,
[Your Name]

Department of [Department]/Name 
of School says the Future is 
Blended
The X Department of Y School 
is introducing a bold, new 
initiative in the delivery of 
their programmes by incorporating 
elements of Blended Learning 
and bringing technology into 
the classroom. Blended Learning 
refers to any educational 
activity that combines 
traditional classroom teaching 
with online teaching activities. 

Fig. 6.2 – Sample Letter to the colleagues who deal with marketing 
and PR activities. 

Dear [name],
I am an educator in [Institute], 
and I wanted to make you aware 
of what I think could be a 
potentially interesting story. 
Our institute has recently been 
delivering some of our courses 
using a mixture of classroom and 
online teaching, and we have 
found that it attracts many 
different types of learners 
than we used to get. One case 
in particular is a learner who 
[sample learner]
Kindest regards, 
[Your Name]

A Second Chance at Learning Using 
21st Century Technology
[Learner name] was 15 years old 
when she left school. A few weeks 
later she got her first job, she 
did not realise then that it 
would take twenty years until she 
would be going back to school. 
She could have never guessed 
that her studies would mean that 
she would be spending as much 
time online as she does in a 
classroom. [Institute name] have 
introduced a number of innovative 
programmes of study that mean 
people in full-time and part-
time employment can get back to 
education in a mix of classroom 
and online teaching.

Fig. 6.1 – Sample Letter to Newspapers
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6.3.3	  Compliance Issues

There are a number of compliance issues that are impor-
tant to take into account when introducing a blended 
initiative. Clearly, there are the organisational compli-
ance issues, including some of the considerations men-
tioned in Section 6.1.3, relating to staffing issues, and 
the strategic organisational considerations discussed in 
Section 6.2.3. There may also be issues about staff that 
are full-time versus those who are part-time in terms of 
issues like hourly pay, and how that applies in a blended 
context. 

There may also be data compliance issues that must be 
taken into account when engaging in Blended activi-
ties as well as potential security compliance issues. It is 
worth consulting experts within or outside your organi-
sation about these issues.

There will almost certainly be some copyright issues 
and considerations that must be taken into account, 
particularly if blended content is being made available 
for recruitment or advertisement.

It is important to explore the blended innovation in the 
context of contingency planning and corporate govern-
ance. Creating a risk register, and ensuring that there is 
a coherent policy on risk management, as well as how 
risk monitoring will be done, and what forms of risk mit-
igation will be undertaken. The key risks to consider are 
related to technological issues that may occur, and the 
challenges of maintaining a consistent online service, 
and what to do if the content cannot be delivered. 

It is also worth remembering that the blended materials 
represent a large cache of content that is available for 
emergencies, e.g. new programmes, staff issues, train-
ing programmes, public presentations.
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6. 	 The Blended Manager
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7. 	Blended Technologies

Technology is just a tool. In terms of getting the kids 
working together and motivating them, the teacher is 
the most important. 

Bill Gates – software industrialist
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Blended Technologies

1	 Booth, C. (2009): Informing innovation: Tracking student interest in emerging library technologies at Ohio University. Association 
of College and Research Libraries.

In Chapter 4 we presented detailed instructions how to 
use particular technology and particular popular soft-
ware supporting the six activities we have been using 
throughout this book: 

●● Presentations

●● Podcasts

●● Videos

●● Documents

●● Games, and

●● Searching 

This chapter now looks at alternative tools you could 
use to do those same tasks. 

Some of them are free, others are not. This is useful in-
formation when discussing the costing of the blended 
activities with your manager. 

We have tried to identify as wide a range of technol-
ogies as possible for you, to show you the variety of 
choices that exist.

We also present some details on other educational tools 
that might be useful for you. In this section we will look 
at website development tools, as well as virtual learning 
environments, and finally we will look at learning object 
standards.

When thinking about these technologies it is useful to 
consider the V&R Model1, the Visitor and Resident Mod-
el, which is a continuum that describes modes of en-
gagement with technology, when on the one extreme 
a learner uses technology to complete a task with no 
online social interaction (Visitor mode), to being online 
to connect to people and leave very visible digital foot-
prints (Resident mode). We need to consider how much 
of each mode we will be using in our Blended Learning.

Videos

1.	 Filmora
2.	 iMovie
3.	 Openshot 
4.	 Final Cut Pro 
5.	 Camtasia

Presentations

1.	 Shapechef
2.	 Office Timeline
3.	 Participoll 
4.	 Aploris 
5.	 Pickit

Games 

1.	 Kahoot
2.	 Educaplay
3.	 Factile 
4.	 Open Digital Badges 
5.	 Open Badge Designer

Podcasts

1.	 Spreacker
2.	 Adobe Audition
3.	 Podbean
4.	 Smart Podcast Player 
5.	 Speakpipe

Searching

1.	 DuckDuckGo
2.	 Ecosia
3.	 Metager 
4.	 Qwant 
5.	 Wolfram Alpha

Documents (PDF)

1.	 InDesign
2.	 PDFelement
3.	 PDFill
4.	 PDFTK Builder

Chapter Guide

Other Technologies 

1. Website tools       2. Virtual Learning Environments      3. Learning Object Standards 
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ShapeChef 

Shapechef is a graphics and charts library for Powerpoint issued by a software 
company from Münster, Germany. It combines design with a number of samples to 
make graphing and charting in Powerpoint easier. The plugin gives you access to a 
set of high-quality graphics, charts and icons. This includes computer network 
icons, flowchart symbols, Gantt charts and illustrative stick figures. Once installed, 
the plugin integrates a library pane into your Powerpoint window, allowing you to 
download premade graphic collections for your work.

More useful than the collection of icons and graphics itself you might find that 
ShapeChef allows you to store icons and graphics from your existing charts for easy 
re-use in other presentation. Think of your organisation’s logo, for example.

-- Windows (Microsoft PowerPoint)

-- Mac

-- Free trial  (30 days)

-- Individual licence 40 US dollars. Friendly surprise: this is one-off, not a monthly 
rent.

-- Team licence 180- 1400 US dollars (prices as in July 2019)

www.shapechef.com

Description

Impression

Platforms

Cost 

More info

7.1 	 Presentations
In this section we will look at some options in terms of what suitable software and hardware tools are available for 
presentations. The software options will vary in terms of cost from free to expensive. 
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Office Timeline 

Office Timeline is an interactive timeline maker and project scheduler for 
professionals who need to build visual project plans, schedules and Gantt charts. 
Office Timeline is equipped with intuitive design tools and powerful automation 
features. It also comes with several free timeline templates that feature different 
visual styles and colours. The software is offered with a fully-workable free version 
and premium editions for individuals and businesses.

-- Windows (Microsoft PowerPoint)

-- Mac

-- Free edition

-- Premium edition: 59  US dollars (prices as autumn 2018)

www.officetimeline.com

Descripton

Impression

Platforms

Costs

More info

For Presentations

7. 	 Blended Technologies

7



166

Participoll

Collect audience response in Powerpoint

Participoll is a PowerPoint add-in that collects audience participation responses via 
any web-connected device and displays live results in your slides. No-hardware 
clicker-free polling using your audience members’ devices. It drops polls straight 
into your slides without having to preload questions.

-- Windows (Microsoft PowerPoint)

-- Mac

-- Free trial  (14 days)

-- Individual licence 199 US dollars

-- Team licence 799 US dollars (prices as in autumn 2018)

www.participoll.com

Purpose

Description

Impression

Platforms

Costs

More info

For Presentations
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Aploris 

Charts creation 

Aploris is graphing software designed to aid in the creation of charts in business 
presentations or in education – wherever statistics needed to be visualised. It 
integrates with MS Powerpoint and MS Excel to help you effectively create charts: 
Marimekko/Mekko, waterfall, Gantt, spider, bar and more. It supports descriptive 
elements including data rows, trend lines, growth arrows, and average lines.

-- Windows (Microsoft PowerPoint)

-- Mac

-- Free trial  (30 days)  

-- Yearly fee depending on the number of licenses. The fee is 220 euros for one 
user (plus VAT!) – which makes it a bit unrealistic for educational environments.

www.aploris.com

Purpose

Description

Impression

Platforms

Cost

More info

For Presentations

7. 	 Blended Technologies
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Pickit

Repository of pictures for Powerpoint presentations and Word documents

Pickit is an image resource site focussed on providing images for Powerpoint 
presentations. It helps you make professionally looking presentations. All images 
are licensed and free to use for anything.

x

Fig. 7.5 – A collection of picture themes as offerec by PIckit on their website in July 2019. The 
software itself is simply a plugin for MS Powerpoint and MS Word. 

-- Pickit Free: free version

-- Pickit Pro version: 5 US dollars per month

-- Windows (Microsoft PowerPoint)

-- Mac

https://pickit.com

Purpose

Description

Impression

Costs

Platforms

More info

For Presentations
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Spreaker 

Produce and distribute podcasts

Spreaker is a podcasting platform allowing you to create, distribute, measure, and 
listen to live or on-demand audio shows.

Spreaker’s features include recording console on both the web and mobile, the 
ability to migrate content using an RSS feed importer, as well as ways to connect 
to external tools and mixers. It further includes audio storage space for hosting 
shows, distribution by connecting to social networks, the ability to export to 
YouTube, Apple Podcasts, and Stitcher, and embeddable players and measurement 
tools with detailed audience analytics like plays, sources, and geolocation.

Fig. 7.6 – The Spreaker website, with the account of one of the authors of the book opened. One 
podcast is currently published. 

iOS, Android, Windows, Mac

-- Free with limited features. 

-- When we checked last (in July 2019), they had four different payment schemes  
for individuals and organisations of different size, starting from 7 euros per 
month (or 72 euros per year), up to 120 euros month (or 1200 euros per year).

https://www.spreaker.com

Purpose

Description

Impression

Platforms

Cost

Website

7.2 	 Podcasts
In this section we will look at some options in terms of what suitable software and hardware technologies are availa-
ble for podcasts. The software options will vary in terms of cost from free to expensive. 

7. 	 Blended Technologies
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Adobe Audition

Audio editor 

Adobe Audition is a digital audio workstation. It offers a multitrack, non-destructive 
mix/edit environment waveform editing view.  When used along with a suitable 
sound card, the programme provides a complete digital recording studio to the 
user’s computer. The programme is used in producing music, radio broadcasts, or 
audio for video. Adobe Audition also supports thousands of royalty-free music 
loops that can be used to compile songs and soundtracks.

However, the free alternative Audacity (presented in Chapter 4) will be as useful to 
you for most use-cases. 

iOS, Android, Windows, Mac

-- Free trial version 

-- 25 euros per month for the ordinary individual users

Adobe has a chaotic mess of special offers for various types of institutions, including 
educational organisations. It could be cheaper to lease a full Creative Cloud licence 
for an educational organisation than an Audition-only licence for an ordinary 
person. You have to check on their website. (We checked last in Mai 2019.)

Earlier versions of Audition could be bought on a DVD once for a lifetime. You can 
search in places where older software is sold (second hand included) and buy this, 
probably cheaply

www.adobe.com/it/products/audition.html

Purpose

Description

Impression

Platforms

Cost

More info 

For podcasts
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Podbean

Hosting and tools for podcasting

Podbean provides hosting and tools for podcasters, from beginners to enterprise 
level organisations. The podcasting platform includes tools for publication, 
management, broadcasting syndication, and analysis of your traffic and listeners. It 
provides everything you need to manage and distribute your podcast.

Fig. 7.8 – Screenshot of the Podbean website, with the account of one of the authors of the book 
opened. He currently has  one single podcast published there. 

-- iOS, Android, Windows, Mac

-- Free with limited features

-- Various payment schemes; when we checked last (2019) they had: 

-- 9 US dollars per month, billed annually 

-- 29 US dollars per month, billed annually

-- 99 US dollars per month,  billed annually

https://www.podbean.com/

Purpose

Description

Platforms

Costs

More info

For podcasts
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Smart Podcast Player

Audio player to be integrated into website

Smart Podcast Player is a customisable podcast player that can be integrated in a 
Wordpress website (yes, only the Wordpress content management system). It 
includes an email capture feature. Visitors can skip forward or backward by chunks 
just like on most smartphone podcast players. Visitors can also change the speed of 
your podcast. One can display unlimited podcast episodes, including pagination 
and search. The player follows responsive design principles so that it looks good on 
all devices, including mobile devices.

Fig. 7.9 – As Smart Podcast Player is a piece of software that can be integrated into websites, 
there is nothing really characteristic to show. Therefore we publish here a simple screenshot of 
the website selling the player. The player itself is integrated at the bottom of the page. 

-- Works on Wordpress websites only 

Wenn we last  checked (July 2019) there were two payment schemes: 

-- 8 US dollars  per month (billed annually)

-- 12 US dollars per month (billed monthly)

https://smartpodcastplayer.com

Purpose

Description

Impression

Platforms

Costs

More info

For podcasts
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Speakpipe

Message recorder to be integrated in your website

Speakpipe is an online service that allows people to leave you an audio message 
directly in the internet, typically while visiting your website or blog. They do not 
need a telephone (their computer or mobile device must have a microphone, of 
course). 

This audio file then gets emailed to you, so that you have the opportunity to 
respond by email or by sending another voice mail.

:

-- iOS

-- Android

-- Windows

-- Free trial

-- Several pro plans with different features

-- Premium 45 US dollars per month

-- Gold 15 US dollars per month

-- Bronze 8 US dollars  per month

https://www.speakpipe.com

Purpose

Description

Impression

Platforms

Costs

More info

For podcasts
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Wondershare Filmora

Video editor

Filmora is an video editing tool developed by a Chinese company that enables also 
uploading of videos onto social media. Features include correction of colour issues, 
and camera shake as well as use it with a green screen.

-- iOS

-- Android

-- Windows

-- Mac

-- Free trial with watermark

-- 1 year licence for approx. 50 US dollars a year (prices checked in autumn 2018)

https://filmora.wondershare.com/

Purpose

Description

Impression

Platforms

Costs

More info

7.3	 Videos
In this section we will look at some options in terms of what suitable software is available for video capture and edit-
ing for the development of blended learning content. The software options will vary in terms of cost from free to very 
expensive. 
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Apple iMovie

Video Editor

Apple iMovie is a video editing tool offering many templates to help make movies. 
As a typical video editing tool, its features include special effects, sound editing, 
adding logos, cast names and credits, add background music and voice-over 
narration. It also helps share movies with social media and online storage.

-- iOS

-- Mac

-- Free for Mac (last checked in late 2018)

https://www.apple.com/imovie/

Purpose

Description

Impression

Platforms

Costs

More info

For videos
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Openshot

Video editor (open source)

Openshot is a free and open source video editing tool. it does what you expect 
from a video editor: running a (theoretically unlimited) number of tracks/layers; 
resize, trim and rotate footage, editing titles and templates, and so on. It provides 
desktop integration, frame-by-frame editing and easy composting and overlaying. 
The bit advantage over other videos presented here is of course that it is completely 
free to use. Simply download it, install it and work with it.

Fig 7.13 – A typical work situation for video editing in Openshot. Visible are currently three 
separate tracks carrying various footage and sound records.

-- Windows, Mac, Linux

Free (last checked in laste 2018)

www.openshot.org

Purpose

Description

Impression

Platforms

Costs

More info

For videos
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Final Cut Pro

Video editor

Apple Final Cut Pro is a video editor that offers multi-camera editing, an extensive 
music library and a range of transition and motion elements. You can add text and 
titles easily as well as split-screen.

-- Mac

-- Free trial with watermark

-- Licenced version: 300 US dollar (last checked in late 2018)

www.apple.com/lae/final-cut-pro

Purpose

Description

Impression

Platforms

Costs

More info

For videos
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TechSmith Camtasia

Video editor

Techsmith Camtasia is a video editor providing multiple video and audio tracks and 
a range of transitions. You can add text, shapes and quizzes and do green screen. It 
also features video and audio stabilisation.

-- Windows

-- Mac

200 US dollars (last checked in late 2018)

www.techsmith.com/video-editor.html

Purpose

Description

Impression

Platform

Costs

More info

For videos
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Indesign

Graphic design & type setting

Adobe InDesign is a full-scale professional print layout application, usually seen as 
the industry standard in print production. It is being used to create posters, flyers, 
brochures, magazines, newspapers, presentations, books and e-books. The most 
usual production flow is to export documents to PDF (which is also the form in 
which print shops receive them and process them further). Other output formats 
are EPUB and SWF to create e-books and digital content suitable for computers and 
tablets.

-- Windows, Mac, Android, iOS

-- 7-day free trial

-- Various annual plans paid monthly according. A typical plan for an ordinary 
customer (individual) would be available for about 25 euros per month. 
However, there are many special offers for institutions, including educational 
organisations, and it can be cheaper to lease an educational licence for the full 
Adobe Creative Cloud package than to take a one-application-only licence for 
an ordinary customer. You have to check on Adobe’s website. 

-- Earlier versions were available as once-for-a-lifetime software. You can search 
at places were older software (including second hand) is being sold. The older 
versions are good as well. One of the authors of this book produces entire books 
till today with the now very old CS3 version of Indesign. 

www.adobe.com/gr_en/products/indesign.html 

Purpose

Description

Impression

Platform

Costs

More info

7.4	  Documents (PDF) 
This section will address some of the best and most popular tools that educators can use to create interactive and 
accessible PDFs. We try to summarize some of the main features of the tools, their cost and a short description of their 
use.
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PDFelement

Create and edit PDF 

PDFelement is a PDF editor produced in China that allows you to create, edit, 
convert, print, annotate and protect PDF files. It is an alternative to Adobe Acrobat. 
Some of its (more or less self-evident) features are: highlighting, strikethrough, add 
comments; text and image editing; create PDFs from various other document 
formats.

-- Windows, Mac

-- Free trial

-- Various plans paid yearly, starting from 100 US dollars per year for one licence 
of the Pro version. Alternatively, a lifetime licence can be bought for about 30 
per cent more. (Last time checked: May 2019) There are also special offers for 
students and educators. 

https://pdf.wondershare.com/pdfelement/

Purpose

Description

Impression

Platforms

Costs

More info

For documents (PDF)
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PDFill 

PDF editing

PDFill is a PDF editor quite different from others. It looks like a classic text editor 
(like MS Word in the early 2000s), but what you produce with it is directly a PDF. You 
could use it and write a letter directly in PDF instead of writing it in Word and then 
exporting it to PDF. However, you will then miss many of the practical features of a 
full-scale text editor. So probably it is better to use PDFiller rather for editing / 
changing existing pdfs, like you would do with Adobe Acrobat. The big advantage 
of PDFill is that it is free (basic version), or cheap (20 US dollars for the Pro version). 
It is produced by a small company in California named . The website is visible a 
couple of years old.  (In April 2019 we tried to buy the Pro version for testing, but 
the company had problems to process the  PayPal payment, so we got stuck with 
this.  You can try anyway.)

-- Windows, Mac

-- Free version 

-- Pro version for 20 US dollars (last checked in May 2019)

www.pdfill.com/download.html 

Purpose

Description

Impression

Platform

Costs

More info

For documents (PDF)
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PDFTK Builder

Processing PDF files 

PDFTK Builder is an open source PDF tool created by one-man programmer Angus 
Johnson (www.angusj.com) that allows you to do certain operations with PDF files 
on the level of pages: you can split a document into separate pages; you can 
combine documents into one; you can reorder pages; you can add backgrounds, 
watermarks and other things; you can rotate pages; and you can encrypt your 
document using passwords. 

Well, all that can be done also with full-size  PDF editors. But the fine thing here is: 
it is free, and it is very light-weight. 

Fig. 7.19 – Three of the four core dialogues PDFTK Builder offers .

Windows

Free

www.angusj.com/pdftkb
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7.5	  Games
This section will feature some websites educators can use to design educational games for their learners. We will also 
look at some software options available for badge creation. The options will vary in terms of cost from free to very 
expensive. 

Kahoot!

Prepare quizzes for audiences in a venue  

Kahoot! is a tool for game-based learning. Teachers can create quizzes, discussions 
or surveys for their classes, or even for large audiences. It is a response system 
played by the whole group in real time. Multiple-choice questions are projected on 
the screen, and learners answer the questions with their smartphone, tablet or 
computer.

For a more detailed description, see Chapter 4.5.2.

Fig. 7.20 – The Kahoot website in edit mode: one of our authors is currently creating a simple quiz 
about Blended Learning. Students will later have to pick answers by touching their smartphones.

-- Windows,  Mac, iOS, Android (relevant for the smartphone app)

-- Basic use is free 

-- There are various subscription models (1-3 dollars per teacher and month) 
offering various helpful additions such as free pictures to use, folders, team 
space, advanced reports etc. (Last time we checked was in May 2019)

https://kahoot.com

Purpose

Description

Impression

Platforms

Costs

More info
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Educaplay

Website for creating educational games etc.

Educaplay is a free website which lets educators create a wide variety of different 
educational interactive resources and link them to blogs or websites. Activities that 
can be created include Listen and Read Dialogues, Jumbled Words, Jumbled 
Sentences, Matching, Quizzes, Image Maps, Riddles, Crosswords, Wordsearch 
Puzzle, Fill in the gaps. Features include:

-- Export your activities to any SCORM-compatible Learning Management System 
such as Moodle, Edmodo, Blackboard, Chamilo, etc.

-- Get the results of your learners

-- Create groups with your activities 

-- Share created resources in any CMS like WordPress, Drupal, Blogger or Joomla! 
or in websites with custom programming

Fig. 7.21 – A gap filling game using a text that describes what Blended Learning is. We created this 
little game in about 5 minutes just to test the website. You can play this here (German needed):
https://www.educaplay.com/en/learningresources/4666185/html5/was_ist_blended_learning.htm

Irrelevant, as this is first of all a website. There is also an app, running on all present 
systems.

-- “General” (you can create activities, collections, groups and get results): free

-- “Premium”: from 4 to 39 euros per month (last checked in late 2018)

www.educaplay.com

Purpose

Description

Impression

Platforms

Costs

More info

For games in education
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Factile

Learning platform

Factile is a free learning platform where educators can create jeopardy-style quiz 
games for different subjects and types of learners. They can also use the database 
of already created games. 

-- Good tool to create revision games and keep learners motivated and challenged 

-- Simple, user-friendly gameboard templates to create games 

-- Easy to share your game with learners

Fig. 7.22 –A typical Factile screen with a quizz not yet started. For each of the dollar fields, you will 
have to create a question and an answer. You have seen this tip of quizzes in TV shows. 

-- Windows

-- Mac

-- iOS

-- Android

-- Standard version: Free

-- Pro version  5 US dollars per month, or 48 US dollars per year

www.playfactile.com

Purpose

Description

Impression

Platforms

Costs

More info

For games in education
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Open Digital Badges

A standart for defining “badges”

Mozilla Open Badge is an open technical standard to create “badges” than can be 
assigned to individuals for learning achievements documented on e-learning 
websites. For more on this see Chapter 4.5.2. 

Fig. 7.23 – The openbadges.org website offers information about the concept of open badges 
and explains how education organisations can start issuing such badges.

All systems that have web browsers.

Free (last checked in late 2018) 

https://openbadges.org

For some practical overview see also University of Texas:

https://openbadges.coerll.utexas.edu/create-badges

This website lists some useful information for creating and issuing Open Digital 
Badges. This includes basic information on digital badges, a list of Learning 
Management Systems that offer integration with Open Badges, and tools for new 
designers of badge systems.

Purpose

Description

Impression

Platforms

Cost

More info

For games in education
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Openbadges.me

Providing “badges” for educational websites

Openbadges.me is one of several services that provide digital badge management 
for educational organisations. This includes  the typical features for such a services, 
for example a design tool for badges (with shape templates), import images and 
backgrounds, custom attributes, etc. 

Fig. 7.24 – Website of Openbadges.me. Here we are logged in as a badge issuing institution, and 
are on the way of creating a badge showing the logo of the Blended Learning project.

All systems that have web browsers (so, all systems) 

-- Starter mode: 50 unique recipients: free

-- Teams mode: up to 500 unique recipients: 50 US dollar per month

-- Embrace mode: up to 3000 unique recipients: 150 US dollars per month (all 
prices last checked in May 2019). More expensive modes have also more 
features. 

 www.openbadges.me

Purpose
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More info

For games in education

7. 	 Blended Technologies

7



188

7.6	  Searching
In this section we look at some options in terms of what is available for searching. In Chapter 4 we have seen that we 
can search for images using the TinEye Multicolr (https://labs.tineye.com/multicolr/) search tool, and the Creative Commons 
search tool for multimedia content (https://search.creativecommons.org/). Statistics show that over 90 per cent of search activ-
ities online use Google. We do not want to support monopolies, so let us look at a few others: 

DuckDuckGo

Search website

DuckDuckGo presents itself as “Privacy – simplified“. The site claims that it does not 
collect data of people using it. As a consequence, the results on a search are 
independent on who is searching. Technically it is a combination of a meta search 
engine and a web crawler. The name goes back to a childrens’ game by the name of 
Duck Duck Goose. The site is run by a small company in the USA. Free 

Well, it’s the internet.

Free, but as all internet search machines, the company running it sells ads.  

https://duckduckgo.com/

Purpose
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Impression
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More info
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Ecosia

Search website

Ecosia is run by a small company in Berlin, Germany. It focusses on a sustainable, 
ecological mission: 80 per cent of its profits are claimed to go into reforestation 
projects in Africa and elsewhere. According to the company, the number of trees 
planted through their financing was 57 million by May 2019. Technology-wise, the 
search results are taken from Bing. - The company in Berlin received various startup 
awards.

Whatever reads the internet

Free, but as all internet search engine providers it sells ads, of course.

www.ecosia.org

Purpose

Description

Impression

Platforms

Costs

More info

For search & research activities
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MetaGer

Search website

MetaGer is a so called meta search engine. It uses the results of many (in this case: 
up to 60) different search engines, filtering these results in a meaningful way. In 
addition, MetaGer has its own crawlers and indexers (like DuckDuckGo). You may 
find MetaGer a lovely project because it is not a business but a university project 
(started in 1996) by Hannover University in Germany (that’s a university with a 
focus on technology). In 2012 they created an association (NGO), the Association 
for free Access to Knowledge to help maintain the project. Since 2013, MetaGer is 
available also in English, and recently a Spanish user interface was added. MetaGer 
has a very high level of privacy for the user.

Well, it is the internet. As long your device has a browser, you are fine

Free, but as all internet search engine providers it sells ads, of course.

https://metager.org/

Purpose
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Platforms
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More info

For search and research activities
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Qwant

Search website

Qwant claims to be ”the search engine that respects your privacy“. For example, 
cookies are deleted with the end of the session. It is based in France (small 
company), and recent data said that about 65 per cent of its use are from French 
users. In independent tests, search results of Google, Bing, DuckDuckGo and Qwant 
turned out to be of similar quality

Well, as long as your device has an internet browser, it will work

Free , but all internet search services sell ads., and so does Qwant

www.qwant.com

Purpose

Description

Impression

Platforms

Costs

More info

For search and research activities
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WolframAlpha

Search website

WolframAlpha is a complex search engine, sometimes called a computational 
knowledge engine or answer engine. It answers factual queries directly by 
computing the answer from externally sourced data and works out problems in 
maths, science, media, and everyday life.

Whatever is able to read the internet will be able to read Wolfram Alpha

Free, but as all search engines, of course they try to generate some income through 
ads etc.  

https://www.wolframalpha.com

Purpose
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More info
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Blend-it-well Handbook 

7



193

7.7 	 Other Educational Technologies
This section will discuss some technologies that focus 
particularly on the development of web-based content. 
First we will  look at some website tools, next we will dis-

cuss virtual learning environments. Finally we will look 
at learning object standards.

7.7.1	  Website tools

The www (World-Wide Web) consists of a collection of 
web pages, stored on computers called web servers, 
which can be viewed using software programmes called 
web browsers. The web pages are plain text files with 
special tags in HTML (Hypertext Markup Language) that 
the web browser uses to format the content for display 
on the computer screen. 

There are many ways to create web pages. A simple 
one is to create a document in Microsoft Word (as this 
is a programme almost everybody has available). You 
would then  use the Save As option to save, and select 
the Web Page (*.htm; *.html) file type.  

The html-file then needs to be put onto a web server. 
You can use your own, but more typically you would use 
the services of a commercial web hosting provider. The 
file needs to be made accessible to the public through 
a web address such as www.hurray-my-first-website.eu 

HTML Editors 
For tasks more complex than creating just a single html 
page, you usually would choose a dedicated html ed-
itor. Such dedicated web page development tools in-
clude Dreamweaver, Frontpage, and KompoZer.

●● KompoZer is a free and open-source web devel-
opment tool, available for MacOS, Windows, Linux, 
and OS-2. It provides a simple development environ-
ment that generates HTML code automatically.

●● Dreamweaver is a commercial web development 
tool from Adobe, available for MacOS and for Win-
dows. It provides a simple development environ-
ment that generates HTML code automatically.

●● Frontpage is a commercial web development tool 
from Microsoft (available for Windows and MacOS). 
It also provides a simple development environment 
that generates HTML code automatically.

For larger websites with many pages, constantly updat-
ed content, and multiple contributers you would proba-

bly prefer using a content management system (CMS) 
such as Joomla or Wordpress. 

Web Hosting Services
Besides a plethora of commercial service providers sell-
ing web space for a monthly rent, there are a number of 
free web hosting services. Here are three of them.

●● Wix allows you to create websites the use of online 
drag and drop tools. You can add in a range of tools, 
such as social plug-ins, e-commerce, online market-
ing, e-mail marketing, and community forums.

●● Weebly also allows you to create websites through 
the use of online drag and drop tools. Basic features 
for blogging and e-commerce are supported, in-
cluding payments via PayPal, etc. 

●● Tripod offers free and paid web hosting services, in-
cluding 20 megabytes of storage space. In addition 
to basic hosting, Tripod also offers a blogging tool, 
a photo album manager, and a simple page editing. 

Checking Accessibility 
We have already discussed the idea of website accessi-
bility, therefore it is worth pointing out that there is a 
number of tools you can use to assess the accessibility 
of your site, once you have created it. 

These tools include WAVE from WebAIM, which is a free 
evaluation tool that provides visual feedback about the 
accessibility of web content by adding icons and indica-
tors into the web page. Another tool, AChecker, which 
produces a report, identifying known, likely, and poten-
tial accessibility problems. Finally, CheckMyColours is a 
tool for checking foreground and background colour 
combinations and determining if they provide sufficient 
contrast when viewed by someone with visual impair-
ments.
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7.7.2 	 Virtual Learning Environments (VLEs)

A VLE (Virtual Learning Environment) is a website that 
allows educators to upload content (lessons, images, 
presentations, documents, etc.), as well as allowing edu-
cators to create quizzes and other forms of assessment. 
The learners can log into this site, read the content, and 
take the quizzes. It provides a controlled environment 
that allows the educator to monitor the learners’ pro-
gress.

WebCT
A very common Virtual Learning Environment is WebCT 
(also known as the Blackboard Learning System) which 
is a proprietary VLE that can be licensed to educational 
institutions, and is used in many campuses internation-
ally for e-learning. The latest version of WebCT is called 
Webcourses. It has a number of in-built tools including 
discussion boards, mail systems, and live chat. A typical 
tool listing includes the following (Fig. 7.1):

Moodle
The most popular rival VLE is Moodle, which is free and 
open-source. It is much more configurable than WebCT, 
and runs on a wide range of operating systems. It also 
allows for extending and tailoring using open-sourced 
plugins. There are over 1000 plugins available, including 
the following:

●● Filtered course list: Displays a configurable list of 
courses. 

●● Completion Progress: A time-management tool for 
students.

●● MathType: Type and handwrite mathematical nota-
tion in Moodle.

●● AutoEnrol: Adds functionality to automatically en-
rol users onto a course.

●● Geolocation Condition: This adds GPS coordinates 
to sections and course modules. 

●● Reader: This tracks the students’ reading achieve-
ments.

●● Questionnaire: Custom Survey Creation

Fig. 7.1 – A typical collection of tools in a VLE
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7.7.3 	 Learning Object Standards 

A learning object is a file that contains special tags that 
help describe any type of electronic learning content (a 
lesson, a presentation, an image, an assessment, etc.). 
The tags are in a language similar to HTML, called XML 
(Extensible Markup Language). This means that the 
learning content can be easily embedded into a VLE, 
and easily transferred into a new one, if needed, so edu-
cators are not locked into one specific VLE. It also makes 
it easier for educators to locate content that is useful 
to their teaching, and it encourages educators to think 
more deeply about their content.

SCORM
A very common learning object standard is SCORM 
(Sharable Content Object Reference Model), which has 
tags that not only provide descriptors of the learning 
content, but can also specify a sequencing of learning 
objects, so it might say something like “The learner must 
read Learning Object A before reading Learning Object B”. 
SCORM also communicates to the VLE that is using it, 
and tells the VLE how to present the learning object to 
the learner, as well as how to track the learners’ interac-

tions with the object. Below is a sample of SCORM tags: 
(See Fig. 7.2)

xAPI
A newer standard that is seen by many as the successor 
to SCORM is called xAPI (Experience API), also known as 
Tin Can API. It provides all of the functionality of SCORM 
but also includes new capabilities, such as taking learn-
ing objects outside of VLEs and using them in mobile 
applications. It also provides improved security fea-
tures, and places much more emphasis on facilitating 
group-based learning.

7. 	 Blended Technologies

<content>

	 <globalProperties>

		  <externalMetadata>

			   <source>ADL</source>

			   <model>ADL SCORM 1.1</model>

		  </externalMetadata>

	 </globalProperties>

	 <block id=”B1”>

		  <identification>

			   <title>Golf Explained - CP Single SCO</title>

			   <description>Content packaging</description>

			   <labels>

				    <curricular>COURSE</curricular>

			   </labels>

		  </identification>

	 </block>

</content>

Fig. 7.2 – Markup code (tags) for a SCORM compliant document (sample).  
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Blended Evaluation

This chapter is perhaps one of the most important ones 
in the whole workbook, as it focusses on a wide range 
of evaluation processes. In order to be able to reflect 
on what occurred, and see what lessons can be learned 
for further iterations, it is very important to include an 
evaluation step in all educational innovations. We have 
already seen some approaches to evaluation, and this 
chapter will provide a wide menu of options in terms of 
evaluation. We do not expect you to use all of them. We 
want you to see which ones best appeal to you. 

The chapter will start with a look at different ways of 
evaluating learners, first by you (the educator) looking 
at formative and summative assessment, as well as ap-
proaches to feedback. Next, we will look at how learners 
can assess themselves and how they can assess each 
other in groups.

From this we will then look at how to assess the blend-
ed learning content, particularly focusing on the online 

content, and look at standard evaluation rubrics that 
are used to assess the quality of learning objects. In ad-
dition, we will look at ways that learners can help you 
assess the quality of the blended assessment using us-
ability approaches including interviews, surveys and fo-
cus groups. Furthermore, more specific techniques like 
shadowing, observation, GOMS, the Think-aloud proto-
col, and personas will be outlined. 

Next, we will look how to evaluate the blended module 
or programme, looking at a variety of reviewing pro-
cess, as well as a SWOT approach.

Finally we will look at the evaluation of the financial 
cost of blended learning, looking at concepts such as 
RoI (Return on Investment), and looking at the costs of 
technologies, in both the short-term and the long-term.

8. 	 Blended Evaluation

Fig 8.1 – Key Sections in Chapter 8.

evaluate 
costs
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8.1 	 Educational Evaluation

1	 Hattie, J. (2003): Teachers Make a Difference: What is the Research Evidence? Paper presented at the Australian Council for 
Educational Research Annual Conference on Building Teacher Quality, Melbourne.

Whether in a blended classroom or a traditional one, it 
is vitally important to evaluate the performance of the 
learners, and to provide them with sufficient feedback. 
This way they can understand their current educational 
attainment, and be given assistance on how to improve 

their subsequent performance. In this section we will 
look at two categories of assessment (summative and 
formative assessment), and three types of assessment 
(examinations, continuous assessment, and informal 
Evaluation). 

8.1.1 	 Categories of Assessment

There are many different definitions of these two cat-
egories of assessment, but in this case, we will use the 
following simple, common-sense definitions:

Summative assessment
Summative assessment is any form of assessment giv-
en by an educator where the learners receive a numeric 
score. Many also receive some quantitative feedback to 

help them to improve their attainment. It typically fo-
cusses on the learning outcome of a programme.

Formative assessment
Formative assessment is any form of assessment given 
by an educator where the learners do not receive a nu-
meric score, but rather receive qualitative feedback to 
help them to improve their attainment. It typically fo-
cusses on the details of content and performance.

8.1.2 	 Types of Assessment

There is a wide range of types of assessment that an ed-
ucator can give a learner, but in this case we are going 
to use three broad groupings: 

Examinations
Examinations are usually summative in nature, and 
in a blended context usually work in the same way as 
they do in a traditional classroom. The learners have a 
fixed amount of time to complete a specified number 
of questions, and are either allowed to consult educa-
tional material (“open-book exam”), or are not allowed 
(“closed-book exam”).

Continuous assessment
Continuous assessment can be either summative or 
formative, and in a blended context can be done in a 
wide variety of ways. In the traditional classroom set-
ting, it typically involves presenting the learners with a 
series of tasks that they are required to complete in their 
own time. Typically the learners are given several days 

or weeks to complete the task, and it involves some in-
dependent research or problem solving. 

A blended environment provides a wide range of novel 
opportunities for continuous assessment: learners can 
be asked to do activities such as creating their own vid-
eos or audio recordings.  They can be asked to edit a 
wiki, post to a blog or to a social network account. They 
can also be asked to develop their own game or under-
take a search activity. They can also create a quiz, inter-
act with someone in another country, and virtually visit 
important locations around the world.

Perhaps the most important thing to say about teach-
ing in general is something we have mentioned already 
in Chapter 3.  There is one factor that can affect learn-
ers’ performance significantly more so than all others 
can, and that is feedback. Australian researcher John 
Hattie published a seminar paper in 20031 where he 
did an analysis of over 500,000 educational studies, and  
identified feedback as being the factor that is the most 
powerful and has the most meaningful effect on learner 
learning. 
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On the following page, we present a more detailed 
feedback form, based on the form in Chapter 3. This one 
is more detailed and includes more information on the 
assignment, and some quantitative categories to give 
quick, and effective, feedback to the learners. It is im-
portant to develop a feedback form that can be com-
pleted quickly as many studies1  show that if feedback 
is not given in a timely fashion, it is ineffective (typically, 
feedback within two weeks is considered effective). In 
addition, if you create a model answer when develop-
ing your assessment, it can be helpful to refer to that in 
your feedback, and give the learners a copy of it. To en-
sure the learners fully understand your feedback some 
educators choose to give the learners an additional task 
of responding to the feedback. Alternatively, you could 

1	 Harrison, S. H., E. D. Rouse (2015): An Inductive Study of Feedback Interactions over the Course of Creative Projects. Academy of 
Management Journal, 58(2), p. 375-404.

consider giving feedback in such a way that it points to 
relevant revision for the learners exams.

Feedback can be given informally in class as well. This 
can be extremely effective in immediately correcting 
misconceptions and steering the learners in the right 
direction. This feedback can be given either verbally or 
even by putting a small message on a post-it note and 
sticking it to a learner’s desk. Informal feedback needs 
to be honest, simple and supportive. When giving infor-
mal feedback it helps to start with something positive, 
and to share with the learners the challenges you your-
self encountered when learning the topic under discus-
sion.

8. 	 Blended Evaluation

Table 8.x – Feedback Form

Reviewer: Assignment: Date of Submission:

Learner: Learner: Date of Marking:

Key Points

I like that you:

1.	 	. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                           

2.	 	. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                           

3.	 	. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                           

I would have liked if you had:

1.	 	. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                           

2.	 	. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                           

3.	 	. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                           

Excellent 
[70%-100%]

Good
[60%-69%]

Satisfactory
[50%-59%]

Weak
[40%-49%]

Fail
[0%-39%]

Format
[0-10%]

[7-10] [6-7] [5-6] [4-5] [0-4]

Coverage
[0-10%]

[7-10] [6-7] [5-6] [4-5] [0-4]

Research
[0-10%]

[7-10] [6-7] [5-6] [4-5] [0-4]

Knowledge
[0-20%]

[14-20] [12-14] [10-12] [8-10] [0-8]

Critical Thinking
[0-25%]

[18-25] [14-18] [12-14] [10-12] [0-10]

Creativity
[0-25%]

[18-25] [14-18] [12-14] [10-12] [0-10]

Signed: Date:
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In a blended context, there are a significantly wider 
number of formats that the feedback can be presented 
in. One method that is growing in popularity is audio 
feedback where the educator records verbal feedback; 
many consider this a faster way of producing the feed-
back, and if several learners need to be given the same 
feedback, the same audio file can be sent to them with-
out any additional effort. The educator is able to elicit 
praise based on the tone of their voice as well as the 
content of the feedback, this is something which learn-
ers appreciate.1 

Other educators have used video feedback, something 
which many learners feel is more personalised and mo-
tivational. Research suggests that video feedback can 
be easier to comprehend, and easier to act upon.2 With 
video feedback, the educator can include demonstra-
tions and show how to improve the submitted content 
easily. 

There are also a number of e-Assessment tools that can 
be used in a blended context, including tools like Ka-
hoot (https://kahoot.com), that allow the educator to devel-
op a range of quiz type games, including multi-choice 
questions, which the learners can vote on collectively 
using their mobile phones. The results of which can be 
displayed on screen. It can also be used with chat tools 
like Skype and Google Hangouts.

Peer and self-evaluation
To help learners to “learn how to learn” (metacognition) 
it can be very useful for learners to reflect on their own 
work and the work of their peers. This can also help 
them to understand both the assessment criteria of a 
given assignment, and understand how the learning 
outcomes are being achieved in the assessments. Peer 
and self-evaluation increases the amount of feedback a 
learner receives, develops the learners’ critical thinking 
skills, and helps them to do better in assessments. 

Peer evaluation involves the learners using a set of as-
sessment criteria to evaluate the work of their peers. 
They should be providing clear feedback to their peers, 
as well as a grade. This will make them more actively en-
gaged in their learning process and can result in them 
being more deeply engaged in the assessment process-
es. Peer evaluation can be done either on a one-to-one 
basis or in small groups of generally no more than five 

1	 Hooper, D. (2010) Towards an Understanding of Students’ Use of Audio Feedback: An Exploratory Study, presented at iCERi2010, 
15-17 November, Madrid, Spain.

2	 West, J., W.  Turner (2015): Enhancing the Assessment Experience: Improving Student Perceptions, Engagement and Understanding 
Using Online Video Feedback. Innovations in Education and Teaching International, 38 (2), p. 240-252.

members. If it is the preference of the learners this can 
be done in an anonymous manner. It can be helpful to 
start with something simple, for example, get learners 
to look at each other’s notes taken in class and have a 
structured discussion around the differences in per-
spective evidenced in the notes. This can also be a way 
for them to look at the gaps in each other’s notes and 
a means to compare previously marked assignments. 
This approach gives the learners a feeling of having 
their voices heard in the classroom, and it is often easier 
for learners to learn from each other as they speak in a 
similar vernacular. There are a wide range of tools that 
support peer evaluation, including:

●● PeerWise: https://peerwise.cs.auckland.ac.nz/

●● CATME: https://www.catme.org/

●● peerScholar: https://peerscholar.com/

●● PEAR: https://peartool.opened.uoguelph.ca/

Self-evaluation can involve the learners cooperating 
with the educator to define a series of assessment crite-
ria, and then applying them to their own work. The fo-
cus here is not about learners giving themselves a mark, 
but rather that they learn to understand the features of 
a well-written assignment. This can also allow them to 
develop their ability to reflect on a learning activity. If 
the assessment criteria are clear and transparent, learn-
ers will often be more critical on themselves than an 
educator will be. Typical questions a learner should be 
encouraged to consider during self-evaluation include:

●● Do I understand what I have answered?

●● Do I understand why it is important?

●● Do I understand why the assessment is asked in the 
way it is being asked?

●● Do I understand how this is contributing to my 
learning?

●● Do I understand  that there are multiple ways I can 
answer this assessment?

●● Do I understand my own preferred communication 
style?

To introduce this approach to learners it can be best 
to start with something simple, for example, give the 
learners a set of multiple-choice questions, and after 
they have completed it, hand out solutions, and get 

Blend-it-well Handbook 
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them to reflect on the answers they got wrong. They 
should consider if it was a lack of understanding of the 
question, or a lack of knowledge about the topic. Once 
they have completed this task, give them more complex 
assessments to self-evaluate. This approach encourages 

learners to pay close attention to assessment criteria, 
and to reflect on how effectively they are meeting each 
of those criteria. It also give them some control over 
their own learning, and it enhances their critical think-
ing skills. 

8.2	 Evaluation of the Blended Process
To understand and evaluate the effectiveness of the 
blended activities you have developed, this section pre-
sents us with four evaluation processes. First, evaluation 
based on standard categories, second, evaluation from 

learners, third, evaluation of technological challenges, 
and finally, the programme-centred evaluation of the 
content.

8.2.1	 Categorical Evaluation of BL Assets

LORI
A number of organisations have developed evaluation 
criteria for online content. These include eLera, a dis-
tributed group that researches and evaluates e-learn-
ing. eLera provides a range of tools and information 
for learning object evaluation and research, and they 
maintain a database of learning object reviews. They 
have developed the Learning Object Review Instrument 
(LORI). LORI has nine criteria. LORI is used to evaluate the 
quality of e-learning resources. LORI is a form consisting 
of rubrics, rating scales and comment fields. The form is 
usually provided online. Table 8.1. gives a detailed de-
scription of the nine criteria.

For this workbook, we have created a simplified version 
of the LORI instrument that you can make copies of and 
hand out to your learners (see next page). 

MERLOT
Another organisation with a similar instrument is 
MERLOT (www.merlot.org), which is a repository containing 
educational resources classified into seven broad sub-
ject categories: arts; busines; education; humanities; 
mathematics and statistics; science and technology; so-
cial sciences.

There are three general categories of evaluation stand-
ards used within MERLOT – see Table 8.2.

1.	 Quality of Content 

2.	 Potential effectiveness as a teaching-learning tool 

3.	 Ease of Use

8.2.2 	 Learner Evaluation of Blended Learning Assets

One of the most useful ways of evaluating the quality of 
blended activities is to ask the learners. It is often best 
to initially get informal feedback, by asking the learn-
ers either as a group or individually for feedback on the 
blended activities. In addition to informal approaches, 
there are a number of structured techniques that can be 
used to elicit feedback, including the following:

Interviews
Interviews generally start will a little small talk, followed 
by a brief outline of the aims of the interview. There are 
generally three forms of interviews:

●● Unstructured Interviews: The interviewer has a few 
themes they wish to explore, but there are no fixed 
questions before the interviews, and the response 
to one question can lead to a number of follow-ups.

8. 	 Blended Evaluation
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●● Semi-Structured Interviews: A significant number of 
the questions are fixed before the interview, and the 
interviewer has leeway in asking follow-up ques-
tions when interesting responses are given.

●● Structured Interviews: All of the questions are pre-
determined before the interview, and are often giv-
en to the interviewee to prepare answers. No new 
questions can be added during the interview.

In the context of blended evaluation, a semi-structured 
approach can yield interesting outcomes. A careful read-
ing and analysis of the answers of several interviews can 
identify areas of improvement. Some researchers sug-
gest that it is necessary to do at least five interviews on 
the same topic to yield a sufficiently wide range of per-
spectives on the topic under scrutiny.

Surveys
Surveys start with a title, and have a brief statement of 
its aims. Surveys are usually composed of two types of 
questions:

●● Closed-ended questions: There are a limited number 
of predefined answers and the learner ticks one of 
the answers. This type of question is easy to adminis-
ter and responses are easy to analyse. They do how-
ever prevent the learner from raising new issues.

●● Open-ended questions: The questions are asked and 
the learner can answer what they wish.  This type of 
question is slower to administer and responses are 

slower to analyse. They do allow the learner to raise 
new issues.

Surveys can be given to learners and asked to be done 
in their own time (this is called “self-administrated”), or 
the educator can be present and can instruct the learn-
ers how to fill out the questions and answer any queries 
(this is called “interviewer-administrated”).

Focus Groups
Focus Groups involve taking a group of learner and 
asking them as a group a number of questions about 
the blended content. Start by thanking everyone for 
coming, review the goals of the group, explain how 
everyone will contribute, and set the tone. Repeat what 
you think the group are saying in different words, and 
respect everyone’s opinion. Sometimes learners will 
answer questions more honestly in a group, buoyed 
by other comments by other learners, than if they were 
doing one-to-one interviews. The major concern with 
using focus groups is that they can be difficult to man-
age and sometimes the group can end up discussing 
irrelevant topics. Focus groups can also be done online 
which allows for greater participation and anonymity.

Shadowing
Shadowing works by simply observing the learners 
use the technology, without asking any questions and 
without offering any assistance. During the observation 
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Table 8.2 – MERLOT Quality Evaluation Categories 

Rating Description

Quality of content

There are two general elements to quality of content:
●● Does the software present valid (correct) concepts, models, and skills? 
●● Does the software present educationally significant concepts, models, and 

skills for the discipline?

Potential effectiveness as a 
teaching-learning tool 

Evaluating the potential effectiveness is asking the peer reviewer to judge, 
based on their expertise as an educator, whether the learning material is likely 
to improve teaching and learning given the ways the faculty and learners could 
use the tool. Questions include:

●● What stage(s) in the learning process/cycle could the materials be used for? 
●● What should learners be able to do after successfully learning with the 

materials?

3. Ease of use 

Determining the ease of use of the content is exploring how easy it is for 
educators and learners to use the content for the first time. Questions include:

●● Can the user get lost easily in the material? 
●● Are the labels, buttons, menus, text, and general layout of the computer 

interface consistent and visually distinct?
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phase the learners will note any questions they have, 
and note any issues they encountered. After the process 
is over the learners can ask the educator about all of the 
questions they need answering. At the same time, dur-
ing the observation phase the educator notes down 
any issues they observe with the learners interaction 
and those issues are discussed after the phase is over. 
Ideally, the observations should not last longer than 30 
minutes. Otherwise they will be of less value and less 
authenticity. Analysis of the outcomes of a shadowing 
activity needs to be undertaken carefully. It is a mistake 
to attempt to generalise the outcomes of a single shad-
owing activity to a whole learner group.8.2.3 	
Technology in Learning - A Perspective from the Dis-
tance 

In this section we will look at two models of technology 
usage. The first, the Gartner Hype Cycle can help predict 
when a technology will become obsolete. The second, 
the UTAUT may help diagnose why learners are having 
problems with using a specific technology.

The Gartner Hype Cycle
Something to remember when choosing a particular 
technology to use as part of the blended environment 
is that technology goes through phases of populari-
ty and later goes out of fashion. Therefore it is a good 
idea to review the blended activities on a regular basis 
and check if they are no longer likely to be supported 
or available. The Gartner Group is a global organisation 
that looks at trends in a range of business domains, in-
cluding IT, HR, Finance, and Customer Support. On an 
annual basis the Group looks at existing and emerging 
technologies, and maps the lifecycle of that technology 
onto their Hype Cycle methodology. This consists of five 
stages:

4.	 Technology Trigger: This is the initial breakthrough 
of a given technology. At this stage there may be 
no commercial products available that incorporate 
the technology, but the media is abuzz with stories 
about it, and early proof-of-concept prototypes are 
very promising.

5.	 Peak of Inflated Expectations: The media is saturat-
ed with stories about this technology. It is appear-

8. 	 Blended Evaluation

Table 8.1 – Learning Object Review Instrument (LORI)

Rating Description

1. Content Quality
This category looks at how factually accurate the content is. In addition, 
it considers whether or not there is a balanced presentation of ideas, 
and it looks to see if there is an appropriate level of detail.

2.Learning Goal Alignment
This category looks at the degree of alignment among learning goals, 
activities, assessments, and learner characteristics.

3. Feedback and Adaptation
This category looks at adaptive content or feedback driven by 
differential learner input or learner modelling.

4. Motivation
This category looks at ability to motivate and interest an identified 
population of learners.

5.Presentation Design
This category looks at design of visual and auditory information for 
enhanced learning and efficient mental processing.

6.Interaction Usability
This category looks at ease of navigation, predictability of the user 
interface, and quality of the interface help features. 

7. Accessibility
This category looks at design of controls and presentation formats to 
accommodate disabled and mobile learners. 

8. Reusability
This category looks at ability to use in varying learning contexts and 
with learners from differing backgrounds. 

9.Standards Compliance
This category looks at adherence to international standards and 
specifications

8
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ing in all the magazines and newspapers. Some 
stories are explaining the potential benefits of the 
technology, many are highlighting its weaknesses.

6.	 Trough of Disillusionment: Interest in the technolo-
gy wanes as the failures are piling up, and investors 
in the technology are looking for something new. 
Many of the companies that were set up to exploit 
this technology have failed, a few are still in oper-
ation. Those still in operation are usually the ones 
who are listening to the problems, and working on 
solutions.

7.	 Slope of Enlightenment: The benefits of the tech-
nology are becoming clear (when properly imple-
mented) and the surviving companies have a clear 
path to market. Second-generation versions of the 
technology begin to appear, and there is more in-
vestment in the technology.

8.	 Plateau of Productivity: The technology is now 
well-established, the benefits and shortcomings 
are well understood, and the applicability of the 
technology is clear to everyone.

Unified Theory of Acceptance and 
Use of Technology (UTAUT) 
If the learners are not engaging with the blended activi-
ties, it may be that the learners’ expectations of what the 
blended activities will do for them are not being met. It 
may also be a reluctance to use technology in a learn-

1	 Venkatesh, V., Morris, M.G., Davis, G.B., Davis, F. D. (2003): User Acceptance of Information Technology: Toward a Unified View. MIS 
Quarterly, pp.425-478,.

2	 Sun Chen, W., A. Yong Tat Yao (2016): An Empirical Evaluation of Critical Factors Influencing Learner Satisfaction in Blended Learning: 
A Pilot Study. Universal Journal of Educational Research, 4(7),.

ing context. To help determine potential pitfalls around 
learner expectations we can use a model developed by 
Venkatesh, et al. (2003).1 They developed a model called 
the Unified Theory of Acceptance and Use of Technology 
(UTAUT) model. The UTAUT considers both the user’s in-
tentions before they interact with the technology and 
the user’s behaviour when they are interacting with the 
technology. The UTAUT states that there are four factors 
that determine how a user (or a learner) will engage 
with technology:

●● Performance Expectancy (PE) – The degree to which 
an individual believes that using the system will help 
them to attain gains in job performance.

●● Effort Expectancy (EE) – The degree of ease associat-
ed with the use of the system.

●● Social Influence (SI) – The degree to which an indi-
vidual perceives the importance that others place 
upon use of the new system.

●● Facilitating Conditions (FC) – The degree to which 
an individual believes that an organizational and 
technical infrastructure exists to support use of the 
system.

The first three factors (PE, EE, and SI) determine the us-
er’s intention before they interact with the technology. 
This is called their Behavioural Intention, BI. The final 
factor, Facilitating Conditions (FC), combined with BI, 
determines how the user will behave with the technolo-
gy (Usage Behaviour, UB).

The UTAUT also considers four key components: Gen-
der, Age, Experience, and Voluntariness of Use which 
also contribute to Behavioural Intention (BI) and Us-
age Behaviour (UB). It is highly successful at predicting 
whether people will use a new technology. There is a 
standard questionnaire based on the model that can be 
used to assess the potential usage behaviour of tech-
nology, which has been validated numerous times since 
its creation in 2003.2 

Figure 8.2 – The Gartner Hype Cycle.
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8.2.4	 Evaluation of Blended Learning Programmes

There are a broad number of ways to evaluate a blend-
ed programme. Here we present two techniques, using 
a SWOT analysis, and a brief description of an academic 
quality assurance process.

SWOT Analysis
SWOT Analysis was developed as a strategic planning 
tool for organisations to help determine both the inter-
nal and external factors that might be advantageous 
and detrimental to their businesses. Although the ori-
gins of SWOT are elusive, generally 
it is credited to Albert S. Humphrey 
working at the Stanford Research 
Institute in the 1960s and 1970s. 
SWOT stands for:

Strengths: What is going well in this 
organisation?

Weaknesses: What is not going well 
in this organisation?

Opportunities: What external ele-
ments are present to improve suc-
cess?

Threats: What external elements 
are present that might be an imped-
iment?

The Strengths and Weaknesses tend to look at the pres-
ent whereas the Opportunities and Threats focus on the 
future. SWOT can be used for any decision making sce-
nario where a clear end goal has been established.

Tabl 8.3 shows  a sample SWOT analysis, looking at the 
Strengths, Weaknesses, Opportunities, and Threats for 
an academic institute.

You find a DOCX file with this template in the supple-
mentary documents to this book, and a template for 
photocopy on the next page (Fig. 8.4).

8. 	 Blended Evaluation

Figure 8.3 – The Simplified UTAUT.

Table 8.3 – S.W.O.T.  Analysis of an Academic Institute

Helpful Harmful

Internal

Strengths:
●● Industry-orientation
●● Good quality assurance
●● Small class sizes
●● Good location

Weaknesses:
●● Staff salaries
●● Limited programmes
●● Technology issues
●● Population challenges

External

Opportunities:
●● Professional 

accreditation
●● Learner research
●● Community links
●● Brand recognition

Threats:
●● Raising costs
●● Online programmes
●● Recent cuts
●● Higher entry points

8
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Fig. 8.4 – SWOT form. You find this as a .docx file in the supplements to this book, 
 www.blenditwell.eu/handbook/templates/BL_Sup03_SWAT.docx

S.W.O.T. Analysis 

Topic:     

  Helpful  Harmful 

In
te
rn
al
 

Strengths:

 

Weaknesses: 

 

Ex
te
rn
al
 

Opportunities: 

 

Threats:
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8.3 	 Financial Evaluation

1	 Marengo, A., V. Marengo (2005): Measuring the Economic Benefits of e-Learning: A Proposal for a New Index for Academic 
Environments. Journal of Information Technology Education: Research, 4, 329-346.

To ensure that the case for the use of blended learning 
in your organisation is comprehensive, it is important 
that you are in a position to discuss some of the finan-
cial challenges and benefits associated with blended 

learning. Therefore this section will provide a brief over-
view of some of the key financial issues, explain some 
key terminology, and look at the long-term financial 
perspective.

8.3.1 	 General Overview of Financial Issues

To help understand some of the key arguments for and 
against introducing blended learning into your organi-
sation, in Table 8.4. we present some of the key financial 
considerations:1

Above is a sample of some of the potential financial 
considerations when developing a blended learning 
programme, there will also be items that are specific to 
your organisation.

It is useful to explore which of these Costs and Benefits 
are once-off and which are on-going:

●● The first item (“Cost of creating content”) might 
seem like a once-off cost, but content will have to be 
refreshed and updated on a regular basis. The costs 
of items 2-6 will be less regular, and the final item 
(“Cost of employing staff”) is a regular cost. 

●● In terms of the Benefits: Saving, items 1-2 are on-go-
ing benefits, whereas item 3 goes from being on 
on-going cost to an ongoing saving. In terms of the 
Benefits: New Revenue, items 1-3 are all on-going 
benefits.

8.3.2	  Key Financial Metrics

This section explains three key financial metrics that it is 
important to be familiar with when discussing financial 
considerations. They are Cost-Benefit Analysis, Return 
on Investment, and Balanced Scorecard.

Cost-Benefit Analysis
Cost-Benefit Analysis should really be called Bene-
fit-Cost Analysis, as it describes the ratio between Ben-
efits and Costs.

Return on Investment
Return on Investment is calculated by first determining 
the Net Profit (with is Benefits minus Costs), dividing 
that by the costs, and multiplying the result by 100.

Balanced Scorecard
A balanced scorecard is a way of looking at a programme 
or an organisation that takes into account more than 
the explicit financial perspective. It also considers other 
factors thafinancial implications, including the custom-
ers (in our case the learners), the learning (within the 
organisation, including staff sharing best practice), and 
the internal processes (including the quality assurance 
processes).  A sample is provided in Table 8.5. 

Benefits

Cost
Cost-benefit ratio =

RoI =
 (Benefits - Costs) ∙ 100

Cost

8. 	 Blended Evaluation
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8.3.3	  Long Term Financial Evaluation

1	 Maloney, S., P. Nicklen, G. Rivers, J. Foo, Y. Y. Ooi, S. Reeves, K. Walsh, D. Ilic (2015): A Cost-Effectiveness Analysis of Blended Versus 
Face-to-Face Delivery of Evidence-Based Medicine to Medical students. Journal of Medical Internet Research, 17 (7).

It is important to recognise that when initially develop-
ing a blended learning programme there will be a high 
cost, but over the long-term the programme will start to 
pay for itself. It is useful to look at the costs from three 
perspectives; Short-term (the first 6 months), Medi-
um-term (6-18 months), and Long-term (18-50 months).

Table 8.6. shows some potential considerations.

A key consideration will be the technology costs, the 
cost of hardware and software can reduce over time, so 
it might be worth waiting to see if the costs of specif-
ic product reduce. It is also worth pointing out that for 
software, there is a wide range of open source software 
that is free that provides the functional of commercial 
products.

Maloney et al. have shown that savings from blended 
learning will far outweigh costs within three years . 
They also discuss the deployment of video content, and 
they highlight the fact that there are a number of free 
hosting services, such as YouTube, that provide content 

management They also state that adding multi-media 
and animations to video appears to have little impact 
on learner achievement.

A key consideration will be the technology costs, the 
cost of hardware and software can reduce over time, so 
it might be worth waiting to see if the costs of specif-
ic product reduce. It is also worth pointing out that for 
software, there is a wide range of open source software 
that is free that provides the functional of commercial 
products.

Maloney et al. have shown that savings from blended 
learning will far outweigh costs within three years.1 
They also discuss the deployment of video content, and 
they highlight the fact that there are a number of free 
hosting services, such as YouTube, that provide content 
management They also state that adding multi-media 
and animations to video appears to have little impact 
on learner achievement.

Blend-it-well Handbook 

Table 8.4  – Key financial considerations

Costs Benefits

1.	 Cost of creating content

2.	 Cost of licencing software

3.	 Cost of Content Management System

4.	 Cost of hosting content

5.	 Maintenance costs

6.	 Cost of equipment

a.	  Video camera

b.	  Microphones

c.	  Lights

d.  Green screen

7.	 Cost of employing staff

8.	 Cost of training staff

Savings

1.	 Reduced costs of lighting and heating of buildings

2.	 Potentially reduced travelling costs

3.	 Blended learning will be cost neutral in the long-term 
(within three years)

New Revenue

1.	 Increased learner reach

2.	 Increased collaboration opportunities

3.	 Write eBooks
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Table 8.6 – Short, Middle and  
Long Term Perspective

Timespan Costs/Benefits

Short-6 months

●● Purchasing of software and 
hardware

●● Intensive content 
development

●● Promotion of programme

Medium-term:
6-18 months

●● First delivery of content
●● Modification of content
●● Maintenance costs

Long-term
18-50 months

●● Significant revision of content
●● Ongoing maintenance
●● Increased learner reach

8. 	 Blended Evaluation

Table 8.5 – A simple Balanced Scorecard

Financial Perspective Learning Perspective

●● Broaden Revenue 
opportunities

●● Improve operating 
efficiency

●● Etc.

●● Cross-departmental 
training

●● Share tacit knowledge
●● Etc.

Customer 
Perspective

Internal Process 
Perspective

●● Provide excellent 
service

●● Partner with 
other quality 
organisations

●● Etc.

●● Develop new services 
and products

●● Understand customer 
demographics

●● Etc.
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Learning Object Review Instrument (LORI)

Content: Reviewer: Date:

1. 	 Content Quality

2.  	 Learning Goal Alignment

3.  	 Feedback and Adaptation

4.  	 Motivation

5.  	 Presentation Design

6.  	 Interaction Usability

7.  	 Accessibility

8.  	 Reusability

9.  	 Standards Compliance

8



213

8. 	 Blended Evaluation

8



214

Blend-it-well Handbook 

8



Appendix:  
A Case Study of  
Blended Learning

Grey, dear friend, is all theory,  
and green the golden tree of life.

Johann Wolfgang von Goethe – Faust I
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A Korea-Ireland Collaboration 
 in Blended Learning

Summary
Flipped learning courses generally follow a basic con-
cept: web-based technologies outside of the classroom 
and instructor-learner interaction during class time, but 
the detailed design of the class builds on the instruc-
tor`s personal experience, knowledge, teaching phi-
losophy and goals of the course. The flipped learning 
concept reached the Republic of Korea (RoK) recently as 
a result of challenges East Asian universities are facing: 
enhancing the quality of education, keeping up with 
international trends and making education as cost-ef-
fective as possible. This case study is the first flipped 
learning course examined in a given Korean setting, 
but not the last one, similar courses are to follow in the 
near future. Therefore, the finding of the present study 
can help in designing and implementing courses in 
the future.  Based on our final finding it seems certain 
that flipped learning methodology has a future in Kore-
an higher education, as long as the course is designed 
for the specific setting: for example, emphasis should 
be put on learner/educator discourse in order to train 
naturally shy learners throughout the course to take an 
effective part in the interaction.

Details
This case study refers to a course taught at Kyungpook 
National University (KNU) in June 2017, during its sum-
mer school program. The module was delivered using a 
flipped classroom blended learning approach in a com-
pressed format of two weeks. The course was a intensive 
course (3 contact hours from Monday to Friday), taught 
in English focusing on Computer Engineering (Cloud 
Computing). The instructor was an invited professor 
from Ireland who facilitates an identical full semester 
course at his home university. Multiple deliveries of this 
module had already been delivered and developed in 
Ireland for a 3rd year Honours Degree Programme in 
Computer Science in the Dublin Institute of Technolo-
gy, though the delivery schedule in Ireland was over 12 
weeks.

The delivery was compressed into ten daily sessions 
over a two week period, with three hour laboratory 

sessions followed by daily pre-prepared video sessions. 
The compressed nature of the Korean delivery was a 
function of the funding model available using a Sum-
mer School environment for the course delivery. The 
compressed delivery also helped evaluate one of the 
delivery options available in a remotely supported de-
livery. 

Initial limitations set were that the maximum class size 
would be constrained by the capacity of a single com-
puter laboratory to ensure that the lecturer delivering 
the course would be present at all times. The expecta-
tion was that approximately twenty learners could be 
accommodated, however only ten learners registered. 
Of these learners eight attended the first class and one 
of them dropped out after the first day. Despite the re-
cruitment process explaining the contents and delivery 
method of the course, the learners attending did not 
have equivalent coding experience to those taking the 
same course in Ireland, through English. There were six 
male learners and one female learner in final attend-
ance. Of these learners six were from a Computer Sci-
ence major with basic programming experience, and 
one learner had no prior programming experience with 
a background in Material Science. 

The module title was “Cloud Computing Technologies” 
and was developed as a stand-alone DIT Continuing 
Professional Development module validated by the DIT 
prior to the delivery of the course to KNU. Learners must 
complete enough work to be awarded 5 European Cred-
it Transfer System (ECTS) credits which is equivalent to 
3 Korean credits. The DIT awarded the credits, which are 
international credits transferable to the KNU learners. 

The following is a summary of the learning outcomes of 
the module.

●● Build a basic Cloud System

●● Demonstrate an understanding of the evolution of 
Cloud Computing Technologies

●● Demonstrate a practical understanding of Cloud 
Computing Technologies in the lab

●● Configure basic infrastructure components used 
with the cloud
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●● Critically analyse different methods for implement-
ing cloud solutions

●● The module content was published online and pro-
vided the following teaching assets in a structured 
manner. 

●● Course summary of topics covered and details of 
each day’s activities in advance

●● Structure of each day; including links to the follow-
ing materials:

○○ Video lectures for the daily lesson, to be 
watched in advance of the lesson. Each lec-
ture was no more than twenty minutes in 
length and covered distinct individual topics 
grouped into coherent themes. 

○○ Online slides associated with each of the lec-
tures

○○ Links to online tutorials and reference materi-
al to assist with laboratory work

○○ Access to source code used as a starting point 
or solution to each assignment

○○ Detailed laboratory sheets with clearly 
marked assessment requirements

○○ Online assessment reports for learners to 
complete relating to the online video lectures 
watched. 

●● Access to a pre-provisioned online virtual machine 
constructed specifically for this module

●● Links to a source code repository for learners refer-
ence

●● A learner survey for the course to be completed at 
the end of the course 

All material was available online including links to oth-
er support technologies such as Google Slides, Goog-
le Forms, BitBucket Source code management, Videos 
hosted by HEANET in Ireland, and VMware virtual sys-
tems which were also hosted in Ireland.  Online interac-
tive tutorials could be repeated by learners and videos 
replayed to ensure that they understood the material. 
The approach taken was that learners would consume 
the online material and answer the online question-
naire and essay question on each topic each day. Que-
ries were dealt with in the laboratory, and feedback 
would be given individually or collectively as required. 
The laboratory sheets were a core component of the de-
livery as this is where the primary interaction with the 
lecturer occurred.  Two types of assessment were used, 
formative and summative. There were three assessment 
points in the course. 

1.	 Online lab reports completed daily and submit-
ted each evening by the learner. Each learner was 
required to view a series of online videos on the 
subject matter and answer questions using an es-
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say style response.  These essays were graded, with 
generalised feedback given to the entire class on 
the overall submissions standard.  Reports were 
submitted using Google Forms. 

2.	 In-lab worksheets were provided for in-class assess-
ment, which were completed throughout the lab. 
Learners were able to discuss issues and get feed-
back as they progressed through the lab sheet.  Lab 
instructions were detailed and clearly showed the 
marking scheme for the work performed. Work-
sheets contributed to the overall assessment mark 
of the course. Each new worksheet would provide 
for increasingly more difficult challenges for the 
learners, allowing them to build up confidence in 
easier sections early in the class, but challenging 
them near the end of the lab.  As each day passed, 
learners had access to solutions for previous labs, 
helping them review any areas they did not score 
well in. Assessment was performed beside the 
learners where they would demonstrate their work 
in person. Submissions were formally made to a 
source code repository. 

3.	 A capstone project was the final summative assess-
ment component of the course. Learners were giv-
en a project to complete, within a two day period, 
which required them to use all of the skills learned 
in the course. Sample solutions of work complet-
ed were provided to ensure learners had access 

to good relevant reference material in the form of 
lecturer provided sample solutions.  Learners were 
assessed through a demonstration of their work 
to the lecturer during the final lab. Learners could 
continue to fix issues found during the final assess-
ment, once they were completed, before the end 
of the lab. 

Learners were graded in teams of no more than two. 
The assessment breakdown for the course was as fol-
lows: 30% for written reports, 40% for lab sheets, and 
30% for the capstone project.  

Conclusions
A pre-course survey found that learners were mainly 
not motivated to take this course because of its flipped 
nature, but because it was taught in English by a native 
English speaker. Since learners considered the course 
as an opportunity to improve their language skills, they 
did not consider the special nature of the course impor-
tant, therefore were not familiar with the flipped learn-
ing methodology, even though all class materials were 
provided long before the class.

Learners reported general satisfaction with the qual-
ity and detail of the online material presented, but 
the compressed nature of the delivery, made it diffi-
cult for them to spend sufficient time on each section. 
The lecturer was required each day to adjust the pace 
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of the course to maintain sufficient progress through 
the module. This was possible only due to the exten-
sive preparation performed by providing solutions to 
learners and working through examples when learners 
struggled with the material. Learners found some parts 
of the course difficult and more focus was placed on 
these areas during the delivery. This was only possible 
due to the constant daily feedback from the learners. 
Interestingly, the learner satisfaction at the end of the 
course on the video material was in fact higher than the 
recorded data during the course delivery.

The ability to alter pace and having all material exten-
sively prepared was a key factor in addressing the learn-
er cohorts’ differing backgrounds. The nature of the 
flipped delivery and feedback allowed the learners to 
engage and perform well despite expressing difficulty 
with some of the worksheets. A strength of the flipped 
learning model was evidenced by the highly engaging 
nature of the contact time. Because the lecturer was not 
presenting new material in the class, but rather address-
ing issues and problems raised by learners in their feed-
back, it ensured that the actual teaching was targeted 
and relevant.  Learners overwhelmingly identified the 
assessment and feedback as being a critical component 
to the success of the module. The lecturer also used the 
feedback to modulate the delivery pace and assess-
ment to allow maximum learner engagement. 

Other observations and lessons learned were:

●● For quicker adjustment to the structure, require-
ments, and methodology of the course, it is desira-
ble that learners have a clear understanding of the 
flipped learning concept before the beginning of 
the course.

●● The compressed nature of the delivery did not add 
in a positive way to the module experience for ei-
ther the learners or the lecturer. While the module 
ultimately resulted in a positive outcome for the 

learners, a larger cohort may have had a difference 
experience. Time is required between each delivery 
to allow learners to absorb the material. 

●● Learners reacted well to the video material and 
found it engaging and challenging, however, further 
worked examples in the online format may have 
helped enhance the learners understanding. Future 
implementations should focus equally on theory 
and practical online videos. 

●● The Korean learners engaged extensively during the 
delivery. While initially quite reluctant to engage, 
the learners quickly started to ask many questions 
and interacted with the lecturer in the same way as 
seen in Ireland, for example. 

●● The feedback methods within the classroom en-
sured that the lecturer was aware of what learners 
were struggling with and allowed the lecturer con-
trol over the pace of the course. Learners expressed 
some considerable satisfaction with the feedback 
and engagement elements of the module, identify-
ing it as a highlight of the module. 

Flipped learning provides a benefit to learners when it 
combines a flexible pace with delivery of modules. This 
flexibility is only made possible through responding 
to feedback from learners on an ongoing basis.  This 
response could take the form of altering assessments, 
adding additional explanations to the material, provid-
ing additional sources of reference or working through 
the problem with the learners as a group in an interac-
tive way. To accomplish this, the lecturer in the room 
should be a subject matter expert and highly experi-
enced in the course material. Moreover, to successfully 
implement a flipped learning course in Korea, the spe-
cific Korean setting should be considered during de-
signing and delivering the course.
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